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This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code
is provided under the following license:
This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the use of
or inability to use this software.
Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it
and redistribute it freely, subject to the following restrictions:

1. Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of con-
ditions.

2. Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list of
conditions in documentation and/or other materials provided with the distribution.

3. Altered versions— including, but not limited to, ports to new operating systems, existing ports with new graph-
ical interfaces, and dynamic, shared, or static library versions—must be plainly marked as such and must not
be misrepresented as being the original source. Such altered versions also must not be misrepresented as
being Info-ZIP releases— including, but not limited to, labeling of the altered versions with the names "Info-ZIP"
(or any variation thereof, including, but not limited to, different capitalizations), "Pocket UnZip," "WiZ" or
"MacZip" without the explicit permission of Info-ZIP. Such altered versions are further prohibited frommis-
representative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases.

Copyright

The software described in this manual is furnished under a license agreement and may be used or
copied only in accordance with the terms of the agreement.

____________________________________________________________________________

Copyright © 2013 - 2023. Micromeritics Instrument Corporation. All rights reserved.



WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and
service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their
reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by
chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization
to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Ser-
vice charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire
liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree
to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves,
seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such
items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of
manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including
but not limited to, the implied warranties of merchantability or fitness for use.
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CORPORATE PROFILE
Micromeritics Instrument Corporation is the world’s leading supplier of high-performance systems
to characterize particles, powders and porous materials with a focus on physical properties,
chemical activity, and flow properties. Our technology portfolio includes: pycnometry, adsorption,
dynamic chemisorption, particle size, intrusion porosimetry, powder rheology, and activity testing
of catalysts. The company has R&D and manufacturing sites in the USA, UK, and Spain, and
direct sales and service operations throughout the Americas, Europe, and Asia. Micromeritics
systems are the instruments-of-choice in more than 10,000 laboratories of the world’s most
innovative companies and prestigious government and academic institutions. Our world-class
scientists and responsive support teams enable customer success by applying Micromeritics
technology to the most demanding applications. For more information, please visit
www.micromeritics.com.
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CONTACT US
Micromeritics Instrument Corporation

4356 Communications Drive
Norcross, GA 30093-2901 USA
Phone: 1-770-662-3636
Fax: 1-770-662-3696
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666
International: Contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com

Micromeritics Application Support
Support@Micromeritics.com
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About this Manual

ABOUT THIS MANUAL

The following can be found on the Micromeritics web page (www.micromeritics.com).

n Calculations document (PDF)
n Error Messages document (PDF)
n Operator Manual (PDF)

n Parts and Accessories
n Smart VacPrep Operator Manual (PDF)
n Vacuum Pump Guide (PDF)

This manual contains instructions for installations in standard and 21CFR11
environments. For instructions on installing the application in a 21CFR11
environment, see the Confirm Administrator Guide [part number 004-42821-01].

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear in this manual:

NOTE — Notes contain important information applicable to the topic.

CAUTION—Cautions contain information to help prevent actions that may damage
the analyzer or components.

WARNING—Warnings contain information to help prevent actions that may cause
personal injury.

NOTE — Notes that apply to 21CFR11 environments only (Confirm applications).
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GENERAL SAFETY

Do not modify this instrument without the authorization of Micromeritics Service Per-
sonnel.

Any piece of laboratory equipment can become dangerous to personnel when improperly
operated or poorly maintained. All employees operating and maintaining Micromeritics
instruments should be familiar with its operation and should be thoroughly trained and instructed
on safety.

n Read the operator manual for any special operational instructions for the instrument.
n Know how the instrument functions and understand the operating processes.

n Wear the appropriate personal protective equipment when operating this
instrument — such as eye protection, lab coat, protective gloves, etc.

n When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assist in
moving the instrument. The TriStar weighs approximately 37 kg (82 lb).

n Always pay attention to the safety instructions provided on each label affixed to the
instrument and do not alter or remove the labels. When inspecting the instrument,
ensure that the safety labels have not become worn or damaged.

n The 3030 TriStar II Plus sound level is below 80 dBA. Hearing protection is
optional.

n The 3030 TriStar II Plus has a safety shield. Ensure it is in place when operating
the instrument.

n Proper maintenance is critical to personnel safety and smooth instrument
operation and performance. Instruments require regular maintenance to help
promote safety, provide an optimum end test result, and to prevent costly down
time. Failure to practice proper maintenance procedures can lead to unsafe
conditions and shorten the life of the instrument.

n If using CO2 for analyses, ensure an exhaust line is connected to the vacuum
pump and the exhaust is run to a ventilation system or out of the building.

n Improper handling, disposing of, or transporting potentially hazardous materials
can cause serious bodily harm or damage to the instrument. Always refer to the
SDS when handling hazardous materials. Safe operation and handling of the
instrument, supplies, and accessories are the responsibility of the operator.

The TriStar II Plus is a stand alone instrument. Safe operation and handling of the
instrument, supplies, and accessories is the responsibility of the operator.

General Safety
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General Safety

INTENDED USE
The TriStar II Plus is a an automated, three-station, surface area and porosity analyzer that
delivers excellent performance and speed of analysis. With three available analysis ports, the
TriStar II Plus provides high sample throughput and advanced data analysis features to the user.
The TriStar II Plus software gives the user the ability to interactively evaluate isotherm data and
reduce the time required to obtain surface area and porosity results.

The instrument is intended to be operated by trained personnel familiar with the
proper operation of the equipment recommended by the manufacturer and as well as
relevant hazards involved and prevention methods. Other than what is described in
this manual, all use is seen as unintended use and can cause a safety hazard.

The instrument is intended to be used as per applicable local and national regulations.

TRAINING
It is the customer's responsibility to ensure that all personnel operating or maintaining the
equipment participate in training and instruction sessions. All personnel operating, inspecting,
servicing, or cleaning this instrument must be properly trained in operation and machine safety
before operating this instrument.
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ENVIRONMENTALLY FRIENDLY USE PERIOD

Part
Name

Hazardous Substances
Lead
(Pb)

Mercury
(Hg)

Cadmium
(Cd)

Hexavalent
Chromium
(Cr (VI))

Polybrominated
biphenyls (PBB)

Polybrominated
diphenyl ethers

(PBDE)
Metal
Parts x o o o o o

Power
Supplies x o o o o o

Printed
Circuit
Boards

x o o o o o

Hazardous Substances Table

o Hazardous substance is below the specified limits as described in SJ/T11363-2006.
x Hazardous substance is above the specified limits as described in SJ/T11363-2006.

The Environmentally Friendly Use Period (EFUP) for all enclosed products
and their parts are per the symbol shown here unless otherwise marked. Cer-
tain parts may have a different EFUP (for example, battery modules) and are
marked to reflect such. The Environmentally Friendly Use Period is valid only
when the product is operated under the conditions defined in the product
manual.

General Safety
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General Safety

SYMBOLS THAT MAY APPEAR ON THE INSTRUMENT

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear on your instrument:

Use extreme caution when working on the instrument where one of these symbols
may be displayed. These symbols indicate the part may be hot and cause serious
burns.

Use the cotton gloves provided in the accessory kit when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

When working on an instrument where this symbol is displayed, refer to the cor-
responding Operator Manual for additional information.

When this symbol is displayed, toxic or flammable gases require proper venting of
exhaust.

This symbol can also indicate the instrument uses mercury which is an extremely
toxic substance. Read the Safety Data Sheet (SDS) and be aware of the hazards of
mercury and know what to do in the event of a spill or an exposure incident.
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1 ANALYZER COMPONENTS FOR TRISTAR II PLUS
Parts and accessories are located on the Micromeritics web page.

FRONT COMPONENTS

A. P0 tube
B. Power indicator light
C. Sample ports
D. Elevator

Component Description
P0 tube For measuring the saturation pressure.

Power indicator
light

Blinks when power is applied to the analyzer; illuminates when the ana-
lysis program is initiated and ready for operation.

Sample ports For installing up to three sample tubes.

Elevator Allows placement of the Dewar around the sample and P0 tubes. The
elevator is raised automatically when the analysis is started and lowers
automatically upon completion. During analysis, the elevator optionally
lowers after the free space measurement to allow evacuation, then is
raised and continues the analysis.

Front Components

1 Analyzer Components for TriStar II Plus
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1 Analyzer Components for TriStar II Plus

SIDE PANEL COMPONENTS

A. Ethernet port
B. RS-232 port

Component Description
Ethernet Port Port for a shielded Ethernet cable allowing communication between

the analyzer and the computer.
RS-232 port Not used.
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REAR PANEL COMPONENTS

Rear panel Power switch

Component Description
A Maximum inlet

pressure
Indicates the maximum inlet pressure that can be used.

B Vacuum pump
connector

For attaching the vacuum pump hose.

C Helium inlet
valve

Inlet valve for helium.

D Gas inlet valves Inlet valves for analysis gases.

E Power cord
connector
and power
switch

For connecting the analyzer to the power supply and for powering the
analyzer on and off.

Rear Panel Components

1 Analyzer Components for TriStar II Plus
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1 Analyzer Components for TriStar II Plus

EQUIPMENT OPTIONS AND UPGRADES
Parts and accessories are located on the Micromeritics web page.

Option Description
Chiller Dewar A closed loop recirculating system that utilizes a high surface area

copper coil to provide excellent heat transfer between the Dewar and
the recirculating liquids. The Chiller Dewar Quick Start Guide is
located on the Micromeritics web page.

FlowPrep The FlowPrep applies both heat and a stream of inert gas to the
sample to remove adsorbed contaminants from the surface and
pores in preparation for analysis for up to six samples. Choose the
temperature, gas, and flow rate best suited for the sample material.
The FlowPrep is an independent unit and not controlled by the ana-
lyzer.

Krypton Option For very low surface area analyses. The option consists of a high-
vacuum pump, and 10 mmHg transducer.

Smart VacPrep The Smart VacPrep prepares samples by heating and evacuation. It
contains six sample ports in which up to five temperatures, ramp
rates, and soak times per sample are individually controlled by the
analyzer program so that all degas information is integrated into the
sample data file for future reference. Samples can also be prepared,
started, and completed independently. There is no need to wait for
samples on other ports to finish. Front panel buttons allow a
QuickStart operation with preprogrammed conditions.

Up to three additional Smart VacPrep degassers can be connected
to one computer permitting 24 preparation ports to be used. The
Smart VacPrep is the recommended degassing unit.
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Option Description
VacPrep The VacPrep offers two methods for removing contaminants. In addi-

tion to flowing gas, it provides vacuum to prepare samples by heating
and evacuation of up to six samples. This combination provides pre-
paration method options best suited to the material or application.
Needle valves are also provided for introducing the vacuum slowly to
prevent fluidization of samples. The VacPrep is an independent unit
and not controlled by the analyzer.

Vacuum Pump The analyzer requires a vacuum pump for sample analysis. Vacuum
pumps used must meet the following criteria:

n Achieve vacuum levels of 20 μmHg at the analyzer inlet
n Contain an anti-suckback valve to prevent vacuum pump oil from

back streaming into the analyzer in the event of a vacuum pump
failure

n Contain an NW16 inlet port for connection to the analyzer

A device to reduce oil vapor backstreaming is recom-
mended.

The vacuum pump must have an anti-suckback valve to
prevent oil from being admitted into the analyzer should
the power fail while the system is under vacuum. Pumps
available from Micromeritics are equipped with an anti-
suckback valve.

An oil-based or oil-free vacuum pump can be used with the analyzer
(an oil-free pump is required if the krypton option is installed).
Appropriate vacuum pumps are available from Micromeritics.

Equipment Options and Upgrades
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1 Analyzer Components for TriStar II Plus

GAS REQUIREMENTS AND PURITY

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the SDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

Compressed gases are required for analyses. Gas cylinders or an outlet from a central source
should be located near the analyzer.

Appropriate two-stage regulators which have been leak-checked and specially cleaned are
required. Pressure relief valves should be set to no more than 30 psig (200 kPag). All gases
should be of a purity listed below. Gas regulators can be ordered from Micromeritics. Parts and
accessories are located on the Micromeritics web page.

Gas Purity

(CGA 580) N2
(CGA 580) He
(CGA 580) Kr

99.999%
99.999%
99.995% (Required for krypton units only)

CRYOGEN REQUIREMENTS
Liquid nitrogen is commonly used as the cryogen to cool the sample during analysis. A liquid
nitrogen transfer system eliminates the need to pressurize storage Dewars. The Model 021 liquid
nitrogen transfer system is available from Micromeritics (www.micromeritics.com).

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the SDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.
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SPECIFICATIONS FOR THE TRISTAR II PLUS

Absolute

Range: 0 to 950 mmHg
Resolution: Within 0.05 mmHg
Accuracy: Within 0.1% of full scale
Linearity: < ± 0.1% of span

Relative P/Po range: 0 to 1.0 P/Po
Resolution: < 10-4

Pressure Measurement

Specific Surface Area From 0.01 m2/g, nitrogen unit
From 0.001 m2/g, krypton unit

Total Surface Area From 0.1 m2, nitrogen unit
From 0.01 m2, krypton unit

Pore Volume From 4 ×10-6 cm3/g

Dewar Duration Up to 40 hours

Gas Consumption Up to 300 cm3 STP per port

Analysis

Nitrogen Unit
Nitrogen; argon, carbon dioxide, or other non-corrosive gases;
butane, methane, or other light hydrocarbon vapors. Oxygen can
also be used only with an appropriate vacuum pump.

Krypton Unit Same as nitrogen unit, plus the capability to perform krypton sur-
face area analyses at lower pressures

The TriStar II Plus should be operated in a properly vented environment when using flammable
or toxic gases.

Adsorptive Gases

Specifications for the TriStar II Plus
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1 Analyzer Components for TriStar II Plus

Accuracy ±0.25 °C

Resolution Within 0.1 °C

Manifold Temperature

Nitrogen Unit Must accommodate 20 × 10-3mmHg or better; uses oil-based or
oil-free vacuum pump

Krypton Unit Must accommodate 1 × 10-3mmHg; oil-free vacuum pump
required

Vacuum System

Temperature 10 to 35 °C (50 to 95 °F), operating
0 to 50 °C (32 to 122 °F), non-operating

Humidity 20 to 80% relative, non-condensing

Indoor or Outdoor Use
Indoor only (not suitable for wet locations)
Altitude: 2000 mmax (6500 ft)
Pollution degree of the intended environment: 2

Degree of Ingress
Protection IPX0

Environment

Height 74 cm (29 in.)

Width 40 cm (16 in.)

Depth 51 cm (20 in.)

Weight 37 kg (82 lbs)

Physical
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Voltage 100-240VAC

Power 150VA, maximum

Frequency 50/60Hz

Overvoltage category II

Electrical

Operating System
Windows 10 or higher operating system is required. For 21 CFR
Part 11 environments, Windows 10 Professional or Windows 10
Enterprise or higher is required.

Desktop Installation
Required

The application should not be installed on a network drive with
shared access.

Multiple users cannot operate the application at the same time.

Ensure the "Sleep" setting on the desktop is set to
"Never" to avoid interruption while running an analysis.
If this occurs, the application loses network
connectivity with the instrument and a communications
error will be reported. A restart of the Windows
application may be required if automatic reconnection
is not successful.

10 Base T or 100 Base T
Ethernet Port

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet-based unit is connected to
the same computer, an Ethernet switch will also be required. If a
Smart VacPrep is to be used, an Ethernet switch is required.

Read/Write Permissions

All application users will need Read/Write permission to all
directories and subdirectories where the application is installed.
For 21 CFR Part 11 environments, permission may be limited to
the installation directory.

Drives USB port

Computer Requirements

Due to continuous improvements, specifications are subject to change without notice.

Specifications for the TriStar II Plus
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2 ABOUT THE SOFTWARE

Software in 21CFR11 Environments on page 2 - 26

The analyzer allows other computer programs to run while an automatic operation is in progress.
The Helpmenu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its
own tab and reflects data collected during the analysis.

The MicroActive feature offers a Windows interface with an easy way to collect, organize, archive,
reduce raw data, and store sample files for later use. Scalable and editable graphs and copy and
paste graphics are easily generated. Customized reports can be viewed on a computer monitor,
printed, or exported for use in other programs.

In addition to customizable standard reports, user-defined calculations and reports can be created
through the Advanced reports feature (using Python).

Data can be manipulated and displayed interactively using MicroActive reports.

2 About the Software
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2 About the Software

MENU STRUCTURE
All program functions use standard Windows menu functionality. The title bar contains a Unit [n]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Selections Description
File Use to manage files used by the application— such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations. Unit 

[n] displays on the menu bar for each analyzer attached to the computer.
Smart VacPrep (If installed.) Use to access the menu for each installed Smart VacPrep.

Reports Use to start or initiate reports and view the results.

Options Use to change presentation options, set the method and active metals
defaults, configure signal calibration, manage libraries, select units, and
create report styles.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.

Help Use to access the embedded operator manual, Micromeritics web page,
and information about the application.

Main Menu Bar Options
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COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located in multiple windows throughout the
analyzer application and have the same description or function. Fields and button descriptions not
listed in this table are found in tables in their respective sections. All entry fields will accept
information when using a bar code reader.

Selections Description
Add Adds an item to the list.

Add Log Entry Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-axes
to be scaled automatically. Autoscalemeans that the x- and y- ranges
will be set to show all the data. If Autoscale is not selected, the entered
range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field
label name)

Use to enter additional information about the sample, such as a sample
lot number, sample ID, etc.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window and displays a prompt to either accept or
reject changes.

Close All Closes all active windows. If changes were made and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments to display in the report header about the sample or
analysis.

Copies Selects the number of copies to print. This field is only enabled when
Print is selected.

Delete When working with tables, deletes the selected information.

Destination Selects the report destination.

Common Fields and Buttons

Common Fields and Buttons
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2 About the Software

Selections Description
Edit When working with report parameters, highlight the item in the Selected

Reports list box and click Edit to modify the report details.
Exit Exits the application. If a file is open with unsaved changes, a prompt

displays the option to save the changes and exit or exit the application
without saving the changes. If an analyzer is currently operating, an
additional prompt displays to confirm exiting from the software.

Export Exports data in a sample file as a .TXT, .XML or .XLS file. When saved
to a file, the data can be imported into other applications.

File Selects the destination directory. Enter a new file name in the File
name field or accept the default. Select to save the file as a spread-
sheet (.XLS), a portable document format (.PDF), or an ASCII text
(.TXT) file format.

File name Selects a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From / To Indicates the From and To range for x- and/or y-axes when working
with report parameters windows.

Insert Inserts one row above the selected row in the table.

List Creates a list of samples or other types of files. The list will contain the
file name, date/time the file was created or last edited, file identification,
and file status.

Name Contains a list of files in the selected directory or library.

Next Moves to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double-click the file name in the
Name column to open the file.

Prev Moves to the previous window.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer, or file).

Remove Removes the selected file or files from the list.

Replace Selects another file where the values will replace the current file’s val-
ues.

Common Fields and Buttons (continued)
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Selections Description
Replace All Selects another .SMP file where the values will replace all values for

the active sample file. The original file will remain unchanged. No
analysis data is added to the file. The only information added is sample
information, material properties, liquid properties, analysis, and
reporting parameters.

Report Displays a window to specify report output options.

Save Saves changes.

Save As Saves a file in the active window under a different file name. A portion
can be saved as a separate, stand-alone file, such as Analysis Condi-
tions or Report Options, when saving sample information.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Displays the data from the current analysis.

Instrument Log. Displays recent analyses, calibrations, errors, or
messages. Enabled only in Service Test Mode.

Instrument Schematic. Displays a schematic of the analyzer system.

Common Fields and Buttons (continued)

Common Fields and Buttons
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2 About the Software

FILE STATUS, DESCRIPTION, AND LOCATION
In the File Selector window, theMic Description column and theMic Status column display the file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right-clicking an entry to display a menu of
standard Windows functions.

File Status Description
Analyzing Sample files that are currently used for analysis.

Complete Sample files used in an analysis that is completed.

Entered Sample files containing manually entered data.

No Analysis Sample files that have not been used to perform an analysis.

Prepared Sample files that have been used in an automatic degas operation but
have not been analyzed. This status is applicable only if using the
Smart VacPrep degasser.

Preparing Sample files that are currently being used in an automatic degas oper-
ation. This status is applicable only if using the Smart VacPrep
degasser.

File Status
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File Type File Name
Extension

Alpha-s Curve1 ) .ALS

Adsorptive Properties .ADP

Analysis Conditions .ANC

Degas Conditions .DEG

Heat of Adsorption
Report

.HOA

Methods .MTH

Report Options .RPO

Sample Information .SMP

Sample Tube Prop-
erties

.STB

SPC Report .SPC

Thickness Curve2 ) .THK

File Type and File Name Extension

File Type File Name Extension
Portable document
format

.PDF

Report .REP

Spreadsheet .XLS

Unicode .TXT

Extensible markup lan-
guage

.XML

File Types for Printing or Exporting

1 ) Saves the relative pressures and resulting quantities adsorbed as an ASCII text file. These
data are derived by dividing the isotherm by the quantity adsorbed at 0.4 relative pressure.
2 ) Saves the relative pressures and corresponding thicknesses as an ASCII text file. These data
are derived by dividing the condensed volume of adsorptive by the selected surface area. The
density conversion factor in the adsorptive properties file is used to convert quantity adsorbed to
volume of condensed adsorptive.

File Status, Description, and Location
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2 About the Software

KEYBOARD SHORTCUTS
Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example, to access the Filemenu, press Alt + F, then press the underlined
letter on the submenu (such as pressing Alt + F) then pressingO to open the File Selector).

If the underscore does not display beneath the letter on the menu or window, press
the Alt key on the keyboard.

Selections Description
Alt +[Unit n] Opens the Unit [n]menu.

Alt + F Opens the Filemenu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to
save changes displays.

Alt + H Opens the Helpmenu.

Alt + I Opens theOptionsmenu.

Alt + R Opens the Reportsmenu.

Alt + V Opens the Smart VacPrepmenu.

Alt + W Opens theWindowmenu.

Ctrl + N Opens a new sample file.

Ctrl + O Opens the File Selector window.

Ctrl + P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F3 When in the File Selector window, opens the file search box.

F4 When in the File Selector window, opens the address bar.

F5 Opens the File Selector window listing report options files.

F6 Cascades open windows.

Keyboard Shortcuts
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Selections Description
F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

F10 Opens the Heat of Adsorption window.

Shift + F2 Opens the File Selector window listing sample information files.

Shift + F9 Opens the shortcut menu of either the selected component on the ana-
lyzer schematic when manual control is enabled or the onscreen reports.

Keyboard Shortcuts (continued)

Keyboard Shortcuts

TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023 2 - 9



2 About the Software

OPTION PRESENTATION
Options > Option Presentation

For 21CFR11 environments, see Software in 21CFR11 Environments on page 2
- 26.

Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted.
Each display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option

is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted Displays the sample file in a single window like the Basic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same password must be entered
to change to the Basic or Advanced display option. This display type
is typically used in laboratories — such as the pharmaceutical
industry — where analysis conditions must remain constant. The
Advanced option is not available in the view selector at the bottom of
the window when using the Restricted display option.

Show Degas
Conditions

When enabled, displays the Degas Conditions tab when using
Advanced option presentation and the Degas Conditions drop-down
list when using Basic or Restricted option presentation. This option
may be deselected to hide the Degas Conditions tab if not using a
Smart VacPrep.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.
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The following examples show the same sample file in Advanced and Basic display. Basic and
Restricted displays will look the same. A password is required if using Restricted format.

Option Presentation Examples

Advanced view Basic or Restricted view

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.

Option Presentation

TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023 2 - 11



2 About the Software

LIBRARIES
Options > Manage Libraries

This feature is not available when using Restricted option presentation.

The library provides an easy way to locate and open specific analyzer files. Libraries are located
within the File Selector window and can be viewed only within the application.

The library gathers sample and parameter files stored in multiple locations, such as folders on a C:
drive, a network location, a connected external hard drive, or a connected USB flash drive, and
provides access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items, such as saved searches and search
connectors, cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original
file storage location. However, when deleting files or folders from within a library, they are deleted
from their original file storage location. Deleted files and folders can be recovered from the
Recycle Bin located on the Windows desktop.
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METHODS

Options > Default Method
File > Open > [.MTH File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Sample file information that is available to Analysts is created by a
member in the Developer group using information in this section.

AMethod determines the default sample identification format and sequence number. AMethod is
a template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed. Only a single selection
is required for each new sample file created.

TheMethod drop-down list displays only those methods applicable to the open sample file type.

Developer Group view in a 21CFR environment

Default Method Examples Default Method Examples

Methods
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2 About the Software

Analyst Group view in a 21CFR environment

Selections Description
Sample file name
[text box]

Enter a format for the sample identification. The entry in this field
becomes a part of the saved sample file name. Include the $ symbol
to have the sample file number included as part of the identification.

Sample
Operator
Submitter
Bar Code [text box]

These field labels may be renamed, and the new label becomes a
part of all new sample files.

Sequence number
[text box]

Specify a default numeric string to use as a prefix in the Sample field
when a new sample file is created. This number increments with
each sample file created.

Default Methods
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CONFIGURE THE ANALYZER

SPECIFY GAS PORTS AND UNIT CONFIGURATION

Unit [n] > Unit Configuration

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

The analyzer has gas inlets for up to three analysis gases and a dedicated inlet for helium. The
gases connected to the inlets must be specified in the analysis program. If the gases are changed
on one of the inlets, make the same change on the Unit Configuration window. The analysis
programmust be kept informed of any changes in gases.

Selections Description
Configuration
[group box]

Displays the IP address used by the analysis program, serial number,
and type of analyzer.

IP address. Displays the IP address of the analyzer.

Change IP. Displays the Board ID dialog, which describes the circuit
boards in the analyzer. Use the Board drop-down list to select a board
to view.

Unit Configuration

Configure the Analyzer
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2 About the Software

Selections Description
Board ID. Click to display information from the circuit boards in the
analyzer. Use the drop-down list to select a board to view. The
parameters shown cannot be edited.

Gas Selections
[group box]

Enter the gas connected to the specified port.

Options [group box] Displays options installed on the analyzer.

Servo Valve
[group box]

Displays the last calibration date for the servo valve.

Software Versions
[group box]

Displays the software versions of the MIC BIOS, controller, and ana-
lysis program.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Unit Configuration (continued)

UNIT SELECTION

Options > Units
Use to specify how data should appear on the application windows and reports. This menu option
is not available if using Restricted option presentation in a standard installation environment.
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INSTRUMENT STATUS

SHOW DASHBOARD

Unit [n] > Show Dashboard
Data for the dashboard comes from the logged diagnostic data. The dashboard remains current
as the relevant diagnostic data items are updated. The gauges will be updated even if the
dashboard window is not open.

Red numbers on the dashboard require attention. To reset the dashboard numbers,
right-click on the dashboard setting, then click Reset.

Selections Description
Analyses
completed / started

Displays N/M where N is the number of analyses that have finished
data collection andM is the number of analyses that have been star-
ted. Analyses canceled or terminated by errors before the termination
stage starts are not counted as completed.

Days until roughing-
pump service is due

Annual maintenance is recommended. The number of days until the
anniversary of the last pump maintenance is shown. The displayed
value is updated at least once per day and when the maintenance
time is reset. When the displayed value is 30 or less, the value is dis-
played in red. Red negative numbers display if maintenance is past
due.

Dashboard Gauges

Instrument Status
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2 About the Software

Selections Description
Manifold outgas rate Provides the qualitative indication of the outgas rate in the dosing

manifold. LED images constitute a bidirectional bar graph of the
outgas rate.

The gauge is updated when the Analysis Manifold Test is run. See
Start Diagnostic Test on page 9 - 1.

n Three green LEDs are lit if outgas rate is below 30% of outgas rate
limit.

n At 30%, the left LED turns off.
n At 60%, the center LED turns off.
n At 90%, three green LED lights turn off and the center yellow

LED turns on.
n At 110% and above, only the red LED turns on and attention is

required.

Nitrogen P0 Displays statistics of the saturation pressures measured with nitrogen
gas at liquid nitrogen temperatures. The mean, two-sigma, minimum,
and maximum values display. The gauge is updated when a P0 is
logged with nitrogen as the adsorptive and a bath temperature of
77±2 K.

Dashboard Gauges (continued)
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SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log

In 21CFR11 environments, see Software in 21CFR11 Environments on page 2 -
26.

Use to display a log of recent analyses, calibrations, errors, or messages. The information is
logged for a 7-day period for analyses and a 30-day period for messages and calibrations.

Selections Description
Add Log Entry [button] Use to enter information to appear in the sample log report that can-

not be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Analysis/
Calibration/
Message [check box]

Select the logs to display.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Instrument Log

Show Instrument Log
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SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic
Use to display an analyzer schematic. To operate the valves and elevator from this window,
manual control must be enabled (Unit [n] > Enable Manual Control).

A. 10 Torr Transducer (displays
only for krypton units)

B. 1000 Torr Manifold Trans-
ducer

C. Port 3 Transducer
D.   Elevator
E.  Port 2 Transducer
F. Port 1 Transducer 
G.  P0 Transducer
H. Servo valve

Icon or
Symbol

Description

Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. When manual control is
disabled, closed valves appear white.

Servo Valve. Closed.

Servo Valve. Open.

Elevator.

Sample Tube. Cannot be manually controlled.

Analyzer Schematic Icons
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Schematic
Components Description

1-3 Sample ports

4 P0 port

5 Servo valve

6 Isolation valve

7,8,9,14 Inlet valves

10 Vacuum

11-13 Unrestricted vacuum sample ports

Analyzer Schematic Components

Icon or Symbol Description
Valve options Open.Opens the selected valve.

Close. Closes the selected valve.

Pulse. Use to quickly turn the valve on and off allowing the operation to
proceed in small increments.

For Servo valve:

n Set. Use to set the servo valve target pressure and dose or evacuate.
n Open.Opens the servo valve. The valve symbol changes to green.
n Close. Closes the servo valve. The valve symbol changes to solid

black.

Elevator options Right-click the elevator icon, then select:

Raise. Select Raise to raise the elevator. When it is moving, press the
keyboard space bar to stop the movement (or right-click and select Stop
from the menu).

Lower. Select Lower to lower the elevator. When it is moving, press the
keyboard space bar to stop the movement (or right-click and select Stop
from the menu).

Stop. Stops the elevator from moving.

Schematic Shortcuts

Show Instrument Schematic
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SHOW STATUS

Unit [n] > Show Status
Use to show the current status for each port.

Post Analysis Free Space
displays in yellow (when
applicable) and if Free
Space After Analysis is
selected (not shown
above)

If multiple units are attached to the computer, select Show Status on each Unit [n]menu. The
status for all units displays.

CONVERT FILES
File > Convert
Converts StarDriver files (.MGD extension) to a sample file with a .SMP file extension. Only those
files with a .MGD file extension display in the Name column.
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EXPORT FILES
File > Export
Exported Data Example on page F - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or a file. Data can be exported as a .PDF, .TXT, .XML, or .XLS file format. The
type of data to include or exclude can be selected during the export process. The data can be
imported into other applications that read these file formats when exported to a file.

1. Click List and open an .SMP file.
2. Select an experiment and the applicable options.
3. ClickOK.

Export Files
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LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the
file was created or last edited, file identification, and file status.

Select one or more files from the file selector, click List, then provide the file destination.

Example of
File List
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SOFTWARE UNINSTALL
Uninstall Software in 21CFR11 Environments on page 2 - 30

The software can be uninstalled in two ways. Either method removes only the files required to run
the software, not the analysis files.

n Click the Windows Start icon. Scroll to the Micromeritics entry. Select the Uninstall [analyzer]
option, then follow the prompts.

n Locate the uninstall.exe file in C:\Program Files (x86)\Micromeritics\[analyzer name] (or
wherever the application was installed). Double-click the uninstall.exe file, then follow the
screen prompts.

SOFTWARE UPDATES

A User Account Control in the Windows operating systemmust be enabled to ensure
all components of the Micromeritics application are correctly installed. If UAC is not
enabled, right-click the setup.exe installer file and select Run as administrator.

The most current version of the instrument software can be found on the Micromeritics web page
(www.micromeritics.com).

When performing a software update, existing data files are not overwritten.

Insert the setup media into the media drive. The setup program starts automatically. If the
program does not start automatically, navigate to the installation media drive, locate and double-
click the setup.exe file.

Existing Confirm application users and groups are not affected by software updates.
Any changes to Confirm users and Confirm groups must be made using Windows
Users and Groups.

Software Uninstall
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SOFTWARE IN 21CFR11 ENVIRONMENTS

The Micromeritics Confirm applications for 21CFR11 environments require an
operating system of Windows 10 Professional or Windows 10 Enterprise or higher.
Management of users and groups is performed in Windows Users and Groups.

The Micromeritics Confirm application enables laboratory managers to develop analysis methods,
enforce industry standards, and produce audit trails. It also enables laboratory analysts to perform
analyses and produce reports.

USER PERMISSIONS

Confirm User Name Description
mic_[analyzer model
number]_controller

mic_[analyzer model number]_controller is the user name used by all
installations.

n This user should have complete control over the installation dir-
ectory.

n The application is launched under this user name and has this
user’s privileges to the windows file system.

n This user should not be used by anyone or any other software that
is not a Micromeritics application.

n The system administrator has the option of modifying this account
so that the password never expires. Alternatively, if the password
does expire while the application is running, the application auto-
matically changes the password for this account.
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Confirm Group Name Description
Developer Group The default Developer group name is

mic_[analyzer model number]_developer. Members of the
Developer group:

n have rights to all functions of the Micromeritics application - includ-
ing Advanced option presentation which allows the creation and
modification of methods, sample files, and parameter files.

n can run an analysis.
n can also be assigned Administrator rights which control the user

profiles.

Analyst Group The default Analyst group name is
mic_[analyzer model number]_analyst. Members of the Analyst
group:

n have access to the Basic presentation option only.
n may create sample files from pre-defined methods and can modify

only a limited number of input fields.

Software in 21CFR11 Environments
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OPTION PRESENTATION FOR 21CFR11 ENVIRONMENTS
Options > Option Presentation

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option

is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Show Degas
Conditions

When enabled, displays the Degas Conditions tab when using
Advanced option presentation and the Degas Conditions drop-down
list when using Basic or Restricted option presentation. This option
may be deselected to hide the Degas Conditions tab.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

For members of the Developer group only. To change the view from Advanced
(for Developers) to Basic (for Analysts), click the view selector drop-down list at the
bottom of the window. Select either Advanced (when in Basic view) or Basic (when
in Advanced view).

Advanced view / Developer group Basic view / Analyst group
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A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.

n The Save button is disabled on sample files with a Complete status.
n When the Preview button is used to view reports for sample files with an unsaved status, the

report will have a Preview watermark.
n The Save As and Print buttons on the report window are also disabled.

CREATE A NEW FOLDER
File > Create New Folder
Provides the option to create and name a new folder in the Confirm application folder. This option
may not be available depending on how the IT Administrator configures Windows permissions.

Software in 21CFR11 Environments
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SYSTEM AUDIT TRAIL
File > System Audit Trail

Lists the current user, successful and failed application user login attempts, and contains a
description of all the changes made to sample files. Contains an audit trail of all system
initializations, user login attempts, and sample analyses.

UNINSTALL SOFTWARE IN 21CFR11 ENVIRONMENTS

When the software is uninstalled using uninstall.exe, only the files required to run the application
are removed. Parameter files, sample files, reports, calibration files, and data files are not
removed.

To uninstall the software, double-click the uninstall.exe file located in the software installation
directory, then follow the prompts.

To uninstall the Micromeritics Confirm application, the owner of the application
directory and its contents must be set to the account of the administrator that is
removing the application installation. This account must also have permission to
modify the application directory and its contents. This may require modification to the
owner and to the access permissions of the application directory and its contents.

Upon uninstalling the Confirm application, the system administrator should go into
Windows Users and Groups to remove the Confirm users and groups. See the
Confirm Administrator Guide [part number 004-42821-01].

Depending on the network, Windows may not allow the uninstall.exe program to run. If this
happens. follow these steps:

1. In Windows Users and Groups, verify that the current user is not a member of the analyst
group or developer group. If so, remove the user from the group(s). Log OFF, then log back
ON to the computer.

2. In Windows Explorer, in the Confirm installation directory, double-click the uninstall.exe file
to run the uninstall program.
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3 SAMPLE FILES
Option Presentation on page 2 - 10
Software in 21CFR11 Environments on page 2 - 26

Sample files include the information required by the analyzer to perform analyses and collect data.
A sample file identifies the sample, guides the analysis, specifies report options, and may be
displayed in Advanced, Basic, or Restricted presentation display mode.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either before or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

3 Sample Files
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3 Sample Files

CREATE SAMPLE FILES
Options > Option Presentation > Show Degas Conditions

File > New Sample > [.SMP File]

File > Open > [.SMP File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in
this section helpful. Sample file information that is available to Analysts is created by
a member in the Developer group using information in this section.

Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone.

Specify or change the option presentation by selectingOptions > Option Presentation or use
the view selector drop-down list at the bottom of the window.

Sample files created in the Basic option presentation are selected from parameter files created in
the Advanced option presentation. The values specified in the parameter portions of the default
method are the defaults for new sample files. To navigate from one set of parameters to another,
select the parameter tab across the top of the window.

Sample Tube parameters are edited on the Sample Description tab.

The Degas Conditions tab displays only if enabled inOptions > Option
Presentation > Show Degas Conditions
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File Editor Example for 21CFR environments

Advanced or Developer view Basic or Analyst view

A bar code reader may be used to enter text into many of the fields on the Sample
Description window. Use a mouse to click in the field first where information is to be
entered then scan the bar code with the bar code reader.

Selections Description
Add Log Entry [button] Use to enter information that will display in the sample log report that

cannot be recorded automatically through the application. Click the
button again to enter multiple log entries.

Bar Code [text box] * Use to enter additional information about the sample, such as a
sample lot number, sample ID, etc.

Comments [text box] Enter comments to display in the report header about the sample or
analysis.

Sample Files

Create Sample Files
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3 Sample Files

Selections Description
Mass [group box] Enter a value for sample mass. Mass can be changed any time

before, during, or after analysis.

Enter. Enables the Sample mass field. Enter a value for the sample
mass.

Calculate. Enables the Empty tube and Sample + tube fields. Enter
the values necessary to calculate the sample mass. Equation used
to calculate sample mass:

Masssample = Masssample+tube – Masstube
Method [drop-down box] Select a method from the drop-down list.

Operator [text box] * Enter operator identification information.

Sample [text box] * Enter a sample description.

Sample Tube
[drop-down box]

Select a sample tube file from the drop-down list, or click Edit to
modify or create a new sample tube file.

Submitter [text box] * Enter submitter identification information.

Type of Data
[group box]

Automatically collected. Select if the type of data will be
automatically collected by the system while an analysis is running.

Manually entered. Use to enter data manually that was collected
from another source. IfManually entered is selected, the Isotherm
Report becomes available in the Basic/Advanced drop-down list for
pasting or importing data into the file.

SeeManually Enter Data on page 3 - 7.
User Parameters
[group box] *

These fields are primarily used for the SPC (Statistical Process Con-
trol) reporting to specify sample characteristics or its manufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
SPC Report.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Sample Files (continued)

* This field label may have been renamed or may not display if modified inOptions > Default
Methods.
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OPEN A SAMPLE FILE
File > Open > [.SMP File]

When working with an existing sample file, consider copying the sample file to
maintain the original configuration options.

File Status Displays
Preparing
Prepared
No Analysis

Tabbed file editor

Complete
Analyzing
Entered

MicroActive report window

File Editor Example for CFR21

Advanced or Developer view Basic or Analyst view

Open a Sample File
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3 Sample Files

Example of a Report window

To view the tabbed file editor for a sample file with a Complete status, select Advanced from the
view selector drop-down list at the bottom of the window.

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.
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MANUALLY ENTER DATA

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

This process allows the manual entry of pressure data from a sample file with a Complete status.
There are two methods for manually entering data into a sample file:

n Copy and paste onto the graph area of the interactive window.
n Import data into the interactive window.

COPY AND PASTE MANUALLY ENTERED DATA

To display the file status in a search window, go to File > Open. Right-click the
column header then clickMore... Scroll to theMIC entries and enableMIC Status.

1. Open a sample file with a Complete status. The file will open in the interactive reports win-
dow.

2. Right-click in the graph area of the interactive reports window, then select Copy data.

Example of Report window

3. Open another sample file using the Advanced option presentation.
4. On the Sample Description tab, selectManually entered in the Type of Data group box.

Manually Enter Data
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3 Sample Files

5. In the view selector drop-down list at the bottom of the window, click Advanced, then select
Isotherm.

6. Ensure that all parameter fields are set appropriately, then click Paste.
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IMPORT MANUALLY ENTERED DATA
When importing isotherm data from an external ASCII text file using the Import button on the
interactive window, the ASCII text file must use the following rules:

ASCII text file format rules

Data must be in two columns and separated by a comma or white-space. Acceptable column
headings are:

n Relative Pressure
n Absolute Pressure (mmHg)
n Absolute Pressure (kPa)
n Absolute Pressure (mBar)

n Quantity Adsorbed (mmol/g)
n Quantity Adsorbed (cm³/g STP)
n Quantity Adsorbed (cm3/g STP)

Sample Physisorption ASCII Text File

Silica Alumina : Adsorption
Relative Pressure        Quantity Adsorbed (cm3/g STP)
0.108629                 50.6657
0.22288                  60.7813
0.339909                 71.3095
0.459512                 84.4172
0.577447                 102.672
0.654583                 121.707
0.760074                 179.096
0.855713                 334.565
0.958511                 394.675
0.996251                 403.793

Silica Alumina : Desorption
Relative Pressure        Quantity Adsorbed (cm3/g STP)
0.996251                 403.793
0.86016                  389.626

Manually Enter Data
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3 Sample Files

0.753567                 256.264
0.664418                 133.099
0.542416                 96.7366
0.422295                 79.7351
0.346371                 71.5994
0.2519                   62.8256
0.152718                 54.2336
0.103389                 49.5803
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To import the ASCII text file

1. Open a new sample file in Advanced option presentation.
2. On the Sample Description tab, selectManually entered.
3. In the view selector drop-down list at the bottom of the window, click Advanced, then select

Isotherm.

4. Ensure that all parameter fields are set appropriately, then click Import.
5. Open the .TXT file. The data from the original sample file is imported and displayed. If an

error message displays instead, verify that the .TXT file format is correct.

Manually Enter Data
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4 PARAMETER FILES

In 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Parameter file information that is available to Analysts is created by a
member in the Developer group using information in this section.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

Methods include both analysis conditions and report options, offering the most convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed, or new
parameter files created.

The following file types can exist as part of the sample file as well as individual parameter files.

File Type File Extension
Adsorptive Properties .ADP

Analysis Conditions .ANC

Degas Conditions .DEG

Method .MTH

Report Options .RPO

Sample Tube .STB

Parameter File Types

4 Parameter Files
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4 Parameter Files

ADSORPTIVE PROPERTIES
File > Open > [.ADP File]
(or click Edit next to the Adsorptive selection on the Analysis Conditions tab when in Advanced
option presentation)

Adsorptive properties provide the adsorptive (analysis gas) characteristics for the analysis.

Selections Description
Adsorbate molecular
weight [text box]

The molecular mass is used for the weight % column of the isotherm
tabular report and the pressure composition isotherm plot.

Adsorptive [text box] Name of the adsorptive gas whose properties are being defined.

Density conversion
factor [text box]

Factor determined by obtaining the ratio of the gas density (STP) to
the liquid density. This field is disabled if Non-condensing Adsorptive
is selected.

or

where

ρgas = gas density at STP

Adsorptive Properties
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Selections Description

ρliq = liquid density

ʋl = molar liquid volume

ʋg = molar gas volume at STP

Dosing Method
[group box]

Normal. Dose from a pressurized tank of gas attached to a gas inlet
port.

From Psat tube. Select if the Psat tube is to be filled with
condensed adsorptive and dosed from the Psat tube. Select this
option if using krypton. The analyzer will determine the maximum
pressure that can be dosed on the analysis temperature and the
saturation pressure information in Fluid Properties.

Ideal gas law with non-
ideality correction
[selection]

Use if there is no compressibility table for the gas being used or to
match existing data. This factor adjusts the ideal gas law for cal-
culating the quantity of gas in the cold free space. Most gases are
nearly ideal near room temperature and at pressures not much
above atmospheric pressure, so the cold free space is where the cor-
rection is most important. If selected, enter the non-ideality factor
field.

Maximum manifold
pressure [text box]

The highest pressure to which the manifold will be dosed. To avoid
damage to the analyzer, this number is limited to 925 mmHg. Low
pressure sources will require lower numbers. For gases to be used
for dosing after charging a tube from a gas inlet, enter the maximum
pressure for dosing from the inlet, not from the tube of condensate.

Mnemonic [text box] Enter the mnemonic name for the adsorptive. .

Molecular cross-sec-
tional area [text box]

The area that a single adsorbed molecule occupies on the surface of
the sample. It is used in surface area calculations.

Non-condensing
adsorptive [check box]

Select if using a non-condensing analysis gas. When selected, the
Density conversion factor field and the PSAT vs T button are dis-
abled.

Non-ideality factor
[text box]

Compensates for the forces of attraction between molecules in a real
gas. This value is used for a calculated free space.

Psat vs T [button] Click to edit the Psat vs Temperature table. The table contains sat-
uration pressures and their corresponding temperatures. To edit,
click in a field and enter the value.

Adsorptive Properties (continued)

Adsorptive Properties

TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023 4 - 3



4 Parameter Files

Selections Description
Therm. tran.
hard-sphere diameter
[text box]

Estimate of the molecular size used in calculating the thermal
transpiration correction.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Adsorptive Properties (continued)
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ANALYSIS CONDITIONS
Perform a Sample Tube Free Space Analysis on page 6 - 20

File > Open > [.ANC File]
Or, click the Analysis Conditions tab when in Advanced option presentation.

Analysis conditions specify the parameters used to guide an analysis.

Selections Description
Absolute pressure
dosing [check box]

Specifies pressure targets in mmHg or mbar instead of relative pres-
sure. If this option is selected, the Relative Pressure labels and
entries change to Absolute Pressure in the selected pressure units.

Adsorptive
[drop-down box]

Select an Adsorptive Properties file from the list of defined gases to
be used for analysis. After selection, click Edit to modify adsorptive
properties. See Adsorptive Properties on page 4 - 2. 

Analysis Conditions
[drop-down box]

Use to browse for an Analysis Conditions file that contains analysis
condition parameters to be used in the analysis.

Analysis Conditions

Analysis Conditions
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4 Parameter Files

Selections Description
Backfill [button] Select gas for backfilling the sample tube at the start and end of an

analysis.

The options are disabled if the file status is Entered, Complete, or
Analyzing.

Dose increments
[selection]

The sample is dosed repeatedly with a fixed amount of gas and
isotherm points are collected after equilibrating each dose.

Options. [button] Each entry in the table defines how much to dose
for a segment of the isotherm. In this form of dosing, there is no
predefined pressure table. Define target ranges for up to 10 dose
increments. The ending relative pressure and the dose amount
(entered or as the fraction of the previous quantity adsorbed) for
each target range are shown.

Analysis Conditions (continued)
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Selections Description
Equilibration [button] Provides options to specify the equilibration interval and delay time.

(Column heading reads Absolute Pressure (mmHg) when Absolute
Pressure Dosing is selected.)

Minimum equilibration delay at p/po > = 0.995. The minimum
number of seconds required before equilibration can occur for a
relative pressure greater than or equal to 0.995. This field is not
available if Absolute pressure dosing is selected on the Analysis
Conditions tab.

Relative Pressure (p/po) or Absolute Pressure. The pressure the
equilibration interval will be applied.

Free Space [button] Use to enter the free space measurement type.

Measure:

n Lower Dewar for evacuation. If the Dewar is to be lowered for
evacuation, select this option and enter the length of time for evac-

Analysis Conditions (continued)

Analysis Conditions
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Selections Description

uation after the free space measurement in the Evacuation time
field. If using a cryostat, the operator must manually move the
cryostat assembly when prompted.

n Evacuation time. The length of evacuation time prior to free
space measurement.

n Outgas test. Checks for system leaks or sample outgassing.
After free space is measured, the Dewar is lowered and the
sample evacuated for the specified amount of time. The leak test
is performed after evacuation. If the pressure rises more than
0.025 mmHg within the time specified in theOutgas test duration
field, outgassing is present. If a leak is found, the analysis stops
and the operator is notified. While leak testing slightly increases
analysis time, it prevents the continuation of analysis and col-
lection of erroneous data if a leak occurs.

Enter.Measures free space after analysis ends. Enter the estimated
free space measurements.

n Ambient free space. Empty sample tube gas capacity measured
at room temperature.

n Analysis free space. Empty sample tube gas capacity measured
with the Dewar raised.

Calculate. Use to have the free space measurement calculated
using the sample and tube parameters.

Analysis Conditions (continued)

4 - 8 TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023



Selections Description
Options [button] Available when the Target Pressures option is selected.

First Pressure Fixed Dose.

This option is most frequently used when performing a standard
nitrogen analysis of mesoporous materials such as catalysts. If
the first pressure table point is low and the gas uptake of the
sample is expected to be high, this option can shorten the time
required to reach the first point on the pressure table.

The sample is dosed repeatedly at low pressures with a specified
amount of gas until the first pressure point is reached. This initial
dosing quickly meets the adsorptive demand of the sample.

The first point on the pressure table is the threshold value,
triggering the transition from the Fixed Dose Mode to Pressure
Table Mode. When the first pressure table value is reached, Fixed
Dose Mode is disabled, and points are equilibrated and recorded
in accordance with the specified pressure table.

Enter the amount of gas to be added to the sample for each dose
cycle.

Maximum volume increment.

Select to determine when additional data points are collected
between target pressures in regions of adsorption. When the
maximum increment has been adsorbed since the last collected
data point, another point is equilibrated and collected. During
desorption, this field is treated as a maximum volume decrement
value.

Absolute / Relative pressure tolerance.

Analysis Conditions (continued)
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Selections Description
Values used to determine how close the actual pressure must be
to each target pressure from the pressure table. At lower
pressures, the relative tolerance value is lower. At higher
pressures, the absolute tolerance value is lower.

Experiment 1. There might be an absolute tolerance of 5 mmHg,
a relative tolerance of 5%, and a target pressure of 40 mmHg; 5%
of 40 mmHg is 2 mmHg. Since 2 mmHg (relative tolerance) is
lower than 5 mmHg (absolute tolerance), 2 mmHg is used.
Therefore a minimum pressure of 38 mmHg (40 - 2) must be
attained to collect data for a target pressure of 40 mmHg.

Experiment 2. There might be an absolute tolerance of 5 mmHg,
a relative tolerance of 5%, and a target pressure of 200 mmHg;
5% of 200 mmHg is 10 mmHg. Since 5 mmHg (absolute
tolerance) is lower than 10 mmHg (relative tolerance), 5 mmHg is
used. Therefore a minimum pressure of 195 mmHg (200 - 5) must
be attained to collect data for a target pressure of 200 mmHg.

Normally, surface area measurement points are widely spaced
and the resulting measurement is not very sensitive to the precise
location of points so wider tolerances may be used.
Unnecessarily tight tolerances lengthen the analysis.

p° and T [button] Click to select one option for obtaining the saturation pressure (Po)
and analysis bath temperature. Each selected option presents a
different set of parameters at the bottom of the window.

Options and descriptions:

1. Analysis bath temperature (not used for krypton analyses).
Measures the p0 on a continuous basis. Allows the meas-
urement of each data point without slowing the analysis.

Analysis Conditions (continued)
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Selections Description
2. Analysis bath temperature (not used for krypton analyses).

Measures the p0 on a continuous basis and over the sample,
then adjusts the measured p0 in the sample tube to agree with
the p0 over the sample.

3. The p0 and analysis bath temperatures or an analysis bath
temperature only (when Absolute pressure dosing is selected
on the Analysis Conditions window). This method uses the
entered values.

4. Psat gas. If this is a krypton analysis, select the Nitrogen@
77.35K option from the Adsorptive drop-down box. Click Psat
vs T to edit the values of the Psat vs T table. Editing the values
in the current table does not affect the original table.

5. Analysis bath temperature. Analysis bath temperature and
an estimate for the initial p0 (not used for krypton analyses).
Measures the p0 over the sample. After the p0 is measured,
the value is reapplied to all data points.

6. Analysis bath temperature. This method calculates the p0 at
the time of analysis using the entered temperature.

Preparation [button] Use to enter analysis preparation details.

Evacuation rate. The rate for restricted evacuation.

Evacuation time. The length of time for preliminary evacuation.

Fast Evacuation. Select for samples (such as pellets) that do not
fluidize or shed particles during evacuation.

Leak Test. Enables the system to check for leaks or sample
outgassing before the analysis. The leak test allows sample pressure
to rise during the test. If the pressure rises more than 0.15 mmHg,
the analysis does not proceed and the operator is notified. While leak
testing slightly increases analysis time, it prevents the continuation of
analysis and collection of erroneous data if a leak exists.

Analysis Conditions (continued)
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Selections Description
Leak test duration. Enter the duration of the leak test.

Unrestricted evac. from. The pressure at which unrestricted
evacuation is to begin. This option is enabled when Fast evacuation
is not selected.

Use TranSeal. Select if using the TranSeal to transfer the sample
from the preparation port to the analysis port under vacuum.

Pressures [button] Available when the Target Pressures option is selected. Use to edit
the Entered Pressures table.

The pressure table consists of relative pressure points at which
isotherm data are to be collected. An optional pressure increment
can be entered in the Pressure Increment column, which will cause
additional points to be collected at intervals of the pressure
increments up to the relative pressure specified in the Ending
Pressure column.

The relative pressure points may span the entire range of
0.000000000 to 0.000000001 p/p0. There must be one adsorption
branch (strictly increasing pressures) followed optionally by one
desorption branch (strictly decreasing pressures).

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Analysis Conditions (continued)
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DEGAS CONDITIONS
File > Open > [.DEG File]
Or, click the Degas Conditions tab when using Advanced option presentation.

Use this option only when the Smart VacPrep is installed. Degassing is a required
step in preparation for an analysis. The Degas Conditions tab provides settings that
will be automatically applied during the degassing procedure when using the Smart
VacPrep.

If using a FlowPrep or a VacPrep use the heating phase section for reference only.

The Degas Conditions tab displays only if enabled inOptions > Option
Presentation > Show Degas Conditions.

The Smart VacPrep Operator Manual can be found on the Micromeritics web page
(www.micromeritics.com).

Degas Conditions
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Selections Description
Copy QuickStart
degas conditions
from Smart VacPrep
Unit [drop-down box]

Use to copy the degas conditions settings from the selected
Smart VacPrep unit and port.

Degas conditions
[drop-down box]

Use to browse for a .DEG file that contains degas condition para-
meters to be used in the analysis.

Heating Phase [table] This option is applicable when degassing with a Smart VacPrep.

Enter up to five stages of degas conditions.

Temperature. Temperature at which the sample is to be held while
degassing.

Time. How long the sample is to be held at the specified temperature
before beginning to cool down.

Temperature Ramp Rate. The rate at which the temperature will
change while advancing to the hold temperature.

Degas Conditions
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Selections Description
Smart VacPrep
Evacuation
[group box]

Backfill sample tube. Indicate if the sample tube should be backfilled
automatically or wait for operator response.

Evacuation rate. Rate used for evacuation.

Evacuation time. Length of time for preliminary evacuation before
proceeding with the Heating Phase temperature schedule. The timer
starts when the vacuum level is reached.

Hold pressure. Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below the Hold pressure. This prevents damage to the sample
structure due to 'steaming' and /or elutriation due to excessive
escaping gas velocity.

Target temperature. Targeted temperature for evacuation.

Temperature ramp rate. Rate at which the temperature is to change
when advancing to the target pressure.

Unrestricted evac. from. Pressure at which the unrestricted
evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Degas Conditions (continued)
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REPORT OPTIONS

File > Open > [.RPO File]
(or click the Report Options tab when in Advanced option presentation)

The Calculations document can be found on the Micromeritics web page
(www.micromeritics.com).

Additional reports are available using the Reportsmenu.

Use to specify report options for data collected from an analysis or manually entered data. Report
Options files also help in customizing report details such as axis scale, axis range, column
headings, and components of thickness curve equations. These files may contain tabular reports,
plots, or both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options files may be defined to include overlay options. This system allows the overlay of
up to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a
different plot type from the same analysis.

Selections Description
Apply thermal
transpiration
correction

Use to correct the temperature-induced pressure difference between
the manifold and the chilled sample tube. This option is most sig-
nificant for pressures less than approximately 1.0 mmHg.
Always use thermal transpiration when performing micropore

Report Options
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Selections Description
[check box] analyses.

Inside diameter of sample tube. Enabled when Apply thermal
transpiration correction is selected. Enter the inside diameter of the
sample tube used in the analysis.

Refer to the Thermal Transpiration Correction section of the
Calculations document.

Overlays [button] SeeGraph and Sample Overlays on page 7 - 27.

Report options
[drop-down box]

Browse for a .RPO file that contains report options parameters to be
used in the report.

Selected Reports
[group box]

Select the report names to include in the report. For BJH reports, BJH
pore dimension can be calculated in pore width (w), pore radius (R), or
pore diameter (D). Go to Options > Units to specify default
calculations.

Show graphic
[text box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Report Options (continued)
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SAMPLE TUBE
File > Open > [.STB File]
Perform a Sample Tube Free Space Analysis on page 6 - 20

Or, click Edit next to the Sample Tube selection on the Sample Description tab when in Advanced
option presentation.

Sample Tube files specify information about the sample tube.

Selections Description
Ambient free space
[text box]

Empty sample tube gas capacity measured at room temperature.

Analysis free space
[text box]

Empty sample tube gas capacity measured with the Dewar raised.

Load from Sample
File [button]

Loads parameters from the selected sample file.

Non-ideality factor
[text box]

Compensates for the forces of attraction between molecules in a real
gas. This value is used for a calculated free space.

Sample tube
[drop-down box]

It is a good practice to label each sample tube with a unique iden-
tification. Enter that information here. This information will also appear
in the Sample Tube drop-down list on the Sample Description tab.

Use filler rod
[check box]

Select if a filler rod is to be used in the sample tube. A filler rod reduces
the stem free space volume resulting in reduction of free space error. It
is generally a good practice to use filler rods for samples having less
than 100 square meters of total surface area.

Sample Tube
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Selections Description
Use isothermal jacket
[check box]

Select if an isothermal jacket is to be used. An isothermal jacket main-
tains a constant temperature profile along the sample tube stem during
an extended analysis of more than 1 or 2 hours.

Vacuum seal type
[group box]

Select the seal type to be used.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Sample Tube (continued)

Sample Tube
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5 DEGASSING
Most solid materials absorb moisture and other contaminants when exposed to the atmosphere.
The sample must be clean when an analysis is performed. The degas process heats the sample
to remove the moisture and contaminants.

The Smart VacPrep Operator Manual can be found on the Micromeritics web page
(www.micromeritics.com).

DEGAS ON THE SMART VACPREP
Equipment Options and Upgrades on page 1 - 4

The Smart VacPrep Operator Manual can be found on the Micromeritics web page
(www.micromeritics.com).

TRANSFER A DEGASSED SAMPLE TO AN ANALYSIS PORT
Sample Data Worksheet for Gas Adsorption on page E - 1

When degassing on a separate degasser such as a Smart VacPrep, the sample tube must be
removed from the degas port, weighed, and then installed onto the analysis port for analysis.

If the sample tube is not mounted on the analysis port immediately, leave it on the
degas port. If it is necessary to remove the sample tube and a Check Seal or TranSeal
was not used, insert a rubber stopper into the sample tube.

1. Allow the sample tube to cool to room temperature (approximately 15 minutes).

Do not touch the sample tube or the heating mantle until they have reached room
temperature. Touching the sample tube, heating mantle, or heating mantle clip before
they have cooled could result in burns.

2. Carefully remove the heating mantle clip and the heating mantle from the sample tube.
3. While holding the sample tube, loosen the port connector nut and remove the sample tube

from the degas port. If a Check Seal or TranSeal was not inserted prior to degassing, imme-
diately insert a rubber stopper into the sample tube.

4. Complete the Sample Data Worksheet.
5. If using a Check Seal, ensure that the Check Seal opener is installed in the analyzer sample

port. If a rubber stopper was used, remove the stopper from the sample tube.
6. bulb
7. Place the connector nut, ferrule, and O-ring onto the sample tube stem.
8. On the analyzer, loosen the connector nut on the Psat tube and rotate it out of the way.
9. Position the Dewar cover so that the slot for the Psat tube is on the left.

5 Degassing
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5 Degassing

A. O-ring
B. Ferrule
C. Connector nut
D. Dewar cover

10. Insert the sample tube through one of the holes in the Dewar cover.
11. Place the sample port nut, ferrule, and O-ring onto the sample tube stem.
12. Insert the sample tube into the analysis port and ensure it is completely in the port. Securely

hand tighten the sample port nut onto the analysis port.
13. Position the Dewar cover approximately 3/4 in. (19 mm) below the sample port nut.
14. Slide the Psat tube into the Psat slot in the Dewar cover and retighten the Psat tube

connector nut.
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A. O-ring (1/4 in.
from top)

B. Ferrule
C. Connector nut
D. Isothermal

jacket

15. Install the Dewar onto the elevator and Close the sample compartment door.
16. Begin the analysis.

Transfer a Degassed Sample to an Analysis Port
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6 PERFORM AN ANALYSIS

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

DEWAR PRECAUTIONS

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the SDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

When handling Dewars containing liquefied gases or cryogenic liquids:

n Wear protective equipment:
o goggles or face shield
o an insulated or rubber apron
o insulated gloves

n When pouring liquefied gases from one container to another:
o cool the receiving container gradually to minimize thermal shock
o pour the liquified gas slowly to prevent splashing
o vent the receiving container to the atmosphere

6 Perform an Analysis
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6 Perform an Analysis

FOR GLASS DEWARS

n Use a plastic stirring rod when stirring substances in a Dewar containing liquefied gases (or
other materials of extremely low temperature). Do not use a glass or metal stirring rod unless it
has a protective coating.

n Do not handle heavy objects above the Dewar. If unavoidable, place a protective cover over the
Dewar opening. If an object of sufficient weight is accidentally dropped into the Dewar, shat-
tering may occur.

n If the Dewar has a protective mesh covering, do not remove it. This cover minimizes the risk of
flying particles should the Dewar be knocked over, dropped, or broken.
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PREPARE FOR ANALYSIS
It is recommended to perform the tasks in the provided order.

CLEAN AND LABEL SAMPLE TUBES

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

Sample tubes and filler rods must be clean and dry before samples are added and weighed. The
following table indicates which materials are needed for cleaning. The procedures following the
materials list are recommended.

Supplied by Micromeritics Supplied by User

n Filler rod
n Funnel
n Sample data worksheet
n Sample tube
n Sample tube brush
n Sample tube rack
n Sample weighing support
n Stopper for sample tube

n Acetone or isopropyl alcohol
n Analytical balance
n Detergent (such as Alconox)
n Drying oven
n Forceps
n Insulated gloves
n Pipe cleaners
n Rubber gloves or clean, lint-free cloth
n Safety glasses
n Ultrasonic cleaning unit
n Waste container

1. Preheat drying oven to 110 ºC.
2. Verify that the ultrasonic cleaning unit is clean.
3. Use 5 grams of Alconox (or other suitable detergent) per 500 mL of warm water and fill the

ultrasonic unit with enough water to cover the sample tubes and filler rods (if used). If too
much detergent is used, it may be difficult to rinse from the sample tubes. Ensure the deter-
gent is dissolved before placing the sample tubes and filler rods into the water.

4. Fill the sample tubes with warm water and place them in the ultrasonic cleaning unit, then
place the filler rods in the unit. Turn on the ultrasonic cleaning unit for approximately 15
minutes.

Prepare for Analysis
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6 Perform an Analysis

5. Use rubber gloves to ensure no oils or residue are transferred to the clean tubes and filler
rods, then remove the sample tubes and filler rods from the unit.

6. Clean the interior of the sample tubes with the brush supplied with the analyzer.
7. Rinse the sample tubes and filler rods thoroughly with hot water. Rinse again with isopropyl

alcohol or acetone. If isopropyl alcohol or acetone is not available, deionized water may be
used.

8. Stand the sample tubes on the sample tube rack and place the filler rods in a basket or in
the rack. Bake in a vacuum oven for two hours at 110 °C.

Samples tubes can also be cleaned with high-purity acetone or isopropyl alcohol and
dried for about 10 minutes under heat. If using this method, continue with step 10.

9. Remove the sample tubes and filler rods from the oven and allow to cool.

Do not insert the filler rods at this time. Filler rods are inserted before the sample tube
is installed on the analysis port.
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10. Blow out the sample tubes with oil-free compressed air.
11. Rinse the sample tube closure with isopropyl alcohol, then wipe the sample tube closure dry

with a clean, lint-free cloth.
12. Label the sample tube and stopper for identification.
13. Replace the rubber stopper, Check Seal, or TranSeal.

CREATE THE SAMPLE FILE

Create Sample Files on page 3 - 2

DETERMINE THE SAMPLE MASS

Sample Data Worksheet for Gas Adsorption on page E - 1

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

There are several different surface area ranges that require different protocol for optimal results.

n If there is between 0.1 m2 and 1 m2 in the tube, follow the recommendations for balancing the
free space using glass beads, along with filler rods, and measure the resulting free space
difference.

n If there is between 1 m2 and 5 m2 of total surface under test, measure the free space difference
between the two tubes as a part of each analysis.

n If there is between 5 m2 and 30 m2, use the option to calculate the free space difference
between the two tubes using the density of the sample in the tube, along with the mass entered.
There are some special considerations when using the tubes with the cylindrical bulb on the
end as opposed to the straight-walled tubes.

n If there is more than 30 m2 in the tube total, it may not be necessary to determine the free
space difference between the two tubes as a part of the analysis.

Smaller quantities are required for samples having high surface areas. These samples require
careful weighing after degassing because a small error may represent a considerable percent of
total mass. Proper weighing techniques are most important in this case. Use no less than 100 mg
to reduce the effect of weighing errors.

Care should be taken when loading powders: the accessory funnel is useful for this purpose.
Large granules or chunks may be loaded with forceps.

Analysis results are expressed in units of surface area per gram of sample; therefore, it is
important to know the true sample mass.

Create the Sample File
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6 Perform an Analysis

Follow the instructions on the Sample Data Worksheet and complete all fields to find the true
sample mass.

1. Record the sample tube identification on the Sample Data Worksheet.
2. Place the sample weighing support on the balance. Tare the balance and allow it to stabilize

at zero (0).
3. Place the empty sample tube set (empty sample tube and stopper) on the sample weighing

support and place it on the balance.
4. Record the stabilized mass on the Sample Data Worksheet. Remove the sample tube set

from the balance.

Do not touch the sample with bare hands while performing the following steps. Doing
so could affect the accuracy of results.

5. Place a sample container on the balance. Tare the balance and allow it to stabilize to zero.
6. Slowly pour the specified amount of sample into the sample container.
7. Remove the rubber stopper, Seal Frit, Check Seal, or TranSeal from the sample tube.
8. Use the sample tube funnel (provided in the accessories kit) and pour the sample from the

weighing container into the sample tube.
9. Replace either the rubber stopper, Seal Frit, Check Seal, or TranSeal.
10. On the Sample Data Worksheet, record the following:

n Mass of the sample tube set with the sample.
n Subtract theMass of empty sample tube set from theMass of sample tube set plus

sample.
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DEGAS THE SAMPLE

If using the Smart VacPrep degasser, go to Smart VacPrep > Unit [n] > Start
Degas, then degas the sample using menu commands and information entered on
the Degas Conditions tab. The Smart VacPrep Operator Manual can be found on the
Micromeritics web page (www.micromeritics.com).

After the sample has been weighed, use a degassing unit to remove any contaminants which may
have adsorbed to the surface or pores. Appropriate degassing units are available from
Micromeritics.

After degassing is complete, perform the following steps:

1. Weigh the sample tube set containing the sample.
2. Record the mass on the Sample Data Worksheet asMass of Sample tube set plus sample

(After Degas).
3. Subtract theMass of empty sample tube set (Before Degas) from theMass of Sample tube

set plus sample (After Degas) to obtain the sample’s mass. Record this value asMass of
sample (After Degas).

Degas the Sample
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6 Perform an Analysis

SAMPLE TUBE INSTALLATION

Repeat these steps for each sample tube to be installed.

If using... Then...
A rubber stopper Remove it.

An isothermal jacket Slide the jacket down over the stem of the sample tube until it touches
the sample tube bulb.

A filler rod Hold the sample tube horizontally and carefully slide the filler rod into
the tube.

Do not hold the rod vertically and drop the rod into the
tube; this could break the rod and/or tube.

1. Remove the sample tube stopper.
n If using a filler rod, hold the sample tube horizontally and carefully side the filler rod into

the tube.
n If using an isothermal jacket, slide the jacket down over the stem of the sample tube

until it touches the sample tube bulb.

2. Insert the P0 tube into the center hole of the Dewar cover and slide the cover up. Ensure the
tapered side of the cover is facing downward.

3. Insert the sample tube through one of the holes in the cover.
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A. O-ring
B. Ferrule
C. Connector nut
D. Dewar cover

4. Place the connector nut, ferrule, and O-ring onto the sample tube stem.
5. Attach the sample tube to the analysis port and ensure it is completely in the port. Securely

screw the connector nut onto the analysis port. Hand tighten the connector nut.
6. Slide the Dewar cover upward until it stops.

Sample Tube O-ring Replacement

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomes worn or cracked, it does not provide a good seal and will need to be replaced.

Before removing (or installing) a sample tube, ensure that the port valve is closed.
Observe the analyzer schematic to verify valve status.

Do not allow the sample tube connector nut drop onto the bottom of the tube as it may
break the tube.

Use the proper size frit for the sample port. The analyzer will not operate properly if an
incorrect size is used.

Sample Tube Installation
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6 Perform an Analysis

1. Carefully remove the Dewar from the analyzer. Take care not to bump the sample tube
bulbs with the Dewar during this process. Place the Dewar aside.

2. Hold the sample tube firmly with one hand, loosen the sample tube connector nut by turning
counter-clockwise.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to
grasp the sample tube with both hands.

A. O-ring
B. Ferrule
C. Connector nut

4. Remove the O-ring from the top of the sample tube and replace it with a new one.

If the O-ring remains inside the sample port, use the O-ring removal tool from the
accessory kit [tool part number 004-54618-00] or use a pair of tweezers or needle-
nose pliers to remove it.

5. After the new O-ring is in place, insert the sample tube back into the sample port until it is
fully seated.

6. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting
(the ferrule and O-ring will move along with the connector nut). Then, turning clockwise,
hand tighten the connector nut to the sample connector.
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FILL AND INSTALL THE DEWAR

Dewar Precautions on page 6 - 1

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

1. Fill the Dewar with the analysis bath liquid (such as liquid nitrogen) to no higher than
2 1/4 in. (5.7 cm) from the top. Filling the Dewar higher than this will cause an error in the
free space measurement.

Incorrect fluid levels can lead to measurement errors. Check the level of the bath
liquid before each analysis.

2. Insert the dipstick and check the level of the analysis bath liquid. Condensation should not
exceed the level indicator mark.

Fill and Install the Dewar
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6 Perform an Analysis

A. Wetness or frozen
condensation
indicates bath
liquid level

B. Level indicator
mark

3. For best results, if the Dewar has not been used for a while, allow approximately 30 minutes
for the temperature of the Dewar to stabilize with the bath liquid, then recheck the level of
the bath liquid. Add additional liquid if necessary.

4. Slide the Dewar cover to approximately 3/4 in. (19 mm) from the sample port nuts to ensure
a proper seal on the top of the Dewar.

5. Place the Dewar on the elevator.
6. Close the safety shield on the front of the analyzer.

Ensure the analyzer safety shield is in place before beginning an analysis. If the
analyzer is operated at an excessive pressure, the sample or balance tube could
become dislodged from its port, possibly causing personal injury or damage to the
equipment.
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PERFORM A KRYPTON ANALYSIS
Unit [n] > Krypton Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Krypton analyses are available only if the krypton option is installed.

Data collection is done sequentially — one analysis starts and completes before the
next analysis begins.

Use to perform up to three simultaneous krypton analyses. Use the following guidelines for
performing krypton analyses:

n All analyses must use krypton gas. An error message occurs if a gas other than krypton is
specified.

n From Psat tube must be selected as the Dosing Method on Adsorptive Properties. An error
message displays if Normal is selected as the Dosing Method. Samples cannot be
removed from or added to ports until the full set of analyses has completed.

1. Click Browse to select a sample file.
2. Click Report after analysis to automatically generate reports when the analysis is com-

plete. On the Report Settings window, select the report destination. ClickOK.
3. Click Start to start the analysis. A window displays data as they are collected. A short delay

is encountered before the port status changes from the Idle state at the bottom of the
window. When analysis is complete, remove the sample tube and store (or dispose) of the
sample material as applicable.

4. Click Start to start the analysis. A window displays data as they are collected. A short delay
is encountered before the port status changes from the Idle state at the bottom of the
window. When analysis is complete, remove the sample tube and store (or dispose) of the
sample material as applicable.

Perform a Krypton Analysis
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6 Perform an Analysis
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PERFORM A QUICKSTART ANALYSIS
Unit [n] > QuickStart Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Use to analyze up to three samples of the same type using the same analysis conditions,
adsorptive properties, and report options. TheQuickStart Analysis option automatically creates a
sample file for each port and assigns the default parameters. Edit the parameters of a file using
the Edit button or select another file using the Browse button.

Click Next to schedule additional analyses after the completion of the first set of analyses. The
Next button appears after the first series of analyses is complete. Samples cannot be removed or
added to ports until the full set of analyses has completed.

1. Click Browse to select a sample file.
2. Click Report after analysis to automatically generate reports when the analysis is com-

plete. On the Report Settings window, select the report destination. ClickOK.
3. Click Start to start the analysis. A window displays data as they are collected. A short delay

is encountered before the port status changes from the Idle state at the bottom of the
window. When analysis is complete, remove the sample tube and store (or dispose) of the
sample material as applicable.

4. Click Start to start the analysis. A window displays data as they are collected. A short delay
is encountered before the port status changes from the Idle state at the bottom of the
window. When analysis is complete, remove the sample tube and store (or dispose) of the
sample material as applicable.

Perform a QuickStart Analysis
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6 Perform an Analysis

Selections Description
Sample tube
[drop-down box]

Click the drop-down arrow to select a sample tube file. This option is
applicable only if the calculated method for measuring free space is
selected for analysis conditions.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

QuickStart Analysis
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PERFORM A SAMPLE ANALYSIS
Unit [n] > Sample Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

Use to perform up to three analyses with different analysis conditions and/or report options.
Sample files can be loaded into ports 1, 2, and 3 allowing one analysis using different analysis
conditions to run on each port.

When Start is selected, the selected sample file’s analysis conditions will be compared with the
port’s hardware configuration to verify that the specified analysis is supported by the hardware:

n If Krypton is selected as the adsorptive, there must be a 10 mmHg transducer present on
the port.

n The minimum target pressure must be no less than theMinimum Record Pressure for the
minimum range transducer present on the port.

n The selected sample files will be checked for matching adsorptive gases, matching Psat or
P0 gases if measured, and matching backfill gases. All selected gases, except those in a
precharged vapor source, must be connected to gas inlets and identified on the Unit [n]
> Unit Configuration > Gas Selections window. See Specify Gas Ports and Unit Con-
figuration on page 2 - 15.

n If any selected sample file specifies an Adsorptive Dose Method from port 3 and a sample
file is selected for port 3, an error message displays indicating the problem and the Start
window will remain active.

Perform a Sample Analysis
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6 Perform an Analysis

1. Click Close Valves to manually close all analyzer valves.
2. For a selected port, either click Browse and select a sample file, or click New to create a

new sample file.
3. Verify the information populated into the sample identification. This information is pulled

from the selected or newly created sample file. The Density value is applicable only if using
the Calculatemethod for the free space determination.

4. Edit the P0 and Bath temperature fields, if necessary.
5. If using a cryostat, select Use CryoStat and complete the Target tolerance and Hold time

fields.
6. Click Report after analysis to generate reports automatically when the analysis is com-

plete.
7. On the Report Settings window, select the report destination. ClickOK to return to the pre-

vious window.
8. Click Start to start the analysis. A window displays data as they are collected. A short delay

is encountered before the port status at the bottom of the window changes from the Idle
state.

9. When the analysis is complete, remove the sample tube and store (or dispose of) the
sample material as applicable.

Use caution when removing the sample tube if using a hanging filler rod. The sample
tube O-ring or Dewar cover may snag the filler rod retaining ring. Loosen the snag
gently as excessive force may break the tip of the filler rod.

Selections Description
Bath temperature
[text box]

Enter the temperature for the analysis bath.

Close Valves [button] Closes all valves on the unit.

Density / Mass / Sample
+ Tub[text box]e / Empty
Tube

Enter values for the sample’s mass and density. These values may
be edited after analysis.

New [button] Creates a new sample file.

P0 [text box] Enabled if Entered is selected for the P0measurement for at least
one file.

Report after analysis
[button]

Generates reports to the selected destination when the analysis is
complete.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Sample Analysis Graph
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A. Suspend/Resume/Skip
buttons

B. Port report buttons
C. Live graph settings

Selections Description
Port [button] Generates a report on data being collected on the respective port.

The reports are displayed on the computer monitor only.
Live Graph Settings
[button]

Select Thermal transpiration, x-axis Quantity (relative or absolute
pressure), and the x-axis Scale (linear or logarithmic).

Report after analysis
[button]

Generates reports to the selected destination when the analysis is
complete.

Status window Displays the last point pressure and relative pressure for each port
with varying numbers of digits after the decimal if 10 mmHg and 0.1
mmHg transducers are present on that port, as follows: P < 0.1: 6
digits, 0.1 <= P < 10: 4 digits, P >= 10: 2 digits. Relative pressure will
show 3 more digits than absolute pressure.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Sample Analysis Graph

Perform a Sample Analysis
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6 Perform an Analysis

PERFORM A SAMPLE TUBE FREE SPACE ANALYSIS
Unit [n] > Sample Tube Free Space
Use Sample Tube Free Space to select sample tube files (.STB), a free space gas, and method to
perform a free space analysis. The ambient and analysis free space values are stored in the
sample tube file. Once the free space is measured and stored in the sample tube file, the sample
tube file can then be selected in the sample file. Then the operator can set the free space
operation to Calculate.

The sample tube free space has as inputs the free space gas to use, the method to use (to obtain
the preparation options), the bath temperature, and the target sample tube files. The outputs are
the target sample tube files with updated analysis/ambient temperature free space values.

Once configured, the operator does not need to run a free space analysis on each sample. It is
calculated from the measured, empty tube free space corrected by the sample mass and density.

1. In the Sample Tube Free Space window, select a method, free space gas, and sample tube
file needed to perform free space analysis. Or click New or Browse to create a new or edit
an existing sample tube file. Ensure that an empty sample tube is attached to the selected
ports for the sample tube free space analysis.

2. Click Next.
After clicking Next, acknowledge that empty sample tubes have been installed on the
selected ports by clicking Next again. Wait for the free space measurement to complete.
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RUN AN ANALYSIS WITH THE UPDATED SAMPLE FILE

1. Go to File > New Sample to create a new sample file or File > Open to open an existing
sample file.

On the Sample Description tab, click the drop-down arrow in the Sample tube field and
select the updated sample tube file to be used for free space analysis.

The Sample mass and Density fields must be correctly entered to calculate the
volume in the sample tube displaced by the sample. This is used by the free
space Calculate option.

2. Go to the Analysis Conditions tab and click Free Space.

Perform a Sample Tube Free Space Analysis
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6 Perform an Analysis

3. Select Calculate.
4. Save the sample file and run the analysis.
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PERFORM AN EMPTY TUBE ANALYSIS
Unit [n] > Empty Tube Analysis

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

The volume correction is only used when calculated free space is selected. It accounts for any
difference in volume between the balance tube and the empty sample tube, and may be
determined by the following procedure: Perform a liquid nitrogen analysis using two empty sample
tubes of the same size. Select Measure for free-space option. After the analysis, record the
reported free-space difference in Unit Configuration and use it for these two tubes only for future
analyses with calculated free space.

1. Click Browse to select a sample file.
2. Click Report after analysis to automatically generate reports when the analysis is com-

plete. On the Report Settings window, select the report destination. ClickOK.
3. Click Start to start the analysis. A window displays data as they are collected. A short delay

is encountered before the port status changes from the Idle state at the bottom of the
window. When analysis is complete, remove the sample tube and store (or dispose) of the
sample material as applicable.

4. Click Start to start the analysis. A window displays data as they are collected. A short delay
is encountered before the port status changes from the Idle state at the bottom of the
window. When analysis is complete, remove the sample tube and store (or dispose) of the
sample material as applicable.

Perform an Empty Tube Analysis
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6 Perform an Analysis

PERFORM A REFERENCE MATERIAL ANALYSIS

Service Test Mode is required for this test. See Service Test Mode on page 11 - 21.

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

1. Remove the sample tubes from the degassing unit and reweigh the samples.
2. Place the filler rods into the sample tubes. Place the isothermal jackets on the sample tubes

and install the tubes on the sample ports.
3. Go to Unit [n] > Service Test > PCP Analysis.
4. Select the correct sample for the instrument:

n Nitrogen - if the instrument is a nitrogen unit.
n Krypton - if running an alumina sample for a krypton analysis.

5. Click Start to begin the analysis.
6. When the analysis completes, go to Reports > Start Report to view the report. Locate the

report file in the c:\......Data\PCP\ directory. An example of the file name is 1N217-0.SMP
where the first digit is the port number (1, 2, or 3), the letter N (for nitrogen), the unit serial
number (217), and -0 (1, 2, 3, etc.) to indicate the number of the run.

7. Select the report and click Report.
8. On the Report Settings window, select Preview as the destination for the report and click

OK.
9. When the analysis is complete, compare the BET Surface Area shown in the report with the

BET Surface Area shown on the reference material bottle.
n If the results are within tolerance, the instrument is operating properly.
n If the results are not within tolerance, refer to the following table for possible causes and

actions. After performing the action, perform the reference material analysis again.

Cause Action
The sample was not degassed
properly.

Degas the sample again.

The gas lines are not clean. Clean and verify the gas lines. See Clean and Verify
the Gas Line on page 11 - 9. See.

The measured free space is too high.
This indicates the helium may not be
pure enough.

Ensure the helium is 99.999% pure.
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7 ABOUT REPORTS
Reports can be generated for data collected on a sample that has completed analysis, collected
on a sample currently being analyzed, or manually entered.

Reports > Start Report
Generates a report on a sample analysis.

Reports > Close Reports
Closes all open reports. This option is unavailable if reports are being generated.

START REPORTS
Reports > Start Report
Starts the selected report. Select a file from the Files list. Ensure the selected file has a status of
either Complete or Analyzing.

7 About Reports
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7 About Reports

HEAT OF ADSORPTION REPORT
Reports > Heat of Adsorption

Use to select sample files, define quantities, and generate a Heat of Adsorption report. The
isosteric heat of adsorption is an important parameter for characterizing the surface heterogeneity
and for providing information about the adsorbent and the adsorption capacity. Multiple adsorption
isotherms are obtained on the same sample using the same adsorptive but at different
temperatures to obtain the heat of adsorption.

Selections Description
Add Samples [button] Adds a sample file to the table.

Clear Samples [button] Removes all entries from the table.

Edit Quantities [button] Specifies the range of surface coverage to include in the report.

Heat of Adsorption Report
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Selections Description

Insert Range. Specifies the starting and ending quantities adsorbed
and number of points to insert.

Load Table. Imports values from another file.

Save Table. Saves the current table as a .QNT file.

Apply. Applies all table changes.
Heat of adsorption plot
[selection]

Generates the Heat of Adsorption data in a graphical format.

Isostere plot [selection] Generates a graph showing quantities of gas adsorbed versus the
temperature.

Remove Sample
[button]

Removes the selected sample from the list.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples that contains the
numeric values contributed by each sample.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Heat of Adsorption Report (continued)

Heat of Adsorption Report
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7 About Reports

SPC REPORT
Reports > SPC Report Options
Use to generate reports with various SPC (Statistical Process Control) options. All selected
variables must be computed for each sample file used in an SPC report; therefore, it is more
efficient to select only the necessary variables.

The selected items display as graph variable selections in Reports > Regression Report and
graph selections in Reports > Control Chart. If report options for NLDFT Advanced PSD are
required, clickMore.
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REGRESSION REPORT
Reports > Regression Report
Use to generate a Statistical Process Control (SPC) Regression report to determine the
interdependency between two variables. Up to three dependent variables (y-axis) may be plotted
against a single independent variable (x-axis). The degree of correlation between the variables is
also reported.

Selections Description
Autoscale [check box] When enabled, allows the x- and y-axes to be scaled automatically.

Axis Range [text box] Enter the beginning and ending values for the x- and y-axis ranges.
These fields are disabled if Autoscale is selected.

Label data [check box] Use to label the points on the plot to correspond with the values in
the sample files.

Recalculate archived
SPC results [check box]

If selected, SPC results are archived in the sample files when a
report is generated. If deselected, previously archived results are
used to save time when generating reports. Since this option
updates and saves sample files, do not use it with sample files that
need to remain compatible with other applications.

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.

Save as Default [button] Click to save selected report options as default report settings.

Regression Report

Regression Report
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7 About Reports

Selections Description
Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples that contains the
numeric values contributed by each sample.

X- and Y-Axis variable
[drop-down box]

Designates the x- and y-axes variables. The variables in the drop-
down lists are those selected in the Reports > SPC Report Options
window. Use these options to plot the regression of up to three y-axis
variables against the x-axis variable.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Regression Report (continued)
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CONTROL CHART REPORT
Reports > Control Chart
Generates a Statistical Process Control (SPC) chart report which plots the changes in a statistic.

Selections Description
Graph [n] [button] Defines the y-axis of each graph.

Statistic. Displays the SPC variables selected on the Reports >
SPC Report Options window. The selected variable will be plotted
for each selected sample. This selection also becomes the y-axis
label.

Autoscale. Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To
fields.

Control Chart Report

Control Chart Report
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7 About Reports

Selections Description
Center Line. Displays placement options for the center line in the
graph. Select Entered to specify placement of the line orMean to
place the center line at the calculated mean value for the selected
samples.

Limit Lines. Displays limiting lines options. Lines can be placed at
some multiple of the standard deviation or at specified positions
(Entered). When Entered is selected, enter the High limit and Low
limit fields with appropriate values.

Recalculate archived
SPC results [check box]

If selected, SPC results are archived in the sample files when a
report is generated. If deselected, previously archived results are
used to save time when generating reports. Since this option
updates and saves sample files, do not use it with sample files that
need to remain compatible with other applications.

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples that contains the
numeric values contributed by each sample.

Control Chart Report (continued)
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Selections Description
X Axis Order By
[group box]

Select the order in which x-axis statistics are placed. Sort by: 

Time. Time the files were analyzed.

File name. Alphanumeric order.

Date. Date the files were analyzed.

Minutes.Minutes elapsed from the first file placed on the list, which
is the earliest-analyzed file.

Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Control Chart Report (continued)

Control Chart Report
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7 About Reports

MICROACTIVE REPORTS
This feature provides a quick and easy way to investigate and manipulate analysis data using a
variety of reporting methods.

When a sample file with a status of Complete, Analyzing or Entered is opened, a linear plot and
log plot of the data collected during analysis are displayed as well as a summary of the analysis
giving the total pore volume. Numerous reports are accessible from a drop-down menu.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters (for example, thickness curve type, pore geometry, and interaction parameters) are
also displayed. Plots may be edited by selecting the data points or data point range to be included
in the plots and modifying the parameters. When a report is edited, the results are immediately
reflected in the plots and summary data.
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INTERACTIVE REPORTS
When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

n a linear plot and log plot of the data collected during analysis.
n a summary of the analysis giving a single total pore volume and surface area.

1. To view the plots in either relative or absolute pressure, select either the Relative Pressure
or Absolute Pressure option.

2. To view the reports selected for generation during the analysis, click Preview.
3. From the view selector drop-down list at the bottom of the window, do either of the following:

n Change the option presentation of the sample description window to either Basic or
Advanced to modify certain file parameters.

n Select another plot from the list and edit the data contained in the plot.

4. When ranges are edited, the changes are reflected immediately in the plots and the sum-
mary data displayed in the window. Some editing options are:
n Drag the blue bars to increase or decrease the range of data included in the plot.
n Edit the Isotherm Linear Plot to include or omit the data point from the BET plot.
n Right-click to display a popup menu to include reports; enable or select overlays; edit

curves, axes, legends, titles; and copy and paste the data in a graph or in tabular
format.

5. Click Save.

Interactive Reports
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7 About Reports

EVALUATE REPORT RESULTS
Analysis reports provide a record of test conditions, experimental data, and information extracted
from the experimental data by application of various reduction methods. This topic discusses the
elements of various reports presented by Micromeritics’ static volumetric physisorption analyzers
and suggests ways by which the merit of the reported information may be evaluated.

Regardless of the precautions exercised before the analysis, problems still may occur during the
analysis, or as a result of using inappropriate parameters or even inappropriate methods. The
analysis data should be inspected for evidence of experimental error. The traditional method of
confirming the quality of the experiment is to repeat the analysis. Toward that end, Micromeritics’
analyzers log and report the exact conditions of each analysis.

Analysis data can be evaluated by:

n Viewing the Validation Report
n Inspecting the Isotherm Plot
n Evaluating the Isotherm Tabular Data Set
n Reviewing Reduced Data
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VIEW THE VALIDATION REPORT
The Validation report shows whether the data collected during an analysis are within typical
ranges. Select the types of reports to include by selecting the report in the Validation Report
Options window.

When a selected report is generated, if errors occur, a message is displayed across the top
portion of the report and a unique symbol displays on the graph.

INSPECT THE ISOTHERM PLOT

Evaluation of data should begin with a visual inspection of the isotherm plot. The plot should be
composed of data which have not been subjected to mathematical smoothing as far as possible. If
the data describe a Type I isotherm, then the plot is best shown on a logarithmic pressure axis so
that details of the low pressure region are revealed. Data in this region are important particularly
for micropore studies. Examine the plot to determine if any points are outliers or if a region of the
isotherm exhibits characteristics (spikes, steps, etc.) which are inconsistent with the physical
process being monitored. The philosophical question of whether or not these suspected
extraneous data points should be removed from the raw data is not considered here, but it may be
appropriate to exclude an outlier from reduced data. Too many outliers can cause the integrity of
the total data set to come under suspicion.

Examine specific reported values to confirm that the isotherm data were collected under
reasonable conditions and using reasonable parameters. For example, confirm that the free
space values reported are typical for the sample holder and bath in use. A problem with either
ambient or analysis free space values may indicate a free space measurement error and affect all
calculations of quantity adsorbed.

Evaluate Report Results
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7 About Reports

The raw data should be carefully examined before it is reduced. Errors that occur in raw data will
only be exacerbated in reduced data.1 )

EVALUATE THE ISOTHERM TABULAR DATA SET

Another place to look for reasonableness of the data is the adsorptive uptake by the sample in the
BET range (P/P0 = 0.05 to 0.30). Total uptake is the specific quantity adsorbed (cm3/g STP) times
the sample mass (g). As an example, the level of uncertainty in this range typically is less than
0.1 cm3 STP for a high performance system. Total uptake quantities should be some multiple of
this level of uncertainty. Otherwise, an unfavorable signal-to-noise ratio and unreliable data result.
The solution is to use a greater quantity of sample to increase adsorptive uptake.

Another valuable bit of information resides in the tabulated saturation pressure. This pressure is
expected to change somewhat over the duration of an analysis, but it is not expected to do so with
large or abrupt transitions. Unreasonable saturation pressures or unusual changes may indicate
that a gas different from the adsorptive was used in determining P0, that the level of the cryogen
fell too far, or that the cryogen is impure or inappropriate.

With experience, obvious signs of problems can be detected by a quick inspection of the tabular
and graphical data. If the data appear satisfactory, the next step is to evaluate the reduced data.2 )

REVIEW REDUCED DATA

Isotherm data may be analyzed by any one of several reduction methods depending on the
analyzer model and pressure range employed. The quality of the results depends on the quality of
the isotherm, the congruity of the data reduction parameters with experimental conditions, the
agreement of the theoretical model with the physical gas-solid system, and compliance to the
pressure range over which the method is valid. Typically, results can be appraised by examining a
few salient areas of the report as described in the following topics.3 )

1 ) The information in this article is extracted from Analytical Methods in Fine Particle Technology,
Webb, P. and Orr, C., (1997).
2 ) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).
3 ) Most of the information in this article is extracted from Analytical Methods in Fine Particle
Technology, Webb, P. and Orr, C., (1997).
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PHYSICAL PARAMETERS

The value of physical parameters which are used only in data reduction routines should be
reviewed to assure that they agree with experimental conditions. These parameters can be
changed and the experimental data recalculated if an error is discovered or if exploring an
alternate value is desired. Analysis condition values used in the calculation of quantity adsorbed
can be changed also. These are typically the manually entered free space(s), nonideality
correction factor, and bath temperature.

The area occupied by a single adsorbed molecule is a required parameter in the calculation of
surface area by the BET and Langmuir methods. The software provides a default value, but other
values are found in the literature. McClellan and Harnsberger1 ) provide a comprehensive review
of such values.

The volume of pores of a specific size range is calculated from the gas quantity adsorbed in them
by converting the quantity to its liquid equivalent volume. This is achieved through use of a density
conversion factor calculated from the ratio of molar densities of the condensed adsorbate at bath
temperature to the gaseous phase at STP. The necessary information is found in handbooks. The
software contains default values for common adsorptives; values for other adsorptives must be
calculated.

The terms for liquid surface tension , contact angle between solid and liquid phase , molar
volume of the adsorbate , gas constant , and sample temperature are treated as one
constant, the adsorbate property factor expressed by:

using which, the Kelvin equation2 ) reduces to

Either surface tension, contact angle, or molar volume can be revised individually to give a new
value for the factor , or can simply be altered arbitrarily for exploratory purposes.

The thermal transpiration correction requires two parameters which may be adjusted from those
of the default values. The first is the inside stem (neck) diameter of the sample holder, and the
second is the hard-sphere diameter of the adsorptive molecule. The sample holder inside
diameter is available from the documentation provided with it or is measurable. Information on
hard-sphere diameters of molecules may be obtained from handbooks.

1 ) McClellan, A.L., and Harnsberger, H.F., Journal of Colloid and Interface Science, 23, 577
(1967).
2 ) Thomson, W., Phil. Mag. S., 42, 448 (1871).

Evaluate Report Results
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7 About Reports

For terms such as the interaction parameter found in the Horvath-Kawazoe calculation1 ) , the
Dubinin affinity coefficient, or Astakhov exponent2 ) , the default values as provided by the
software generally are adequate. A search of the technical literature is required if the analysis
involves a gas-solid system other than that covered by the default values.

The t-Plot method plots quantity adsorbed against thickness (t) derived from a thickness equation,
and the Dubinin transform plots quantity adsorbed against log(P/P0)n. All of these data reduction
methods were first proposed for specific applications. The user must make a judgment as to the
applicability of the method to a gas-solid system.

If applied appropriately, all transform plots will exhibit a linear range and the regression analysis
must be applied only over the linear range and within the range of application. Fitting a regression
line to surface area transformation plots should yield a correlation coefficient of 0.9999 or better
and for t-plots and Dubinin plots the correlation coefficient should be 0.99 or better.

If the data reduction model does not apply to the gas-solid system under examination, then it may
be that either no linear range exists within the pressure range of validity, or that solutions derived
from the regression line of the linear range are intuitively incorrect, that is, they have no relevance
to the physical situation, such as a negative C-value from a BET transform.

BET C-VALUE

BET theory assumes uniform surface coverage with no favored adsorption sites and it also
assumes that the gas is more strongly attracted to the surface than to other gas molecules. The
typical range of BET C-values is from about 5 to well over 100. Values much less than 5 imply that
the gas-to-gas affinity is competing with the gas-to-solid affinity which conflicts with the basic
assumptions of BET theory. C-values much greater than 100 indicate very strong attraction for the
surface or preferential adsorption.

Provided the isotherm was determined with negligible error and the regression line to the BET
transformation data was fit properly, then an out-of-range C-value probably indicates that the gas-
solid interaction for the particular sample material does not conform to the BET model. An
inappropriate adsorption model may be indicated also by the coefficient of correlation of the
regression line, 0.999 being about the minimum value expected with five more or less equally
spaced points. In the case of indications of poor conformance to the BET model, the Langmuir
data reduction method should be examined.

1 ) Everett, D.H. and Powl, J.C., J. Chem Soc., Faraday Trans. 1, 72, 619 (1976).
2 ) Dubinin, M. and Radushkevich, L.V., Proc. Acad. Sci. USSR, 55, 331 (1947).
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DATA ANALYSES BY THE BJH METHOD

In general, this method visualizes the incremental decomposition of an experimental isotherm,
starting at the highest relative pressure or pore size. At each step the quantity of adsorptive
involved is divided between pore-emptying and film-thinning processes and is accounted for
totally. This computational algorithm frequently leads to inconsistencies when carried to small
mesopore sizes. If the thickness curve used is too steep, ultimately it will predict a larger
increment of adsorptive for a given pressure increment than is actually observed. The algorithm
must stop since a negative pore volume is nonphysical. Accumulated error results in the
calculation of a too large volume of (possibly nonexistent) small pores if the thickness curve used
underestimates film thinning.

Evaluate Report Results
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7 About Reports

REPORT FEATURES AND SHORTCUTS
Graph Features and Shortcuts on page 7 - 22

In 21CFR11 environments, members of the Analyst group must click Preview on the
sample file window to access this screen.

Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature,
or axis cross-hairs.

n After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
n The report zoom feature provides the viewing of fine graph details and the ability to shift the

axes.
n All reports contain a header displaying file statistics.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

If configured, the report header can also contain a graphic and/or a title.

n Tabular and graphical reports contain sample and analyzer statistics such as analysis date/-
time, analysis conditions, etc.

n The headers contain notes of sample file changes occurring after analysis.
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REPORT HEADER SHORTCUTS
Right-click in the report header to display header shortcuts.

Selections Description
Copy header as text Copies the report header as text. Text is copied to the clipboard and

then can be pasted into other documents.
Edit Opens a dialog box for editing the report title.

Report Header Shortcuts

Report Features and Shortcuts

TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023 7 - 19



7 About Reports

REPORT TOOLBAR
The Report window has a toolbar on the right portion of the window and selectable tabs at the top
of the report header. To view a specific report, either select the tab or the report in the Reports list
box, then click Show.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

Selections Description
Default Style [button] Specifies default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in the Reports list box. Deleted reports
will have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in the Reports list box.

Print [button] Displays the Print window for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hid-
den using the Hide button.

Show [button] Displays the selected or hidden report in the Reports list box.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Report Toolbar
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TABULAR REPORT FEATURES AND SHORTCUTS
Display tabular report shortcuts by right-clicking in the body of the tabular report. Column
shortcuts require right-clicking on the column to be modified.

Selections Description
Align column Changes the column alignment to either left, right, or centered.

Copy table as text Copies the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Edits the report title and/or title font attributes. Click Font to modify
font attributes.

Move column Right-click the column to be moved. SelectMove column on the short-
cut menu and select Left or Right for the move.

Rename column Right-click the column to be renamed. Select Rename column on the
shortcut menu and enter the new column name.

Resize column Right-click the column to be resized. Select Resize column on the
shortcut menu and enter the new column width in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right-click in the report data. Select Table data font on the shortcut
menu.

Table header font Right-click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Tabular Report Shortcuts

Report Features and Shortcuts
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GRAPH FEATURES AND SHORTCUTS
Right-click in the graph area to display graph report shortcuts.

Selections Description
Autoscale all axes Returns the report to full view after using the zoom feature.

Copy data Copies the report data to the clipboard. It can then be pasted into
other software programs as tab-delimited columns or copied as an
overlay onto another graph.

Copy graph Copies the graph to the clipboard. It can then be pasted into other
software programs.

Edit axis Edits the selected axis properties.

Gridlines. Changes how to display major / minor grid lines.

Scale.
n Autoscale minimum/maximum. To manually specify minimum /

maximum autoscale, deselect the option and enter the new
amount in the text box.

n Invert scale. Inverts the scale.
n Linear/Logarithmic. Scales the graph as linear or logarithmic.
n Scale font. Modifies the font for the scale label. Deselect Use

default font to enable font options.

Title. Edits the selected axis label.

Title font.Modifies the font for the selected axis label. Deselect Use
default font. Select new font attributes for report data. Enable Use

Graph Shortcut Options
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Selections Description
default font to reset default fonts.

Edit curve Edits selected curve properties.

Color. Changes the curve color.

Curve. Changes the interpolation, point style, and pen style for the
selected curve. These options are disabled if Use default fill style is
selected in the Histogram group box.

Histogram. Enabled only if Histogram is selected in the Style drop-
down list. Specifies the type of fill, fill color, and label position for the
selected curve.

Label. Designates where the graph point labels will display (left,
right, center, etc.) on the SPC report.

Style. Selects another style for the collected data curve.

Title. Changes the title of the selected curve.

Use default thickness. Uses the default curve thickness. Deselect
to enter a new thickness number in the Thickness text box.

Graph Shortcut Options (continued)

Graph Features and Shortcuts
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Selections Description
Edit legend Changes the legend location and font.

Edit title Changes the report title.

Enable overlays If overlays have been selected, this option displays (or hides) the
overlays.

Include report When selected, places a checkmark to the left of the report in the
Select Reports list box on the Report Options tab.

Reset axis limits to
initial setting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Select overlays... Displays the option to select files to overlay onto the active graph. To
view the overlays, click Enable Overlays on the shortcut menu.

Show curve Displays a list of all curves. Select the curve(s) to display.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Graph Shortcut Options (continued)
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AXIS CROSS-HAIR
Left-click on the graph to view the cross-hair coordinates.

Example of
Axis cross-hair feature

ZOOM FEATURE
Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A box will display in the area to be enlarged. To return to normal
view, right-click in the graph and select Autoscale all axes.

Graph Features and Shortcuts
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7 About Reports

GRAPH GRID LINES
Options > Graph Grid Lines

Use to select how grid lines appear on reports. This menu option is not available if using
Restricted option presentation.

Selections Description
Grid Line Styles
[selection]

Select if the major and/or minor grid lines should appear as solid or
dotted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the
logarithmic and linear scales. Deselect this option to remove the grid
lines.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Graph Grid Lines
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GRAPH AND SAMPLE OVERLAYS

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

n Multiple Graph Overlays.Overlay two different types of graphs from one sample.
n Multiple Sample Overlays.Overlay graphs of the same type with that of the current plot. This

type of overlay is available only for:

o BJH Adsorption / Desorption
o DFT Pore Size / Surface Energy
o Dollimore-Heal Adsorption / Desorption
o Horvath-Kawazoe
o M-P Method

This feature is available only when using Advanced option presentation. Go to
Options > Option Presentation > Advanced.

Graph and Sample Overlays
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7 About Reports

GENERATE PORE SIZE DISTRIBUTION GRAPH OVERLAYS

The following reports in the physisorption applications can produce graphical results for a sample
material's pore size distribution:

BJH Adsorption/Desorption Report on page 8 - 8
DFT Pore Size Report on page 8 - 14
Dollimore-Heal Adsorption/Desorption Report on page 8 - 18
Horvath-Kawazoe Report on page 8 - 31

Two methods can be used to import and overlay report data into another interactive graph using
shortcut menu options:

n Import ASCII text data. Data can be imported from an ASCII text file into the interactive graph.
The ASCII text file must follow certain rules.

n Copy/paste. Data can be copied from one sample file (source) and pasted into another sample
file (target).

Pore size distribution report overlays menu selections are:

n Copy data
n Paste data
n Edit Imported Data
n Display Imported Data
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IMPORT ASCII TEXT DATA
ASCII text file format rules

n The header must consist of one line to include title, two unit specifications, and distribution
type:

o Accepted pore dimension units are: A, nm, um
o Accepted pore volume units are: cm3/g, cm3/g, mL/g
o Accepted distribution types are: cumulative, incremental

Two examples of a header format:

My Title (A, cm3/g, incremental)
My Title (A, cm3/g, cumulative)

n The data must be in two columns and should be separated by a comma or white space.
n The data lines must be ordered so that pore dimensions are monotonically increasing or

decreasing.

Window appearance will vary depending on the selected report. This function can be performed
on samples files with a Complete status or during an analysis.

1. Create the ASCII text file using the proper format as indicated above.
2. In the analyzer application, go to File > Open.
3. Select a sample file to overlay graphs on to.
4. ClickOpen (or double-click the file name).
5. Right-click in the graph area and select Edit imported data.

Generate Pore Size Distribution Graph Overlays
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7 About Reports

6. In the Select Imported Overlays window, if the ASCII text file does not display, click Import
to locate the file.

7. Select the ASCII text file in the Select Imported Overlays window, then clickOK. If an error
message is displayed, verify that the .TXT file format is in the correct format.

8. To include the overlay data in a printed report, see Print Pore Size Distribution Overlay
Data in Reports below.

OVERLAY PORE SIZE DISTRIBUTION DATA USING COPY/PASTE
1. Open a source sample file and a target sample file; both should have a Complete status.

The report will open to the interactive reports window.
2. In the source sample file, right-click on the graph and select Show Curve.
3. Deselect any differential curve data to hide them in the graph.
4. Right-click in the graph area again and select Copy Data.
5. Change to the target sample file, right-click the graph, and select Paste data. The graph

now displays overlayed data from the source sample file.

Typically, one new graph will appear showing both the cumulative and differential curves.
To show or hide individual curves, right-click the graph and select (or deselect) Display
imported data.

6. Ensure that all parameter fields are set appropriately, then click Paste.
7. To include the overlay data in a printed report, see Print Pore Size Distribution Overlay Data

in Reports.

Print Pore Size Distribution Overlay Data in Reports

1. Open the sample file containing the overlay data and select Advanced from the view
selector drop-down list at the bottom of the window.

2. Click the Report Options tab.
3. In the Selected Reports list box, select the cumulative, differential, or incremental intrusion

graph to show the imported distribution data, then click Edit (or double-click the selected
report).

4. In theOverlay drop-down box, select Imported.
5. ClickOK to close the window.
6. Click Preview on the Report Options tab.
7. Click Print in the reports toolbar section to display print options.

7 - 30 TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023



OVERLAY MULTIPLE SAMPLE FILES

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

To overlay the same type of graph on multiple samples:

1. Go to File > Open.
2. Select a .SMP file, then clickOpen. If the Isotherm plot displays, select Advanced from the

view selector drop-down list at the bottom of the window to display the tabbed window view.
3. Click the Report Options tab.
4. In the Selected Reports list box, highlight a report then click Edit. Use the following table to

complete the process for the selected report.

Overlay Multiple Sample Files
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7 About Reports

If overlaying this type of
report...

Then...

n Isotherm

a. On the Isotherm Report Options window, select one or
more plots in the Selected Reports group box, then click
Options to the right of the selected plot.

b. On the Plot Options window, select Plot curve and/or Plot
points if they are to be included in the overlay. If the x-
and/or y-axes are to be autoscaled, enable Autoscale; oth-
erwise, enter the From and To points for the axes. Click
OK.

c. On the Isotherm Report Options window, in the Plot
Options group box, select Plot overlays. ClickOK.

d. Continue to Step 5.

n Alpha-S Method
n BET Surface Area
n f-Ratio Method
n Freundlich
n Langmuir Surface Area
n t-plot
n Temkin

a. On the pop-up window, selectOverlay samples. Verify
other fields. ClickOK.

b. Continue to Step 5.

n BJH
n Dollimore-Heal
n MP-Method

a. Select the report variable from the Selected Reports
group box, then click Edit.

b. Click the down arrow on theOverlay field, then select the
Samples option.

c. Verify other fields.
d. ClickOK.
e. ClickOK again.

5. On the Report Options tab, clickOverlays.
6. On the Plot Overlay Sample Selection window, move up to 25 files from the Available Files

box to the Selected Files box:

7. ClickOK.
8. To view the report, click Preview.
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Selections Description
Available Files
[selection]

Lists files that meet the selected criteria. Select the files to be com-
bined, then click Add. The selected files are moved to the Selected
Files list box.

Look in [button] Changes the file folder location. Click the Browse icon.

Selected Files
[selection]

Lists the files selected to be combined. Click Remove to move a file
back to the Available Files list box. ClickOK to combine the files.

Status [drop-down box] Selects the status of files to be combined.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Overlay Sample Selection

Overlay Multiple Sample Files
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7 About Reports

IMPORT ASCII PORE DISTRIBUTION DATA

Manually Enter Data on page 3 - 7

IMPORT AN ASCII TEXT FILE USING GRAPH SHORTCUTS
1. Create an ASCII text file.
2. Open a report with a Complete status.
3. Select a pore-size distribution report from the view selector drop-down list at the bottom of

the window.
4. Right-click on the graph and select Edit imported data on the shortcut menu.
5. If the ASCII text file does not display on the Selected Imported Overlays window, click

Import.
6. Select the file, then clickOpen. Header information from the ASCII text file will appear in the

Select Imported Overlays window.
7. Select the entry, then clickOK. If an error message appears, verify that the .TXT file format

is correct.
8. To hide or show imported data, right-click in the graph area and use the Display imported

data option on the shortcut menu.

COPY/PASTE AN ASCII TEXT FILE USING GRAPH SHORTCUTS
1. Create an ASCII text file.
2. Copy the ASCII text data to the clipboard.
3. Open a report with a Complete status.
4. Select a pore-size distribution report from the view selector drop-down list at the bottom of

the window.
5. Right-click on the graph and select Paste data on the shortcut menu.
6. To hide or show imported data, right-click in the graph area and use the Display imported

data option on the shortcut menu.

COPY/PASTE GRAPH DATA FROM ANOTHER GRAPH

1. Open a source pore distribution data report with a Complete status.
2. Right-click on the graph and select Copy Data on the shortcut menu.
3. Open the target pore distribution data report.
4. Right-click on the graph and select Paste Data on the shortcut menu.
5. To hide or show imported data, right-click in the graph area and use the Display imported

data option on the shortcut menu.

7 - 34 TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023



REPORT EXAMPLES

BET REPORT

Report Examples
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7 About Reports

BET SURFACE AREA PLOT
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BJH ADSORPTIVE CUMULATIVE PORE VOLUME

BJH Adsorptive Cumulative Pore Volume
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BJH DESORPTION CUMULATIVE PORE VOLUME
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ISOTHERM LINEAR PLOT

Isotherm Linear Plot
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ISOTHERM LOG REPORT
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T-PLOT

t-Plot
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8 SELECTED REPORT OPTIONS

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

To edit reports, open the Sample file then select the Report Options tab. Highlight the
report name in the Selected Reports list box and click Edit.

ADVANCED REPORTS - PYTHON MODULE

In a 21CFR11 environment, the Advanced reports feature is applicable to members
of the Developer group only.

n Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

8 Selected Report Options

TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023 8 - 1



8 Selected Report Options

Advanced Reports

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. SeeMicModule Python Calls on page A - 17 for an
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.
2. Open a sample file with a Complete status.
3. Select Advanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On the Report Options tab, select Advanced in the Selected Reports list box, then click

Edit.
5. On the Advanced Report Options window, click Add in the Available Scripts group box to

locate and select the Python script. Repeat for each script to be added.

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. Click Pressures to add pressure points to the report. ClickOK to return to the Report
Options tab.

8. Select theOverlay samples checkbox to enable the overlay sample feature.
9. On the Report Options tab, click Preview. The Python Reports will be included on the tabs

across the top portion of the Reports window.
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Selections Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace,
edit, or remove reports.

Overlay samples (if
shown) [check box]

Use to overlay samples as defined by the function.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Advanced Reports

Advanced Reports - Python Module
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8 Selected Report Options

ALPHA-S METHOD REPORT

The Alpha-S plot converts the standard adsorption isotherm into a dimensionless isotherm using
the quantity adsorbed at a relative pressure of 0.4.

One predefined curve is located in the Reference file directory. Use the table buttons to enter
relative pressure and the Alpha-S values.

Selections Description
Open [button] Use to import values from an existing thickness curve (.ALS).

The table to be imported must be saved as ASCII text with a .ALS file
extension. It must have a two-column format with the relative
pressures in the first column and the alpha-s values in the second
column. Columns must be separated by a space or a tab.

Alpha-S Method Report
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Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Ref. surface area
[text box]

Enter the surface area from the reference curve. This value is used
to calculate the sample surface area.

Select Range
for Alpha-S Fit
[group box]

Enter minimum and maximum relative pressures to determine the fit.

Selected Reports
[group box]

Alpha-S Plot. Use to plot data in graph format.
n Autoscale x-axis. The x-axis field shows the relative pressure.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the plot.
Tabular Report. Use to have a tabular report of data generated.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Alpha-S Method Report (continued)

Alpha-S Method Report
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BET SURFACE AREA REPORT

The BET calculation obtains the sample surface area value by determining the monolayer
capacity of adsorbed gas from the isotherm data. BET uses a multilayer model.

Selections Description
Pressures [button] This option is available when the sample file has a status of Ana-

lyzing or Complete. Use to enter a range of pressure points to be
included in the report or to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table if not using the Use
Interpolation option.

Exclude All. Select to exclude all pressure points in the table.

BET Surface Area Report
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Selections Description
Include All. Select to include all pressure points in the table.

Insert Predefined. Click to insert a predefined (default) set of points
into the report. Use Interpolationmust be selected to enable this
button. This button displays for BET reports only.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for BET fit [text box]

Enter values to indicate the fitted pressure range.

Selected Reports
[group box]

BET Isotherm plot. Uses BET monolayer capacity and constant to
produce an isotherm.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the relative pressure for BET.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the

BET isotherm plot.
BET Transform plot. Use to generate a traditional BET surface
area plot used to determine monolayer volume and BET C constant.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the relative pressure for BET.
n Autoscale y-axis. The y-axis field shows BET transformation.
n Overlay samples. Use to overlay sample files on the

BET transform plot.

Tabular report. Use to have a table of measured and calculated
values generated.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

BET Surface Area Report (continued)

BET Surface Area Report
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BJH ADSORPTION/DESORPTION REPORT

The BJH calculation determines the mesopore volume/area distribution, which accounts for both
the change in adsorbate layer thickness and the liquid condensed in pore cores. Reports can be
generated from both adsorption and desorption data. The fields for both BJH Adsorption Report
Options and BJH Desorption Report Options are identical unless otherwise specified.

An incomplete pore distribution may be generated if a thickness curve selection is not
a good match for the sample being analyzed.

Circled selection is applicable to BJH
Adsorption only

Selections Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

BJH Adsorption/Desorption Report
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Selections Description

BJH Correction
[group box]

Select the type of correction to apply to calculations. The selected
type will display in the report header.

Faas.Good for statistical thickness curves.

Kruk-Jaroniec-Sayari.Good for reference thickness curves.

Standard. Uses original BJH models.
Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter the minimum and maximum diameter (radius or width) of pores
to include in the BJH reports.

Fraction of pores open at both ends. This field is not available for
the BJH Desorption Report Options window.

During adsorption calculations, the analysis program assumes that
all pores are closed at one end. Occasionally, a percentage of pores
may be open at both ends causing disagreement in the adsorption
and desorption data or in the values for total volume and total BJH
pore volume. Enter the fraction of pores open at both ends to
compensate for this error.

BJH Adsorption/Desorption Report (continued)

BJH Adsorption/Desorption Report
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Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

BJH Adsorption/Desorption Report (continued)
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Selections Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

BJH Adsorption/Desorption Report (continued)

BJH Adsorption/Desorption Report
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BJH Plot

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the BJH Report Options window, then
click Edit.

Selections Description
Autoscale [check box] When enabled on the report parameters windows, allows the x- and

y- axes to be scaled automatically. Autoscalemeans that the x- and
y- ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Plot curve / Plot points
[check box]

Select to plot points on the graph.

X-Axis [group box] Use to have the x-axis on a logarithmic or linear scale.

Y-Axis [group box] Overlay. Select an option to overlay onto the current report.

Variable. Select a variable.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

BJH Plot Report
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BJH Tabular Report

Highlight BJH Tabular Report in the Selected Reports list box on the BJH Adsorption Report
Options window, then click Edit to specify the method of data reduction.

Selections Description
Collected points
[selection]

Use to include all relative pressure points collected. See the
Columns button below.

Columns [button] Select the data types to include in the report. Column [n] indicates
the column order and data contents for the report.

Fixed pore size table
[selection]

Use to specify exact pore sizes for volume or area data. Click Table
to modify the fixed pore size table. See the Table and Columns but-
tons elsewhere in this table.

Table [button] The fixed pore size table must contain a minimum of two points. The
points must be strictly decreasing. Enabled only when Fixed pore
size table is selected.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

BJH Tabular Report

BJH Adsorption/Desorption Report
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DFT PORE SIZE REPORT

The DFT Pore Size report contains the results of pore size distribution analyses using a non-local
DFT range of micro and mesopore ranges.

Selections Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

DFT Pore Size Report
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Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user)
is selected, enter a number in the text box giving a relative weight for
the smoothing during deconvolution. Larger values produce more
smoothing.

Select Isotherm Data
[group box]

Select the isotherm data to be used in the report.

Select Reports
[group box]

Select the reports to generate. To edit graph details, highlight the
graph option and click Edit. The Log Goodness of Fit andGoodness
of Fit graphs cannot be edited.

Autoscale Options. Use to autoscale the x-axis and/or y-axes.

DFT Pore Size Report (continued)

DFT Pore Size Report
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Selections Description
Axis Range. From/To fields are enabled when Autoscale options
are not selected. Enter the starting and ending values for the x-
and/or y-axes.
n x-axis. Shows the pore size.
n y-axis. Shows the area.

Overlay. Select an overlay for the report.

Plot Type. Select the method for data display.
Type [drop-down box] Classical.Model based on the Kelvin equation and thickness for

determining the pore size distribution. See DFT Models on page B -
1.

DFT.Model based on the density functional theory.
Version 2
deconvolution
[check box]

If enabled, adds improved performance for nonzero values of the
DFT regularization. The DFT results will be slightly better than when
the checkbox is not selected and when using a regularization
parameter. When the checkbox is not selected, the legacy behavior
of the DFT calculation used by earlier versions of the application is
produced.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

DFT Pore Size Report (continued)
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DFT SURFACE ENERGY REPORT

DFT Pore Size Report on page 8 - 14

The DFT Surface Energy report contains the results of surface energy distribution analyses.

DFT Surface Energy Report Options fields and buttons are identical to the DFT Pore Size Report
Options.

DFT Surface Energy Report
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DOLLIMORE-HEAL ADSORPTION/DESORPTION REPORT

BJH Adsorption/Desorption Report on page 8 - 8

The Dollimore-Heal Adsorption Report Option and the Dollimore-Heal Desorption Report Option
generate reports from both adsorption and desorption data.

Selections Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

Dollimore-Heal Adsorption/Desorption Report
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Selections Description
Cumulative Reports
[group box]

Larger. Use to report the total volume found in pores larger than the
current pore size.

Smaller. Use to report the total volume found in pores smaller than
the current pore size.

Pores [group box] Enter the minimum and maximum diameter (radius or width) of pores
to include in the BJH reports.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Select Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Smooth differentials
[check box]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

Dollimore-Heal Adsorption/Desorption Report (continued)

Dollimore-Heal Adsorption/Desorption Report
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8 Selected Report Options

Selections Description

To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Dollimore-Heal Adsorption/Desorption Report (continued)
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Dollimore-Heal Desorption Plot Options

The fields for all plot options are identical for specifying plotting methods and customizing plots.
Highlight any plot option in the Selected Reports list box in the Dollimore-Heal Report Options
window, then click Edit. The fields and buttons for these reports are identical to the BJH Plot
Report Options.

Dollimore-Heal Tabular Report Options

Dollimore-Heal Tabular Report Options are identical to the BJH Tabular Report Options.

Dollimore-Heal Adsorption/Desorption Report
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DUBININ REPORT

The Dubininmethod provides pore volume distributions for microporous materials by making use
of an expression for the adsorption potential.

Selections Description
Adsorptive [button] Displays the Adsorptive Options window. The recommended adsorpt-

ives and their values are shown. Up to eight adsorptive and
adsorbate property factor combinations may be specified.

Fitted Relative
Pressure Range
[group box]

Enter the minimum and maximum limits for Radushkevich or Astak-
hov relative pressures included in the line fit.

Dubinin Report
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Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Report Type
[group box]

Select report types. If Astakhov is selected, either selectOptimize
exponent or enter an appropriate exponent value in the text box.

Select Reports
[group box]

Select the reports to generate. Highlight the report, then click Edit to
modify report options.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Dubinin Report (continued)

Dubinin Report
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Dubinin Pore Volume Report Options

In the Dubinin Report Options window, highlight dV/dw Pore Volume in the Selected Reports list
box, then click Edit.

This option plots differential pore volume as a function of pore width.

Selections Description
Autoscale x-axis /
Autoscale y-axis
[check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Enable to enter beginning and ending values manually.
Overlay samples
[selection]

Use to overlay sample files on the plot.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Dubinin Report
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Dubinin Tabular Report Options

In the Dubinin Report Options window, highlight Dubinin Tabular Report in the Selected Reports
list box, then click Edit. Column [n] indicates the column order and data contents for the report.

Log (po/p )^n. The value for [n] is the optimized exponent ifOptimize exponent is selected on the
Dubinin Report Options window. If not, then the value for [n] is the entered exponent value.

Dubinin Report
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Dubinin Transformed Isotherm Plot Options

Highlight Transformed Isotherm in the Selected Reports list box in the Dubinin Report Options
window, then click Edit.

The transformed Dubinin isotherm is the logarithm of quantity adsorbed as a function of the log of
relative pressure raised to a power. Isotherms for which the Dubinin method is applicable produce
straight lines when transformed in this way.

Selections Description
Autoscale x-axis /
Autoscale y-axis
[check box]

Select an option to have the x- and/or y-axes scaled automatically.
Both axes begin at 0; the system uses the highest values collected
during analysis as the ending points for axis ranges.

Deselect to enter beginning and ending values manually.

Autoscale x-axis. Shows the quantity of gas adsorbed at standard
temperature and pressure.

Autoscale y-axis. Shows the log of relative pressure.
Overlay samples
[check box]

Use to overlay sample files on the plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Dubinin Transformed Isotherm Plot Report
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F-RATIO METHOD REPORT

The f-Ratio report uses the measured isotherm and normalizes it using a reference isotherm.

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Reference isotherm
[group box]

Browse to select a sample file to use as a reference for the isotherm.
Select a file containing an isotherm measured from a non-porous
sample of the same material as the current sample.

f-Ratio Report

f-Ratio Method Report
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8 Selected Report Options

Selections Description
Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

f-Plot. Use to generate a normalized isotherm.

n Autoscale x-axis. The x-axis field is dimensionless in units of f-
ratio.

n Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

n Overlay samples. Use to overlay sample files on the f-plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

f-Ratio Report (continued)

8 - 28 TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023



FREUNDLICH REPORT

The Freundlich Isotherm is an empirical isotherm used to model low pressure adsorption data. It
can also be applied to model some micropore isotherms. In the Selected Reports list box, highlight
Freundlich, then click Edit.

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Freundlich Report

Freundlich Report
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Selections Description
Select Reports
[group box]

Freundlich Isotherm plot. Plots the absolute pressure vs quantity
adsorbed. Shows best fit line.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure.
n Autoscale y-axis. y-axes begin at zero. The y-axis field shows

the quantity of gas adsorbed.
n Overlay samples. Use to overlay sample files on the Freundlich

isotherm plot.
Freundlich Transform plot. Plots the log(P) vs log(Q) and the best
fit.
n Autoscale x-axis. The x-axis field shows the absolute pressure.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the Freundlich

transform plot.

Tabular report. Select to include pressure points included in the
report.

Specify monolayer
capacity [selection]

Select and enter the monolayer capacity of the sample.

Tabular report
[selection]

Use to have a report of the pressure points generated.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Freundlich Report (continued)
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HORVATH-KAWAZOE REPORT

The Horvath-Kawazoemethod plots individual peaks for different pore sizes even if the difference
between one pore size and the next is only one angstrom (0.10 nm) or less.

Selections Description
Apply Cheng-Yang
correction [selection]

Use to apply the Cheng-Yang correction to the pore size analysis.
This correction substitutes the Langmuir equation of state for Henry’s
Law in the Horvath-Kawazoe derivation.

Interaction Parameter
[group box]

Use to determine which interaction parameter will be used in the
report. These options are disabled if Sphere is selected in the Pore
Geometry group box.

Computed. Use to calculate using the parameters on the Horvath-
Kawazoe Physical Properties window (click Properties to display
the Physical Properties window). The interaction parameter is
recalculated each time a parameter in the Physical Properties
window is edited.

Entered. Calculates using the value entered in the text box.
Pore Geometry
[group box]

Select the option that best represents the physical geometry of the
micropores in the sample material. When Sphere is selected, options
in the Interaction Parameter group box are disabled.

Horvath-Kawazoe Report

Horvath-Kawazoe Report
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8 Selected Report Options

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.
Properties [button] Click to view or edit the constants describing the physical properties

of the adsorbent and adsorptive.

Adsorbent. Contains the parameters for the sample. If using
Computed for the interaction parameter, all fields are enabled. If
using Entered, only the values in the Diameter and Diameter at zero
energy text fields may be edited.

n Density. Enter the density per unit area of the sample. *
n Description. Select the name of the sample used in the analysis.
n Diameter. Enter the diameter of the sample atom.
n Diameter at zero energy. Enter the diameter of an atom at zero

interaction energy: (2/5)1/6 × diameter.
n Magnetic susceptibility. Enter the magnetic susceptibility of the

sample. *
n Polarizability. Enter the polarizability of the sample. *
Adsorptive. Contains the parameters for the adsorptives. If using
Computed for the interaction parameter, all fields are enabled. If
using Entered, only the values in the Diameter and Diameter at zero
energy text fields may be edited.

n Density. Enter the density per unit area of the adsorptive. *
n Diameter. Enter the diameter of the gas phase atom.
n Diameter at zero energy. Enter the diameter of an atom at zero

Horvath-Kawazoe Report (continued)
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Selections Description

interaction energy: (2/5)1/6 × diameter.
n Magnetic susceptibility. Enter the magnetic susceptibility of the

adsorptive. *
n Mnemonic. Select the mnemonic of the adsorptive gas in use.
n Polarizability. Enter the polarizability of the adsorptive. *

* Option is disabled if Entered is selected in the Interactions
Parameter group box.

Select Reports
[group box]

Select the types of reports to generate. Highlight the report, then
click Edit to modify report parameters.

Smooth differentials
[selection]

Use to smooth all differential calculations, thus eliminating variations
in the differential computation caused by noise in the input data.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Horvath-Kawazoe Report (continued)
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8 Selected Report Options

Horvath-Kawazoe Plots

See BJH Adsorption/Desorption Report on page 8 - 8 for additional information on fields and
buttons for this report.

Highlight a plot option in the Selected Reports list box in the Horvath-Kawazoe Report Options
window, then click Edit to customize the plotting method.

Horvath-Kawazoe Tabular Report

Highlight H-K Tabular Report in the Selected Reports list box in the Horvath-Kawazoe Report
Options window, then click Edit. Select the data types to include in the report. Column [n]
indicates the column order and data contents for the report.
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ISOTHERM REPORT

The Isotherm report indicates adsorption (up to saturation pressure) and desorption (down from
saturation pressure) of a gas by a solid held at constant temperature.

Selections Description
Options [button]  Click to display related linear plot options. All plot windows contain

identical fields.

Autoscale x-axis. Linear x-axes begin at zero. Logarithmic x-axes
begin at an appropriate value. The x-axis field shows the relative or
absolute pressure.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Plot curve / Plot points. Select to plot points on the graph.
Plot Options [group box] Select the types of isotherm to plot.

Quantity Adsorbed
[group box]

Select how to report the quantity adsorbed.

n per gram (cm3/g) STP
n per BET Surface Area (cm3/m2) STP or mmol/g
n per other Surface Area (cm3/m2) STP or mmol/m2

Selected Reports Select each option to include on the final report. Click the Options

Isotherm Report

Isotherm Report
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Selections Description
[group box] button of a selected item to include plot curve, plot points, and to

autoscale x- and y-axes.
Tabular Options
[group box]

Select the options to include on the report.

Elapsed time. Time elapsed during the analysis.

Time between points. Time elapsed between points during the
analysis.

Weight %. Enter the mass percentage when plotting pressure
composition.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Isotherm Report (continued)
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LANGMUIR REPORT

The Langmuir calculation determines the surface area of a sample by relating the surface area to
the volume of gas adsorbed as a monolayer. Langmuir uses a single layer model.

Selections Description
Pressures [button] This option is available when the sample file has a status of

Analyzing or Complete. Use to enter a range of pressure points to be
included in the report or to modify table values for pressure points.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table. To exclude a point from
the calculations used to generate the report, select Exclude.

Langmuir Report

Langmuir Report
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Selections Description
Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Use Interpolation. Use to indicate if the system should use the table
or interpolated data. This option is available for BET and Langmuir
reports only.

Select Pressure Range
for Langmuir fit
[group box]

Enter values to indicate the fitted pressure range.

Select Reports
[group box]

Langmuir Isotherm Plot. Uses the Langmuir monolayer volume
and constant to produce an isotherm.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure for Langmuir.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the Langmuir

isotherm plot.
Langmuir Transform Plot. Use to generate a traditional Langmuir
surface area plot used to determine monolayer volume constant.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure for Langmuir.
n Autoscale y-axis. The y-axis field shows Langmuir trans-

formation.
n Overlay samples. Use to overlay sample files on the Langmuir

transform plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Langmuir Report (continued)
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MP-METHOD REPORT

TheMP-Method Report provides pore volume distributions for microporous materials by
correlating quantity adsorbed with the thickness of the adsorbed layer as determined from a user-
selected thickness curve. Pore size can be expressed in angstroms or nanometers. Go
to Options > Units to specify the unit.

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

MP-Method Report

MP-Method Report
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Selections Description
Select Reports
[group box]

Select the reports to generate. Highlight the report, then click Edit to
modify report options.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

MP-Method Report (continued)
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MP-Method Plot Report

In theMP-Method Report Options window, highlight a plot option in the Selected Reports list box,
then click Edit to customize the plotting method.

Selections Description
Overlay [drop-down box] Select an option to overlay on the current report.

Plot curve / Plot points
[selection]

Select to plot points on the graph.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve.

X-Axis [check box] Use to have the x-axis autoscaled or enter beginning and ending
values.

Y-Axis [group box] Autoscale. Use to have the y-axis autoscaled or enter beginning
and ending values.

Overlay. Select an option to overlay on the current report.

Variable. Select a variable.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

MP Method Plot Report

MP-Method Report
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MP-Method Tabular Report

In theMP-Method Report Options window, highlightMP Tabular Report in the Selected Reports
list box, then click Edit. Column [n] indicates the column order and data contents for the report.

The MPMethod reports hydraulic radius only. If Pore size in diameter is selected on
the Unit Selection window, pore size in radius will be reported.
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NLDFT ADVANCED PSD REPORT

The NLDFT Advanced PSD report allows for more advanced computation of the pore size
distribution of a material using two separate analyses and two non-local DFT models.

The NLDFT Advanced PSD report option provides the same calculations as the DFT Pore Size
report option and more. The NLDFT report compares two sample files. The models that can be
selected are restricted to only those models which have the same analysis temperature and
analysis gas as the sample file that is open. For instance, if the sample file was analyzed with N2
at 77 degrees Kelvin, then only the N2 DFT models at 77 degrees Kelvin will be available in the
Model drop-down list.

The model curve fit is shown in the lower right quadrant along with the adsorption isotherm. This
curve fit is updated each time the calculation parameters change (selection of isotherm data
points, choice of model, choice of regularization parameter).

A second sample file and second model is used to compute a more accurate pore size distribution
(PSD), which is shown in the upper left quadrant. Typically, the second sample file will have used
the same sample material as the first sample file yet will have used a different analysis gas and
temperature.

In general, the isotherm for this second sample will be different than the first sample. The
advanced DFT calculation takes the data from both sample files and combines all this data into a
more accurate calculation of the pore size distribution. More accurate means getting the pore
distribution at smaller pore sizes (a few Angstroms) as well as larger pore sizes (one thousand
Angstroms).

NLDFT Advanced PSD Report
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To make a successful Advanced calculation, a second sample file must be selected
using the Select button. A second model must also be selected. Use the options next
to the two sample file names to select the isotherm data points for each sample. After
selecting an option, the blue bars in the isotherm graph will be toggled to select either
the red points or the green points. Once these selections have been done, the results
will appear in the left-hand plots and a second isotherm will appear in the isotherm
plot (lower right) as well as a second curve-fit. As the selection of points is adjusted,
the DFT editor will recalculate the PSD results and also recalculate the two model
curve fits.

Selections Description
Geometry
[drop-down box]

Select the pore shape.

Model [drop-down box] Lists the models that meet the specified criteria and match the
adsorbate and temperature of the sample data. If no models appear,
no models meet the selected criteria. One model must be selected.

Regularization
[drop-down box]

Select the extent of smoothing to apply to the data. If 0.20000 (user)
is selected, enter a number in the text box giving a relative weight for
the smoothing during deconvolution. Larger values produce more
smoothing.

Select Reports
[group box]

Use to select the second sample file.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

NLDFT Advanced PSD Report
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To run the NLDFT report:

1. Go to File > Open. Select a sample file with a Complete status, then clickOpen.
2. In the view selector drop-down list at the bottom of the window, select NLDFT Advanced

PSD. Graphs for the first sample file display and the sample description shows as the first
group box title in the upper right corner of the window.

A. First selected sample file
B. Second selected sample file

a. Select theGeometry andModel from the drop-down lists for the first sample file.
b. To select isotherm data points for calculation for the first sample file, ensure the option

to the left of the first sample file description is selected. Slide the two blue bars on the
isotherm graph to select data points. Without a second sample selected, the report will
perform a single model DFT calculation and show the results in the two left-hand result
windows.

3. To calculate data from the second sample file, click Select to locate and open the second
sample file with a Complete status. Graphs for the second sample file display and the
sample description will display as the second group box title in the upper right corner of the
window.
a. Select theGeometry andModel from the drop-down lists for the second sample file.
b. To select isotherm data points for calculation for the second sample file, ensure the

option to the left of the second sample file description is selected. Slide the two blue
bars on the isotherm graph to select data points. Data are automatically calculated for
both sample files.

c. Click Edit to make any necessary modifications to the second sample file.

NLDFT Advanced PSD Report
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OPTIONS REPORT

Lists the conditions used to perform the analysis such as:

n Adsorptive properties
n Analysis conditions
n Analysis method
n Degas conditions
n Free space
n Saturation pressure (P0) and temperature

Options reports cannot be edited.

Options Report
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SAMPLE AUDIT TRAIL REPORT

For 21CFR11 environments only.

This report lists all changes and comments that have been applied to sample files with a Complete
status.

8 - 48 TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023



SUMMARY REPORT

The Summary Report for physisorption analyses provides a condensed summary of selected data
results.

In the Pore Volume group box, if Adsorption total or Desorption total is selected, the p/po field is
enabled. Enter the relative pressure used to calculate the total pore volume.

Selections Description
Item [n] [selection] Use to enable the first Pass/Fail item. Until the Summary Report is

selected, S A Single-point BET will be displayed by default. When
selected, click Pass/Fail, then select pass/fail criteria options.

Pass/Fail [n]. Click to display the Pass/Fail Options window for
selection of pass/fail criteria.

S A: Single-point BET. Use to enable Pass/Fail [n] in the Item [n]
group box.

Summary Report

Summary Report
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Selections Description
Upper/Lower. Specify upper and lower limits for the selected
parameter. A range can be left open by not selecting the limit. In the
text box to the right of Upper / Lower, enter operator instructions to
be displayed if a failure is encountered.

Select All / Deselect All
[button]

Selects (or deselects) all options.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Summary Report (continued)
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T-PLOT REPORT

The t-Plot calculation allows quantitative analysis of the area and total volume ascribed to
micropores. Matrix area (the area external to micropores) is directly determined and often proves
to be a valuable way of characterizing complex mixed materials.

Selections Description
Fitted thickness range
[text box]

Enter the minimum and maximum thicknesses (in angstroms or nano-
meters) to include in the thickness curve. Go toOptions > Units to
specify default units.

Pressures [button] Use to select a pressure range for report calculations and points for
exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

t-Plot Report

t-Plot Report
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Selections Description
Selected Reports
[group box]

Tabular Report. Use to have a tabular report of data generated.

t-Plot. Use to have a graphical representation of data generated.
n Autoscale x-axis. The x-axis field shows the statistical thickness

of the adsorbed film.
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the t-plot.

Surface area correction
factor [text box]

Enter the value to correct for surface areas that are not smooth. This
brings the values for BET surface area and micropore surface area
into accordance. For most samples, the default value of 1.000 is
adequate.

Surface Area
[group box]

Select the surface area value used for thickness calculations. BET is
the most commonly used option.

Thickness Curve
[group box]

Select the thickness curve, then click Edit to modify the values in the
equation for the selected curve. The Frenkel-Halsey-Hill thickness
curve can be applied using the Halsey option.

Kruk-Jaroniec-Sayari / Halsey / Harkins and Jura / Broekhoff-
de Boer / Carbon Black STSA. Select the thickness curve option,
then click Edit. Modify the equation for the selected curve as
needed.

Reference. Select Reference, then click Edit to define a t-curve by
entering both the relative pressure and thickness values. One
predefined curve is shipped with the analysis program and is found in
the Reference directory.

t-Plot Report (continued)
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Selections Description
To import values from an existing thickness curve (.THK file), click
Open, then select the file containing the values. The table to be
imported must have a .TXT or .THK file extension and have a two-
column format with the relative pressures in the first column and the
thickness values in the second column. Columns must be separated
by a space or a tab.

t-Plot [check box] Use to have a graphical representation of data generated.

Autoscale x-axis. The x-axis field shows the statistical thickness of
the adsorbed film.

Autoscale y-axis. The y-axis field shows the quantity of gas
adsorbed.

Overlay samples. Use to overlay sample files on the t-plot.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

t-Plot Report (continued)

t-Plot Report
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8 Selected Report Options

TEMKIN REPORT

The Temkin isotherm is used to model adsorption data where the heat of adsorption drops linearly
with increasing coverage.

Selections Description
Pressures [button] Use to select a pressure range for report calculations and points for

exclusion from calculations.

Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.To exclude a point from
the calculations used to generate the report, select Exclude.

Exclude All. Select to exclude all pressure points in the table.

Include All. Select to include all pressure points in the table.

Temkin Report
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Selections Description
Select Reports
[group box]

Tabular Report. Generates a tabular report of the included samples
that contains the numeric values contributed by each sample.

Temkin Isotherm plot. Overlays the Temkin isotherm with the
analysis data.
n Autoscale x-axis. Linear x-axes begin at zero. The x-axis field

shows the absolute pressure.
n Autoscale y-axis. y-axes begin at zero. The y-axis field shows

the quantity of gas adsorbed.
n Overlay samples. Use to overlay sample files on the isotherm

plot.

Temkin Transform plot. Plots a linear form of the Temkin
transform plot.
n Autoscale x-axis. The x-axis field shows the logarithm of pres-

sure (ln).
n Autoscale y-axis. The y-axis field shows the quantity of gas

adsorbed.
n Overlay samples. Use to overlay sample files on the transform

plot.

Specify differential heat
of adsorption
[check box]

Select and enter the differential heat of adsorption at zero surface
coverage. This allows inclusion of all Temkin constants.

Specify monolayer
capacity [check box]

Select and enter the monolayer capacity of the sample.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Temkin Report (continued)

Temkin Report
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8 Selected Report Options

VALIDATION REPORT

This report allows data to be examined by the analysis program to determine if the results are
within typical ranges. If the data for any reports selected for validation are determined to be out of
range, a warning will display and suggestions are given for corrective action.
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9 DIAGNOSTICS
Unit [n] > Diagnostics
Use to display diagnostic readings, start diagnostic tests, and open saved diagnostic reports.
Each test generates a file to the default directory name and path of ...\...\Service\userdiag unless
another directory name was specified. These reports can be sent to a Micromeritics Service
Representative for examination.

SHOW ALL READINGS
Unit [n] > Diagnostics > Show All Readings
The Show All Readings window displays the calibrated readings of all sensors in the system.

START DIAGNOSTIC TEST
Unit [n] > Diagnostics > Start Diagnostic Test
Use to clean and verify gas lines when connecting or changing a gas. See Clean and Verify the
Gas Line on page 11 - 9 for detailed instructions. Also used to perform diagnostic tests
requested by a Micromeritics Service Representative.

This option is typically used and /or requested by a Service Representative. These tests create
and save files to the ...\...\Service\userdiag directory. The Micromeritics Service Representative
may request an emailed or faxed copy of the file for diagnostic purposes.

9 Diagnostics
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9 Diagnostics

Selections Description
Comments [text box] Displays comments from the selected diagnostic test.

Estimated time (min.)
[text box]

Approximate time for test completion.

File [group box] Shows a status bar of steps complete once the test begins.

Next [button] Starts the next test.

Operator [text box] Enter information to identify the person running the service test.

Repeat [button] Repeats the selected diagnostic test.

Report after test
[check box]

Automatically generates reports to the selected destination when the
test is complete.

Sequence Sequence number assigned to the test.

Start [button] Starts the diagnostic test.

Test [drop-down box] Select the diagnostic test to be performed.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Start Diagnostic Test
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10 CALIBRATION
Unit [n] > Calibration

A calibration file was created specifically for the analyzer and included with the
accessories. It is not necessary to recalibrate the system unless it seems out of cal-
ibration.

Disabled calibration menu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

To review calibration details of the analyzer, go to Unit [n] > Unit Configuration.

Generally, it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

10 Calibration
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10 Calibration

MATCH TRANSDUCERS
Unit [n] > Calibration > Match Transducers

This process should not be performed when the main transducer reading is abnormal.

Use to evacuate the system and zero the pressure transducers, then adjust the scale to match
them to the manifold transducer near full scale pressure.

A blank sample tube or small plug must be installed on each selected port prior to start-
ing this process.

1. Ensure that all applicable transducers are selected.
2. Click Start. The window closes when the operation is complete.
3. ClickOK when the process is complete.
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PRESSURE OFFSET

Unit [n] > Calibration > Pressure Offset
This procedure evacuates the system and zeroes the pressure transducers. This calibration
should only be performed by qualified service personnel. In order to perform this procedure,
sample tubes must be attached to each port.

1. Install a blank sample tube or small plug on each applicable port.
2. Ensure that all applicable transducers are selected, then click Start. ClickOK when the pro-

cess is complete. The current pressure readings and operation status messages display.

When the calibration is complete, a confirmation message is displayed with the event log
message for the pressure transducer offset calibration. ClickOK.

Pressure Offset
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10 Calibration

SERVO VALVE
Unit [n] > Calibration > Servo Valve
Use to calibrate the servo valve to the sample transducer. The servo valve should always be
recalibrated after a pressure calibration has been performed. The pressure transducer should be
calibrated before starting this calibration procedure.

Ensure the pressure transducer has been calibrated before performing this pro-
cedure. Go to Unit [n] > Unit Configuration and view the calibration information.
Contact your Micromeritics Service Representative if calibration dates are not listed.

Click Start. The window closes when the calibration is complete.

Click Cancel to stop the calibration process.

SAVE CALIBRATION TO FILE
Unit [n] > Calibration > Save to File
Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Calibration > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be
changed. The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 Analyzer serial number
2013-04-25 Date the calibration file was saved
.CAL File name extension
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LOAD CALIBRATION FROM FILE
Unit [n] > Calibration > Load from File
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using Unit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration
file, a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten
each time a new one is created.

Changing the calibration may affect the analyzer’s performance.

Load Calibration from File
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11 TROUBLESHOOTING
The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.micromeritics.com).
n Error Messages document (PDF)
n Parts and Accessories
n Smart VacPrep Operator Manual (PDF)
n Vacuum Pump Guide (PDF)

Most operational problems are caused by:

n Leaks (commonly found at the sample tube O-ring at the analysis port)
n Sample weighing errors
n Use of too much analysis bath fluid in the Dewar at the start of an analysis
n Entry of incorrect system volume for analysis
n Impure gas supply

When unexpected analysis results occur, check the above first. Some common operational
problems not indicated on the window and their respective causes and solutions are provided
below:

Elevator cannot be raised or lowered.

Cause: Dewar elevator stuck.

Action: Check for possible obstruction to elevator movement.

Elevator is noisy.

Cause: The elevator screw may need greasing.

Action: Contact your Micromeritics Service Representative.

Sample is not within specifications.

Cause A: There may be a manifold leak.

Action A: Run a manifold leak test. See Diagnostics on page 9 - 1.

11 Troubleshooting
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11 Troubleshooting

Cause B: Gas may be contaminated.

Action B: n Perform a blank analysis. If results are good, perform a reference material
analysis.

n Replace tank.
n Check for line leak, which could cause contamination.
n Flush the lines occasionally to help prevent contamination.

Cause C: Incorrect type of gas line.

Action C: Ensure the gas line is all metal. It is best to use the one shipped with the ana-
lyzer. Do not use polymer gas lines or flexible gas lines that may be coated
internally with a polymer.

Valves cannot be operated.

Cause: Cable from computer to the instrument is loose.

Action: Reconnect the cable.

Vacuum pump is noisy.

Cause A: Sample tube connector is loose.

Action A: Tighten fitting. Replace O-ring.

Cause B: Sample tube O-ring is worn or cracked.

Action B: Replace O-ring. See Sample Tube O-ring Replacement on page 11 - 19.
Cause C: Sample tube is cracked.

Action C: Replace with new sample tube.

Cause D: No sample tube loaded on a selected port.

Action D: Install plug or empty sample tube.

Cause E: Gas inlet valve open while vacuum valve open.

Action E: With manual control enabled, use the instrument schematic to close gas inlet
valve.
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POWER

The TriStar II Plus is designed to operate with universal input power supply (100-240 VAC, 50/60
Hz, 150 VA). Noise-free power of the correct voltage and frequency, with a safety earth ground,
should be available through a standard wall receptacle. The power outlet should be able to supply
15 amps@ 100 or 115 VAC ±10% or 7.5 amps@ 230 VAC ±10%. These requirements can be
checked by using a circuit analyzer (available at most hardware or electronic supply houses) or a
multimeter. There should also be sufficient outlets for the computer, dry roughing pump, monitor,
printer, and any other peripheral devices.

The power cord, IEC, 300V, 10A (available in the accessories kit) should be connected to noise-
free power of the correct voltage and frequency, with a safety earth ground, through a standard
wall receptacle.

The analyzer and peripheral devicesmust be installed on their own dedicated power
line. Other devices— such as motors, generators, or ovens— should not be placed
on the same power line.

Replacement power supply cords must be rated for the specifications stated above.

Power
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11 Troubleshooting

GUIDELINES FOR CONNECTING GASES

Analyzer Gauge should indicate
TriStar 15 - 18 psig (103 - 124 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended pressure could cause personal injury or dam-
age the instrument.

These instructions refer to the installation of a gas line, regulator, and gas cylinder for
each type of gas used. If expansion kits or other accessories are used in the lab, spe-
cial consideration should be given to these configurations when installing the gas
lines.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the SDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories are the responsibility of the operator.

n Place gas cylinders within 6 feet (2 m) of the gas inlets of the analyzer. Place the cylinders
close enough to allow for proper connection at the analyzer inlet.

Using gas line extenders on gas cylinders located in remote areas may degrade gas quality
and reduce pressure.

Long gas lines, such as those used with gas cylinders placed in remote areas, must be purged
for an extended period of time to remove ambient gases. When possible, avoid placing gas
cylinders in remote locations. It is always best to have gas cylinders located near the analyzer.

n Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
n Always use the gas lines provided with the analyzer. It is very important that proper gas lines

are used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible lines may appear to be appropriate, such as
those with a herringbone covering, but the line may be coated internally with a polymer.

n Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or
entangling gas lines. This will help avoid confusion when maintenance is required.

n Label the gas line at the analyzer inlet for proper identification and maintenance.
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n Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-
sure reads approximately 500 psi (3500 kPa) on the high-pressure gauge. Contaminants
adsorbed to the walls of the cylinder will desorb as the pressure decreases.

REPLACE A GAS CYLINDER

Analyzer Gauge should indicate
TriStar 15 - 18 psig (103 - 124 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended pressure could cause personal injury or dam-
age the instrument.

These instructions apply to working with inert gases only. When working with
hazardous gases, follow the safety procedures established by your lab.

A power failure or loss of cryogen can result in dangerous pressures in the sample
chamber. When using toxic or flammable gases, additional venting of the cabinet may
be required.

A. Gas tubing to instrument
B. Gas regulator shut-off valve
C. Low pressure gauge
D. High pressure gauge
E. Gas cylinder shut-off valve
F. Regulator connecter nut
G. Regulator control knob
H. Brass reducer fitting

Replace a Gas Cylinder
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11 Troubleshooting

Disconnect a Depleted Gas Cylinder

1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-
wise.

2. Disconnect the gas line from the regulator. Gas will be vented from the line. It is not neces-
sary to disconnect the gas line from the analyzer inlet if the cylinder will be replaced imme-
diately with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gas will be
vented from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap and

move the cylinder to an appropriate location.
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Connect a Gas Cylinder

Move the replacement cylinder close to the analyzer and tether it into place. It is not necessary to
disconnect the gas line from the regulator or the analyzer.

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas
cylinder.

2. Place the protective cap in a secure location. It will be needed to recap the gas cylinder
when it is depleted and replaced.

3. Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an
appropriate wrench to tighten an additional 3/4 turn.

Over-tightening the fitting may cause a leak.

4. Check for leaks at the high pressure side of the regulator and in the connector.
a. Turn the regulator control knob fully counter-clockwise.
b. Slowly open the gas cylinder shut-off valve, then quickly close it.
c. Observe the pressure on the high pressure gauge for approximately one minute.

n If the pressure is stable, proceed with the next step.
n If the pressure decreases, tighten the regulator connector nut until it becomes

stable. If the pressure does not remain stable, remove the regulator and clean all
contacts at the regulator connection, then reinstall the regulator.

5. Purge the air from the lines by doing the following:

Purge the regulator before starting to prevent contamination of the analysis gas sup-
ply.

a. Open the gas cylinder valve to pressurize the regulator, then close the valve.
b. Adjust the Pressure Control knob to approximately 5 psi.
c. Turn the regulator Shut-off valve counter-clockwise to open. Allow gas to flow until both

gauges read approximately zero.
d. Close the regulator Shut-off valve to stop gas flow.
e. Reconnect the gas line to the regulator.
f. Use two 7/16 in. (11 mm) wrenches to tighten the gas line connection. Hold one wrench

fitting steady and the other to tighten the connector nut.
6. Set the analyzer pressure by doing the following:

a. Turn the Regulator Control knob clockwise until the low pressure gauge indicates the
appropriate pressure. See the Regulator Pressure Settings table in Connect a Gas
Cylinder.

b. Open the regulator Shut-off valve.
c. Open the gas cylinder Shut-off valve and flow gas for 10 to 30 seconds.

Replace a Gas Cylinder
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11 Troubleshooting

d. Close the gas cylinder Shut-off valve.
e. Close the gas cylinder valve.

7. If the gas line to the instrument inlet was previously disconnected, reconnect it now.
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CLEAN AND VERIFY THE GAS LINE

Unit [n] > Diagnostics > Start Diagnostic Test
Always clean the gas lines and verify there are no leaks at the connections after a gas cylinder is
connected. This test examines the gas line from the analyzer to the gas cylinder, then from the
analyzer to the regulator shut-off valve. A report is generated at the completion of the test to verify
that it has passed or failed. Causes and corrective action for a failure are provided.

Confirm that the state for valves and the low pressure gauge are as follows:

A. Gas tubing to instrument
B. Gas regulator shut-off valve -

OPEN
C. Low pressure gauge - 14-15

psig
D. High pressure gauge
E. Gas cylinder shut-off valve -

CLOSED
F. Regulator connecter nut
G. Regulator control knob -

OPEN
H. Brass reducer fitting

1. Select Clean and Verify Analysis Gas Line [n] Test Rev [n] in the Test field. The length of
time a test will run is indicated on the window. The Sequence field indicates the file created
as a result of this test.

2. In theOperator field, enter either the name or initials of the operator performing this test.
3. Select the Report after test option then select Preview. Click Start.
4. From the View drop-down list, select eitherOperation, Instrument Log, or Instrument

Clean and Verify the Gas Line
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11 Troubleshooting

Schematic.
5. The following series of prompts display requiring operator response:

a. This is the gas line clean and leak check test for inlet port [n]. Inlet ports being tested
must be connected to a gas cylinder according to the user manual. A Nupro isolation
valve should be installed on the line between the analyzer and the regulator.

b. The test starts with a manual leak check (requires Snoop or equivalent, and IPA), then
the line and regulator are evacuated for 20 minutes for cleaning. Next, the leak rate of
the gas line is determined.

c. With the regulator set to 15 psig, open the cylinder, regulator shut-off valve, and isol-
ation valve. Check each joint for bubbles with Snoop or equivalent. If a joint is leaking,
attempt tightening (without over-tightening) or replace ferrules.

d. When there are no leaking joints, use IPA to remove water from each joint, then wipe
dry.

e. Close the gas cylinder valve. Leave the regulator shut-off and isolation valves open.
f. User will be needed in 30 minutes to close the isolation valve. ClickOK to begin auto-

mated testing.
6. ClickOK when the test is complete. The test reports display.
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7. Click each tab across the top of the window and look for a reading of Passed. A Passed
reading indicates all valves are in a proper state for operation. If any test shows a Failed
reading, refer to the following table to help determine the location of the gas leak.

Tab Test If Failed status, then...
Gas Line to Inlet
Port [n]
Test 1

Gas Line to Gas Cylin-
der Test

This test will show a reading of Failed if any of the
other tabs has a Failed reading. Correct the
failed connection and rerun the test.

Gas Line to Inlet
Port [n]
Test 2

Gas Line to Isolation
Valve Test

Check for a leak between the gas line and the
isolation valve. Correct the problem and rerun
the test.

Gas Line to Inlet
Port [n]
Test 3

Isolation Valve To
Cylinder Leak Rate

Check for a leak between the isolation valve and
the gas cylinder. Correct the problem and rerun
the test.

Corrective Action

If a test reports as failed, one or more valves is not in the proper position. Set the valves, then
ensure the appropriate pressure is displayed on the low pressure gauge.

If re-running the test, close the gas cylinder valve before starting the test.

1. Click Close to close the test report. Click Close again to close the test.
2. Repeat steps 1 through 8 for each gas line attached to the analyzer.

ENABLE MANUAL CONTROL
Unit [n] > Enable Manual Control

Show Instrument Schematic on page 2 - 20
Use Enable Manual Control to enable the manual control of certain system valves and pump com-
ponents on the analyzer schematic. When this option is enabled, a checkmark appears to the left
of Unit [n] > Enable Manual Control. If the analyzer schematic is not immediately visible, go to
Unit [n] > Show Instrument Schematic.

Enable Manual Control
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11 Troubleshooting

PERFORM A LEAK TEST
Unit [n] > Diagnostics > Start Diagnostic Test
AMicromeritics Service Representative may request that a leak test be performed to determine if
there is a system leak and may also require a copy of the report generated by this test.

The test provides:

n Prompts on preparing the analyzer for the test.
n Approximate time period of the test.
n Prompts in which an operator response is required.

1. Select the test to run.
2. Select Report After Test and choose Preview as the destination.
3. Click Start.
4. Verify all tests have a Passed status by selecting the tabs and looking for the Passed status

for each test run.
5. Click Save As to save the test file results.
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A. Suspend/Resume/
Skip/Play buttons

B. Port report buttons
C. Live graph settings

Perform a Leak Test
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11 Troubleshooting

PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and
calibration be performed by a Micromeritics Service Representative every 12 months.

Maintenance Required Frequency
Alumina in vapor oil traps * Replace as required.

Analyzer exterior Clean as required or every 3 to 6 months.

Dewar Check and clean weekly.

Diaphragm vacuum pump ** If an oil-free pump is used, replace diaphragm(s) every 12
months.

Dry forepumps As required or every 24 months.

Port filters and O-rings Replace every 3 to 6 months.

Sample tube O-ring Replace as required or every 3 to 6 months.

Test for leaks As required or every 12 months.

Vacuum pump exhaust filter Replace as required or every 12 months.

Vacuum pump fluid * Inspect and change as required or every 3 to 6 months.

* Oil sealed vacuum pumps only.

** For oil-free pumps only: After 12 to 18 months of operation, the diaphragm(s) in the pump will
wear out and the pump becomes completely inoperable. To prevent instrument downtime due
to an inoperable pump, it is recommend that the diaphragm(s) be replaced by a Micromeritics
Service Representative every 12 months.
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CHECK AND CLEAN THE DEWAR

When handling Dewars, follow the precautions outlined in Dewar Precautions on
page 6 - 1.

Always handle glass Dewars with care. Any product incorporating a vacuum is a
potential safety hazard and should be treated with caution. If in doubt, contact your
safety officer.

Ice and suspended frost particles may accumulate in the bottom of the analysis port Dewar.
Particles or deposits exceeding 1/4 in. (6 mm) in depth may jam between the bottom of the sample
tube and the bottom of the Dewar, causing the Dewar not to raise fully.

Accumulations of fine particles impede liquid nitrogen circulation around the bottom of the sample
tube. This causes the sample temperature to be slightly higher which, in turn, can cause pore
volume measurement errors in those samples exhibiting high isotherm slope above 0.97 relative
pressure.

Accumulated ice is likely to melt and form a pool of water in the Dewar if all liquid nitrogen
evaporates. The water must be removed, otherwise it will solidify when liquid nitrogen is added
and could press on the bottom of the sample tube causing breakage.

To ensure problems do not develop due to ice accumulation, check the Dewar after each use.
Clean on a weekly basis.

1. Remove the Dewar from the analyzer.
2. Pour out liquid nitrogen into an appropriate cryogenic container. Do not re-use liquid nitro-

gen.

Do not pour liquid nitrogen directly into a sink. Doing so may cause drain pipes to
burst.

3. Rinse the Dewar with warm water to melt any remaining ice accumulation which may
remain. Dry thoroughly.

4. Replace the Dewar.

Check and Clean the Dewar

TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023 11 - 15



11 Troubleshooting

CLEAN THE INSTRUMENT

The exterior casing of the instrument may be cleaned using a clean, lint-free cloth dampened with
isopropyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type
of abrasive cleaner. It is not necessary to remove knobs, screws, etc. while cleaning.

n Use only a mild detergent in water to clean safety shields. The use of isopropyl alco-
hol can damage the shield surface.

n Do not allow liquid to penetrate the casing of the analyzer. Doing so could result in
damage to the unit.

n Use only a mild detergent in water to clean safety shields. The use of isopropyl
alcohol can damage the shield surface.

CLEAN THE GAS DELIVERY TUBES

If using a FlowPrep, gas delivery tubes should be wiped with a clean, lint-free cloth after each use
to remove any particles of sample that may have adhered to the tube. If a gas delivery tube
becomes clogged or damaged, it should be replaced.

1. Remove the gas delivery tube from the flexible tubing.
2. Attach a new gas delivery tube by pressing the flexible tubing over the gas delivery tube.

Ensure that the flexible tubing completely covers the ferrule at the end of the gas delivery
tube.

LUBRICATE THE ELEVATOR DRIVE ASSEMBLY

The elevator screw is lubricated before it leaves the factory and should not require lubricating. If
the elevator starts to vibrate or becomes noisy when traveling, contact a Micromeritics Service
Representative for disposition.

Should lubrication become necessary, apply a light coat of Teflon Magnalube-G grease
[Micromeritics part number 004-16163-00] to the elevator screw. Do not grease the guide rods.
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POWER INSTRUMENT ON AND OFF

Do not connect or disconnect cables when the instrument is powered ON.

Power ON the equipment in the following order:

1. Computer, monitor, and printer.
2. Analyzer.
3. External vacuum pump.

The pump must warm for approximately two hours before performing analyses.

Power OFF the equipment.

The analyzer should remain powered ON at all times, however it if becomes neces-
sary, power OFF the equipment in the following order:

1. Exit the analysis program. Failure to do so could result in loss of data. If an analysis is in pro-
gress when closing the application, the following message is displayed:

2459 - An Instrument is busy. A delay in restarting this application
could result in loss of new data. Continue program exit? Yes / No

Yes. Closes the program. The analysis continues and data continue to be collected. The
data will be restored when the application is restarted. Reports queued in the print
manager will print. If a power failure occurs and an uninterruptible power supply (UPS) is
not attached to the analyzer, the data collected after exiting the analysis program are lost.

No. The program remains open and the analysis continues to run.

2. Computer, monitor, and printer.
3. Analyzer.
4. External vacuum pump.

Power Instrument On and Off
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11 Troubleshooting

SAMPLE PORT FRIT REPLACEMENT

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

A frit is located in the connecting nut attached to each analysis port. If the frit becomes
contaminated, the contaminant may adsorb or desorb during analysis, affecting the results. A
contaminated frit on the analysis port may be indicated as a leak or a free space reading much
lower than normal.

Use the proper size frit for the sample port. The analyzer will not operate properly if an
incorrect size is used.

3. Use a wrench to remove the connecting nut from the sample port. Pry out the filter (frit) and
O-ring.

To avoid degassing problems, the frit should be clean and should not be touched with
bare hands.

4. Place a new frit into the connecting nut.

A. O-ring
B. Filter (frit)
C. Sample tube fitting

5. Replace the filter and O-ring. Carefully reassemble the sample tube fitting and reinstall on
the sample port. Tighten by hand, then with a wrench to prevent leaks.
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SAMPLE TUBE O-RING REPLACEMENT

The equipment images in this topic may differ slightly from your equipment; however,
the instructions are the same unless otherwise noted.

It is important to maintain a vacuum-tight seal near the top of the sample tube stem. If an O-ring
becomes worn or cracked, it does not provide a good seal and will need to be replaced.

Before removing (or installing) a sample tube, ensure that the port valve is closed.
Observe the analyzer schematic to verify valve status.

Do not allow the sample tube connector nut to drop onto the bottom of the tube as it
may break the tube.

Use the proper size frit for the sample port. The analyzer will not operate properly if an
incorrect size is used.

1. Carefully remove the Dewar from the analyzer. Take care not to bump the sample tube
bulbs with the Dewar during this process. Place the Dewar aside.

2. Hold the sample tube firmly with one hand, loosen the sample tube connector nut by turning
counter-clockwise.

3. Carefully pull the sample tube down until it is free from the port. It may be necessary to
grasp the sample tube with both hands.

A. O-ring
B. Ferrule
C. Connector nut

4. Remove the O-ring from the top of the sample tube and replace it with a new one.

Sample Tube O-ring Replacement
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11 Troubleshooting

If the O-ring remains inside the sample port, use the O-ring removal tool from the
accessory kit [tool part number 004-54618-00].

5. After the new O-ring is in place, insert the sample tube back into the sample port until it is
fully seated.

6. Slide the sample tube connector nut up the tube until it comes in contact with the port fitting
(the ferrule and O-ring will move along with the connector nut). Then, turning clockwise,
hand tighten the connector nut to the sample connector.

RECOVER FROM A POWER FAILURE
The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progress when
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected
during the analysis will still be present, but the analysis should be restarted in order to produce
complete results.
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SERVICE TEST MODE

Options > Service Test Mode

Service Test Mode is a password protected option used to perform certain service tests with the
assistance of a trained Micromeritics Service Representative. This password is supplied by your
Micromeritics Service Representative.

If a menu item is grayed out, it is usually an indication that Service Test Mode is required.

To exit Service Test Mode, go toOptions > Service Test Mode and deselect the Service Test
Mode option or close the application.

OIL-BASED VACUUM PUMP
The Vacuum Pump Guide can be found on the Micromeritics web page (www.micromeritics.com).

PARTS AND ACCESSORIES
Parts and accessories are located on the Micromeritics web page.

Service Test Mode
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A ADVANCED REPORTS - PYTHON MODULE

In a 21CFR11 environment, the Advanced reports feature is applicable to members
of the Developer group only.

n Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

A Advanced Reports - Python Module
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A Advanced Reports - Python Module

ADVANCED REPORTS
Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. SeeMicModule Python Calls on page A - 17 for an
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.
2. Open a sample file with a Complete status.
3. Select Advanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On the Report Options tab, select Advanced in the Selected Reports list box, then click

Edit.
5. On the Advanced Report Options window, click Add in the Available Scripts group box to

locate and select the Python script. Repeat for each script to be added.

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. Click Pressures to add pressure points to the report. ClickOK to return to the Report
Options tab.

8. Select theOverlay samples checkbox to enable the overlay sample feature.
9. On the Report Options tab, click Preview. The Python Reports will be included on the tabs

across the top portion of the Reports window.
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Selections Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace,
edit, or remove reports.

Overlay samples (if
shown) [check box]

Use to overlay samples as defined by the function.

For fields and buttons not listed in this table, see Common Fields and
Buttons on page 2 - 3.

Advanced Reports

Advanced Reports
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A Advanced Reports - Python Module

SCRIPTS

Run a Script

1. Open a sample file with a Complete file status.
2. Select Advanced in the view selector drop-down list at the bottom of the window.
3. Select the Report Options tab.
4. Highlight Advanced in the Selected Reports list box, then click Edit.
5. On the Advanced Report Options window, click Add.
6. Select one or more python scripts then click Select. The selected scripts become a part of

the drop-down list in the Available Scripts section of the Advanced Report Options window.
7. In the Select Reports section, select up to five Advanced reports in the drop-down lists.
8. ClickOK.
9. Click Preview on the Report Options tab to view all reports selected in the previous window.

Remove a Script

Select the script in the Available Scripts box then click Remove. The script is removed from the
application however, the original .py text file is not affected.

Edit a Script

Selections Description
Add [button] Adds one or more scripts to the Available Scripts box. The added

scripts then become available as options in the Selected Reports
section.

Edit [button] Edits the script stored within the application but does not affect the
original .py text file.

Overlay samples
[check box]

Select to enable the overlay sample files process.

Pressures [button] Select to include or exclude pressures from the report.

n Calculation pressure range. Enter the minimum and maximum
pressures to be used in the pressure table.

n Cancel. Discards any changes or cancels the current process.
n Exclude All. Select to exclude all pressure points in the table.
n Include All. Select to include all pressure points in the table.
n OK. Saves and closes the active window.

A - 4 TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023



Selections Description
Remove [button] Removes the script from the Available Scripts box but does not affect

original .py text file.
Replace [button] Replaces the contents of the selected script however, the script

name remains the same.

Scripts
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A Advanced Reports - Python Module

PYTHON REPORTS

Graphic Report

This script is an example of the mic module producing a graph with two curves:

1 import mic
2 import numpy as np
3
4 mic.graph( 'My Graph', 'X', 'F(X)' )
5 myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ]

)
6 mic.graph.add( 'X2', myx, myx*myx, marker='o' )
7 mic.graph.add( 'sin(X)', myx, np.sin(myx), marker='^' )

The results are:

A - 6 TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023



Summary Report

This script produces a summary report with two summaries:

1 import mic
2 import numpy as np
3
4 mic.summary( "My Summaries" )
5 mic.summary.add( "Summary A",
6 ["Label 1:", "Label 2:", "Label 3:"],
7 ["val1", "val2", "val3"] )
8 mic.summary.add( "Summary B",
9 ["Label 4:", "Label 5:", "Label 6:"],
10 ["val4", "val5", "val6"] )

The result is:

Python Reports
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A Advanced Reports - Python Module

Tabular Report

If more than one column is required, the callmic.table is employed. This script produces a tabular
report consisting of two tables.

This script uses the Python package numpy and c-style formatting of the numerical
values.

11 import mic
12 import numpy as np
13
14 mic.table( "My Tables" )
15 mic.table.addtable( "My Set A" )
16 mic.table.addcolumn( "X", ["1.0", "2.0", "3.0"] )
17 mic.table.addcolumn( "Y", ["0.5", "1.0", "1.5"] )
18 x1 = 0.2
19 x2 = 0.5
20 x3 = 3.14159/2
21 mic.table.addtable( "My Set B" )
22 mic.table.addcolumn( "X", ['{:8.3f}'.format(x1),
23 '{:8.3f}'.format(x2),
24 '{:8.3f}'.format(x3)] )
25 mic.table.addcolumn( "sin(X)", ['{:8.3f}'.format(np.sin(x1)),
26 '{:8.3f}'.format(np.sin(x2)),
27 '{:8.3f}'.format(np.sin(x3))] )
28 mic.table.addcolumn( "cos(X)", ['{:8.3f}'.format(np.cos(x1)),
29 '{:8.3f}'.format(np.cos(x2)),
30 '{:8.3f}'.format(np.cos(x3))] )
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The result is:

Python Reports
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A Advanced Reports - Python Module

ACQUIRE BASIC INFORMATION

To acquire the adsorption isotherm and other basic information about the sample being edited, the
callsmic.isotherm,mic.sample_information, andmic.adsorptive_data are applied.

This script produces a graph of the adsorption and desorption isotherms for both relative and
absolute pressure, and prints summaries of the sample information and the adsorptive properties.

1 import mic
2
3 prel, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm

('rel')
4 mic.graph( 'Graphical Report 1', 'Relative Pressure (P/Po)', 'Quant-

ity Adsorbed (cm³/g STP)' )
5 mic.graph.add( 'Sample Isotherm', prel, qads )
6
7 pabs, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm

('abs')
8 mic.graph( 'Graphical Report 2', 'Absolute Pressure (mmHg)', 'Quant-

ity Adsorbed (cm³/g STP)' )
9 mic.graph.add( 'Sample Isotherm', pabs, qads )

10
11 mass = mic.sample_information('sample mass')
12 Tanl = mic.sample_information('analysis temperature')
13 dens = mic.sample_information('sample density')
14
15 mic.summary( "Sample Information" )
16 mic.summary.add( "Sample Information",
17 [ "Number of adsorption points:",
18 "Warm free space:",
19 "Cold free space:",
20 "Sample mass:",
21 "Description:",
22 "Analysis temperature:",
23 "Sample density:" ],
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24 [ '{:d}'.format(n_ads),
25 '{:8.3f}'.format(warm_fs) + ' cm³',
26 '{:8.3f}'.format(cold_fs) + ' cm³',
27 '{:8.3f}'.format(mass) + ' g',
28                    desc,
29 '{:8.3f}'.format(Tanl) + ' K',
30 '{:8.3f}'.format(dens) + ' g/cm³' ] )
31
32 csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
33
34 mic.summary.add( "Adsorptive Data",
35 [ "Cross sectional area:",
36 "Hard sphere diameter:",
37 "Density conversion factor:",
38 "Molecular weight:",
39 "Analysis gas:" ],
40 [ '{:8.3f}'.format(csa) + ' nm²',
41 '{:8.3f}'.format(hsd) + ' Å',
42 '{:8.3f}'.format(dcf),
43 '{:8.3f}'.format(mol_weight),
44                    analysis_gas ] )

Note the calls tomic.isotherm andmic.adsorptive_data above are each returning results as a list
with elements of varying return type.

Acquire Basic Information
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A Advanced Reports - Python Module

ACQUIRE REPORT RESULTS

Sample file report results may be accessed using themic.report call. This script prints a summary
of the results of the t-plot and BET reports.

1 import mic
2
3 sa  = mic.report("bet", "surface area")
4 c   = mic.report("bet", "bet constant")
5 vm  = mic.report("bet", "monolayer capacity")
6 esa = mic.report("tplot", "external surface area")
7 vol = mic.report("tplot", "micropore volume")
8
9 mic.summary( "BET and T-plot Results" )
10
11 mic.summary.add( "Report Results",
12 [ "BET surface area:",
13 "BET constant:",
14 "BET monolayer capacity:",
15 "T-plot external surface area:",
16 "T-plot micropore volume:" ],
17 [ '{:10.5f}'.format(sa) + ' m²/g',
18 '{:10.5f}'.format(c),
19 '{:10.5f}'.format(vm) + ' cm³/g',
20 '{:10.5f}'.format(esa) + ' m²/g',
21 '{:10.5f}'.format(vol) + ' cm³/g' ] )

The result is:
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Acquiring the results from a pore-distribution report such as the BJH method is done in a similar
way as in the previous script except the return values from themic.report call are slightly different
since they involve lists of data. For example:

1 import mic
2 import numpy as np
3
4 xdat, ydat, desc = mic.report( 'bjhads', 'incremental distribution'

)
5 if not (np.isnan(xdat[0]) or np.isnan(ydat[0])): # NaN indicates BJH

calculation error.
6     mic.graph( 'BJH Adsorption/Desorption', 'Pore Diameter (Å)',

'Incremental Volume (cm³/g)' )
7     mic.graph.add( desc, xdat, ydat )

The result is:

Acquire Report Results
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A Advanced Reports - Python Module

ACQUIRE OVERLAY SAMPLE DATA

The call to obtain overlay sample data is similar to the calls for the primary sample. This script
involves two overlay sample files.

The calls to obtain adsorptive data and report results for an overlay sample file usingmic.report
andmic.adsorptive_data have a very similar interface as themic.overlay call, and a summary of
their usage is shown in the example in this topic.

1 import mic
2
3 p, q, n, fsw, fsc, mass, desc = mic.isotherm('rel')
4 p1, q1, n1, fsw1, fsc1, mass1, desc1 = mic.overlay( 1, 'rel')
5 p2, q2, n2, fsw2, fsc2, mass2, desc2 = mic.overlay( 2, 'rel')
6
7 mic.graph( 'Three Sample Isotherms', 
8 'Relative Pressure (P/Po)',
9 'Quantity Adsorbed (cm³/g STP)' )
10
11 mic.graph.add( 'Primary Isotherm', p, q )
12 mic.graph.add( 'Overlay Isotherm 1', p1, q1 )
13 mic.graph.add( 'Overlay Isotherm 2', p2, q2 )
14
15 mic.summary( "A Summary Report" )
16
17 mic.summary.add( "Two samples",
18 [ "Primary sample:",
19 "Overlay sample 1:",
20 "Overlay sample 2:" ],
21 [ desc, 
22                    desc1, 
23                    desc2 ] )
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The results are:

To enable the use of overlay data in the Advanced reports, the following two actions must be
taken prior to running the script:

n Sample files to overlay must be selected, and
n TheOverlay samples checkbox on the Advanced Report Options window must be selected.

Acquire Overlay Sample Data
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A Advanced Reports - Python Module

ENABLE THE USE OF OVERLAY DATA

1. On the Report Options tab, clickOverlays.
2. On the Plot Overlay Sample Selection window, to move a file from the Available Files list

box to the Selected Files list box, either double-click a file name in the Available Files list
box or click one or more files in the Available Files list box then click Add.

3. ClickOK.
4. On the Report Options tab, highlight Advanced in the Selected Reports list box.
5. Click Edit.
6. Select theOverlay samples checkbox to the right of the selected report.
7. ClickOK.
8. Run the script using the instructions found in Scripts on page A - 4.
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MICMODULE PYTHON CALLS

Tables

Available Mic Python calls for tables:

n Create a new tabular report
n Add a column
n Add a table

Add a Table

This script adds a table to the last created tabular report:

1 mic.table.addtable( name )
2
3 Keyword arguments:
4
5   name --- the table name

Add a Column

This script adds a column to the last created table:

1 mic.table.addcolumn(header, values, align='r'):
2
3 Keyword arguments:
4
5   header --- column header; must be a string (or convertible)
6   values --- column values; must be a list of strings (or con-

vertible)
7   align  --- column alignment; 'r', 'l', 'c' for right, left, and

center justified

MicModule Python Calls

TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023 A - 17



A Advanced Reports - Python Module

Create a New Tabular Report

1 mic.table( title='User Table' )
2
3 Keyword arguments:
4
5   title --- the tabular report title (default = 'User Table')
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Summary Reports

Add a Summary Section

This script adds a summary section to the last created summary report:

1 mic.summary.add(name, labels, values):
2
3 Keyword arguments:
4
5   name   --- summary section name
6   labels --- column of labels; must be a list of strings
7 (or convertible) and the same length as values
8   values --- column of values; must be a list of strings
9 (or convertible) and the same length as labels

Create a New Summary Report

1 mic.summary( title='User Summary' )
2
3 Keyword arguments:
4
5   title --- the summary title

MicModule Python Calls
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A Advanced Reports - Python Module

Graphic Reports

Add a Curve

This script adds a curve to the last created graphical report:

1 mic.graph.add(name, x, y, yyaxis=False, color=None, linestyle='-',
2               marker='a', graphtype='both', interpolation='akima'):
3
4 Keyword arguments:
5
6   name      --- the curve name
7   x         --- list of x values; must be a list of floats
8 (or convertible) and the same length as y
9   y         --- list of y values; must be a list of floats

10 (or convertible) and the same length as x
11   yyaxis    --- place this curve on the yy-axis if True
12                 otherwise place on the y-axis (default = False)
13   color     --- RGB color as an HTML hex string (e.g., '#4169e1')
14 or a three-element list or tuple (e.g.,

[65,105,225]);
15 if None, color is automatically selected (default =

None)
16   linestyle --- line style; (default = '-')
17 '-'        : solid
18 '--'       : dash
19 '.'        : dot
20 '-.'       : dash dot
21 '-..'      : dash dot dot
22   marker    --- marker shape; (default = 'a')
23 '+'        : plus
24 'o' or '0' : circle
25 'x'        : cross
26 '^'        : up triangle
27 'v'        : down triangle

A - 20 TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023



28 's'        : square
29 'd'        : diamond
30 '8'        : hourglass
31 '~'        : horizontal hourglass
32 '' or None : no marker
33 'a'        : automatically selected
34   graphtype --- graph type; (default = 'both')
35 'curve' or 'c' : curve
36 'points' or 'p' : points
37 'both' or 'b' : curve-and-points
38 'hist' or 'h' : histogram
39   interpolation -- linear or akima spline interpolation

(default='akima')
40 'akima' use akima spline
41 'linear' use linear interpolation

Add a Curve Using the Second Y-Axis

This script adds a curve to the last created graphical report using the second y-axis:

1 mic.graph.addyy(name, xx, yy):
2
3 Add a curve to the last created graphical report using the second
4 y-axis. The arguments to this call are the same as to mic.-

graph.add.

MicModule Python Calls
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A Advanced Reports - Python Module

Create a New Graphical Report

1 mic.graph(title='User Graph', xlabel='X axis', ylabel='Y axis',
2           yylabel='YY axis',
3           xlinear=True, ylinear=True, yylinear=True,
4           xinvert=False, yinvert=False, yyinvert=False,
5           xrange=None, yrange=None, yyrange=None, xbars_id=''):
6
7 Keyword arguments:
8
9   title    --- the graphical report title (default = 'User Graph')
10   xlabel   --- x-axis label (default = 'X axis')
11   ylabel   --- y-axis label (default = 'Y axis')
12   yylabel  --- yy-axis label (default = 'YY axis')
13   xlinear  --- x-axis linear scale; if false, use log scale
14 (default = True)
15   ylinear  --- y-axis linear scale; if false, use log scale
16 (default = True)
17   yylinear --- yy-axis linear scale; if false, use log scale
18 (default = True)
19   xinvert  --- Invert x-axis if true (default = False)
20   yinvert  --- Invert y-axis if true (default = False)
21   yyinvert --- Invert yy-axis if true (default = False)
22   xrange   --- None, or two values giving the min and max
23                range of the axis.
24   yrange   --- None, or two values giving the min and max
25                range of the axis.
26   yyrange  --- None, or two values giving the min and max
27                range of the axis.
28   xbars_id --- None, or the id of an xbar control created
29                via the mic.control() object
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Get Primary Isotherm Data

1 mic.isotherm(press_type='rel', sample_number=0, item=''):
2
3 Get isotherm data.
4
5 Keyword arguments:
6
7   press_type    --- the pressure basis; use 'rel' for relative pres-

sure,
8 'abs' for absolute (default = 'rel'). This is

ignored
9 if the 'item' argument is also used.
10
11   sample_number --- Sample to retrieve
12 0           : current sample file (default)
13 1 through 8 : corresponding overlay sample file
14
15   item          --- string identifying the item to be returned.
16                     For example; 'absolute pressure', or 'quantity

adsorbed'
17                     The default is an empty string for which the

return
18                     value is the below list of quantities
19
20 Usage for specified item:
21   prel = mic.isotherm(sample_number=0, item='relative pressure')
22
23 Usage with tuple returned:
24   p, qads, n_ads, warm_fs, cold_fs, mass, desc = mic.isotherm

('rel')
25
26   p       --- array of pressure (relative or absolute)
27   qads    --- array of cumulative quantity adsorbed
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A Advanced Reports - Python Module

28   num_ads --- number of points in the adsorption curve
29   warm_fs --- warm free-space
30   cold_fs --- cold free-space
31   mass    --- sample mass
32   desc    --- sample description
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Get Overlay Isotherm Data

1 mic.overlay(overlay_number=1, press_type='rel'):
2
3 Get overlay isotherm data.
4
5 Keyword arguments:
6
7   overlay_number --- the overlay number (1 through 8; default = 1)
8   press_type     --- the pressure basis; use 'rel' for relative

pressure,
9 'abs' for absolute (default = 'rel')

10
11 Usage:
12
13   p, qads, num_ads, warm_fs, cold_fs, mass, desc = mic.overlay(1,

'rel')
14
15   p       --- array of pressure (relative or absolute);
16               empty-array if overlay is unavailable
17   qads    --- array of cumulative quantity adsorbed;
18               empty-array if overlay is unavailable
19   num_ads --- number of points in the adsorption curve;
20 0 if overlay is unavailable
21   warm_fs --- warm (ambient) free-space; 0.0 if overlay is unavail-

able
22   cold_fs --- cold (analysis) free-space; 0.0 if overlay is unavail-

able
23   mass    --- sample mass; 0.0 if overlay is unavailable
24   desc    --- sample description; empty-string if
25               overlay is unavailable
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Get Adsorptive Data for Each Sample

1 mic.adsorptive_data(sample_number=0):
2
3 Get adsorptive data for each sample
4
5 Keyword arguments:
6
7   sample_number --- Identifier for the adsorptive data to retrieve
8 0           : current sample file (default)
9 1 through 8 : corresponding overlay sample

file
10
11 Usage:
12
13   csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data()
14   csa, hsd, dcf, mol_weight, analysis_gas = mic.adsorptive_data(0)
15
16   csa          --- cross sectional area (nm^2)
17   hsd          --- hard sphere diameter (angstroms)
18   dcf          --- density conversion factor (dimensionless)
19   mol_weight   --- molecular weight
20   analysis_gas --- mnemonic for the analysis gas species
21 (e.g., 'CO', 'H2')
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Get Sample Information Item

1 mic.sample_information( item, sample_number = 0 ):
2
3 Keyword arguments:
4
5   item          --- string identifying the item to be returned.
6                     For example; 'sample mass', or 'sample descrip-

tion'
7                     The default is an empty string for which the

return
8                     value is a list of all available keywords
9

10   sample_number --- Sample to retrieve
11 0           : current sample file (default)
12 1 through 8 : corresponding overlay sample file
13
14 Usage:
15
16   all_keywords = sample_information()
17   mass         = sample_information('sample mass')
18   mass         = sample_information('sample mass',0)
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Get Report Results

This script gets report results for the indicted report and sample:

1 mic.report(report_name='', result='', sample_number=0):
2
3 Get report results for the indicated report and sample
4
5 Keyword arguments:
6
7   sample_number --- Identifier for the sample data to retrieve.
8 0           : current sample file (default)
9 1 through 8 : corresponding overlay sample file

10
11 Usage:
12
13   sa                  = mic.report('bet', 'surface area')
14
15   porew, incvol, desc = mic.report('bjhads',
16 'incremental distribution')
17
18 The available report keywords, result keywords and a corresponding
19 description of the result is listed in the table below
20
21    Report        Result                   Description
22 -----------   --------------              -----------
23     bet        surface area               Surface area (m^2/g)
24     bet        bet constant               BET constant (dimen-

sionless)
25     bet        monolayer capacity         Monolayer capacity

(cm^3/g)
26     tplot      external surface area      External surface area

(m^2/g)
27     tplot      micropore volume           Micropore volume (cm^3/g)
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28     bjhads     incremental distribution   Incremental Distribution
29     bjhdes     incremental distribution   Incremental Distribution
30     dhads      incremental distribution   Incremental Distribution
31     hk         incremental distribution   Incremental Distribution
32     dft        incremental distribution   Incremental Distribution
33     nldft      incremental distribution   Incremental Distribution
34
35
36   where the incremental pore distribution result above (for those
37   reports which return this) is a list with three components being,
38
39   porew  --- array of pore dimension boundaries (angstroms);
40              empty-array if unavailable.
41   incvol --- array of incremental pore volumes (cm^3/g);
42              empty-array if unavailable.
43   desc   --- Name of data set; empty-string if unavailable.
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Get Imported Pore Data

1 mic.imported_pore_data(import_number=1):
2
3 Get imported pore data.
4
5 Keyword arguments:
6
7   import_number --- the import number (1 through 8)
8
9 Usage:
10
11   porew, incvol, desc = mic.imported_pore_data(1)
12
13   porew  --- array of pore dimension boundaries (angstroms);
14              empty-array if unavailable.
15   incvol --- array of incremental pore volumes (cm^3/g);
16              empty-array if unavailable.
17   desc   --- Name of data set; empty-string if unavailable.
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B DFT MODELS

Theories are developed by scientists in an attempt to explain a class of observed behavior. In the
experimental physical sciences, theories are often expressed in terms of a model that can be
visualized and described mathematically. Early models of physisorption were quite simple, both
conceptually and mathematically. For very practical reasons, hand computations were required.
Today we can explore complex models that describe adsorption systems on the atomic scale of
size and sub-picosecond time frame. This is not because scientists are smarter, but because of
available tools. The DFT models are created by classical approaches to adsorption as well as
models based on modern statistical thermodynamics.

MODELS BASED ON STATISTICAL THERMODYNAMICS
Included in this group are methods that model the adsorption system in terms of forces acting
between individual molecules.

THEORETICAL BACKGROUND
Traditional adsorption theories attempt to describe experimental adsorption isotherms with an
isotherm equation containing a small number of parameters. At a minimum, these parameters
include the extent of the surface, such as the monolayer capacity (Qm), and the molar intensity of
the gas-surface interaction, such as the Langmuir “K” constant or the BET “C” constant. In some
equations, additional parameters take into account the lateral interaction of adsorbed molecules
with each other. Other theories, such as the Dubinin-Astakhov approach, also include parameters
for the effect of adsorbent porosity.

Instead of this classical kinetic or phenomenological approach, we can use a molecular-based
statistical thermodynamic theory that allows us to relate the adsorption isotherm to the
microscopic properties of the system: the fluid-fluid and fluid-solid interaction energy parameters,
the pore size, the pore geometry, and the temperature.

The following example is provided to understand how such a theory is constructed:

A clean sample of a solid material containing slit-shaped pores of a single width is placed in an
evacuated space. It is kept at a fixed temperature as a known quantity of pure argon gas is
admitted into the space surrounding the sample. The pressure within the space is recorded
over time. In this situation, the pressure falls rapidly from its initial value and gradually
approaches a steady reading, called the equilibrium pressure. The amount adsorbed
corresponds to the quantity of gas effectively removed from the gas phase by the solid
surface. A graph that plots amount adsorbed versus equilibrium pressure is called an
adsorption isotherm.

B DFT Models
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B DFT Models

Under such conditions, the argon atoms that randomly enter the pore space feel the presence
of the solid surface as the action of an external attractive force (the dispersion forces or Van
der Waal’s forces) and spend more time near the surface. As a result, the space near the
surface acquires a greater average density of argon atoms than regions farther removed.

If the equilibrium distribution of the gas atoms near the surface could be described as a
function of pressure and the molecular properties of the components of the system, then a
model could be constructed for the adsorption isotherm for the system. Modern physical
chemistry provides several ways to calculate this distribution. All these methods are based on
the fundamental thermodynamic law that such a system adopts a configuration of minimum
free energy at equilibrium. Also needed is a description of the pairwise interaction energy
between atoms, U(s), commonly given by a Lennard-Jones potential:

where

ε = a characteristic energy of the adsorptive,
σ = the diameter of the adsorptive molecule, and
s = the separation distance.

MOLECULAR SIMULATION METHODS

Two simulation techniques are commonly used to determine the distribution of gas molecules in a
system in equilibrium: the molecular dynamics method and the Monte Carlo method. Both of these
are used as reference methods because their results are considered exact.

MOLECULAR DYNAMICS METHOD

In the molecular dynamics method, the position and velocity of individual gas particles are
calculated over time at very short intervals. This method takes into account both the forces acting
between the gas particles themselves and those acting between the gas particles and the atoms
of the simulated surface. As the simulated particles collide with each other and with the surface,
the average concentration of particles in the space near the surface is calculated; this calculation
yields the amount of gas adsorbed.

This method can be thought of as a way to determine the chronological record of the movement of
each particle in the system using time steps of 10-14 seconds. Although the mathematics are
simple, the number of calculations required for a system of even a few hundred particles is
astronomical and challenges even the fastest computers.
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MONTE CARLO METHOD

In the Monte Carlo method, determination of the system equilibrium distribution begins with an
assumption (which may be only approximate) about the initial configuration of particles in the
system. The system is “equilibrated” through a process of randomly selecting one particle and
conditionally moving it a random distance in a random direction.

If the move results in a configuration of lower total energy, then the move is completed and
another particle is randomly selected to be moved.

If the move results in a configuration of higher energy, a probability for that event is calculated,
and a random number between zero and one is generated. If the generated number is smaller
than the probability of the event, then the move is accepted; otherwise, another particle is selected
and the process is repeated. This process continues until the average total energy of the system
no longer decreases; at this point, average configuration data are accumulated to yield the mean
density distribution of particles in the system.

Monte Carlo simulations require considerably less computation time than molecular dynamic
simulations and can yield the same results; however, neither method provides a really practical
way to calculate complete isotherms.

DENSITY FUNCTIONAL FORMULATION
Density functional theory offers a practical alternative to both molecular dynamic and Monte Carlo
simulations. When compared to reference methods based on molecular simulation, this theory
provides an accurate method of describing inhomogeneous systems yet requires fewer
calculations. Because the density functional theory provides accuracy and a reduced number of
calculations, it is the basis embodied in the DFT models.

The system being modeled consists of a single pore represented by two parallel walls separated
by a distance H. The pore is open and immersed in a single component fluid (adsorptive) at a fixed
temperature and pressure. Under such conditions, the fluid responds to the walls and reaches an
equilibrium distribution. In this condition (by the definition of equilibrium), the chemical potential at
every point equals the chemical potential of the bulk fluid. The bulk fluid is a homogenous system
of constant density; its chemical potential1 ) is determined by the pressure of the system using
well-known equations. The fluid near the walls is not of constant density; its chemical potential is
composed of several position-dependent contributions that must total at every point to the same
value as the chemical potential of the bulk fluid.

1 ) Chemical potential may be thought of as the energy change felt by a probe particle when it is
inserted into the system from a reference point outside the system. It can also be defined as the
partial derivative of the grand potential energy with respect to density (or concentration).
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As noted previously, at equilibrium, the whole system has a minimum (Helmholtz) free energy,
known thermodynamically as the grand potential energy (GPE). Density functional theory
describes the thermodynamic grand potential as a functional of the single-particle density
distribution; therefore, calculating the density profile that minimizes the GPE yields the equilibrium
density profile. The calculation method requires the solution of a system of complex integral
equations that are implicit functions of the density vector. Since analytic solutions are not possible,
the problemmust be solved using iterative numerical methods. Although calculations using these
methods still require supercomputing speed, the calculation of many isotherm pressure points for
a wide range of pore sizes is a feasible task. The complete details of the theory and the
mathematics can be found in the papers listed under DFT Model References on page B - 16.

The following graphs and accompanying text illustrate the results of using density functional
theory to predict the behavior of a model system.

Figure 1 shows the density profile for argon at a carbon surface as calculated by density functional
theory for a temperature of 87.3 K and a relative pressure of about 0.5.

Figure 1

Density Profile for Argon on Carbon at
87.3 K and a Relative Pressure of 0.5

This figure represents a cross-section of the region near the surface. Note the layerwise
distribution of adsorbate; the first monolayer is sharply defined and a third layer can be
distinguished. The area under the profile curve represents the amount adsorbed per unit area at
this pressure. The positions of the maxima are separated by a distance determined by the size of
the adsorptive atom.
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Given the density profile, the amount adsorbed at the stated pressure can be easily calculated as
the integral over the profile. Repeating this calculation over a range of pressures yields the
adsorption isotherm for the model. If the value of H is very large, the isotherm obtained
corresponds to that of an external, or free, surface. If H is smaller, a range of pressures is reached
where two minima exist for the grand potential, showing the presence of two metastable phases
having different density distributions but the same chemical potential. The phase with the lower
GPE is the stable one. As the pressure is increased, a point is reached where the other phase
becomes the stable one. This phase transition reflects condensation of adsorbate in the pore; the
pressure at which it occurs is called the critical pore-filling pressure. This pressure is analogous to
the condensation pressure predicted by the Kelvin equation in the classical model of pore filling.

Figure 2 shows how the profiles change with pressure for a model pore with H = 40 angstroms.
The inset shows the density profiles for the corresponding points of the isotherm.

Figure 2

Model Isotherm for Argon at 87.3 K in a
40 Å Slit in a Carbon Substrate

The profiles show the density distribution from one wall to the center of the slit; the other half of the
distribution is a mirror image of the profile shown.

As the pressure is first increased from zero, almost all the adsorbed atoms occupy a position close
to the surface.

n Inset a shows the profile corresponding to point a on the isotherm where the surface is about
half covered.

n At point b, the first layer is so full that it is more favorable for atoms to start a new layer.
n At point c, a third layer is forming. Point c, for this size slit, is the critical pore-filling pressure. In

inset c, the profile shows the density decreasing to near zero (actually the bulk gas density) at 4
or 5 molecular diameters from the surface.

n Inset d shows the profile converging on a density similar to that of bulk liquid argon in the center
of the pore, indicating a phase transition.
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Note that the adsorption isotherms for pores larger than the one shown in the previous graph is
identical up to point c. The lower branch of the isotherm simply continues to a higher pressure for
larger pores. This trend is illustrated in the Figure 3, where isotherms for some larger size pores
are shown. It is clear that pore size is uniquely characterized by a corresponding critical pore-
filling pressure. At large pore sizes, density functional theory produces results for the critical filling
pressures that are in good agreement with those produced by the Kelvin equation.

Figure 3

Model Isotherms for Some Larger Pore
Widths Argon on Carbon at 87.3 K

Figure 4 shows model isotherms for pores in the micropore size range. Note the logarithmic scale
for pressure.

Figure

Model Isotherms in the Micropore Size
Range of Pore Width Argon on Carbon
at 87.3 K
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Pores of 4 Å width, barely larger than the argon atom (3.38 Å), fill at pressures below 1 millitorr.
Pores below 15 Å fill before a monolayer is completed on the surface of the larger pores. In the
micropore size range, the pore volume fills more gradually with pressure and the total shape of the
isotherm is important in characterizing the pore size.

Models Included

Non-Local Density Functional Theory with Density-Independent Weights

N2 - DFT Model
AR - DFT Model

Geometry: Slit
Substrate: Carbon (graphite)
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Using the methods of non-local density functional theory, two sets of isotherms have been
calculated to serve as kernel functions for the characterization of porous solids from adsorption
data. The model isotherms are stored in binary format files. These models assume a slit-like pore
geometry. The pore size range from 4.0 to 4000 Å is covered in 91 classes in a geometric
progression. The class intervals are rounded to the nearest 0.02 molecular diameters. A model for
the free or external surface is included to account for unfilled pores. Each of the 92 model
isotherms has been calculated at 181 pressure points from near 1×10-6 to near 1.00 relative
pressure.

These models are identical to those supplied with the original DOS version of DFT software.
Some slight difference from the DOS results may be noted when they are applied to the same
data due to improvements in the deconvolution algorithm and better regularization of the current
software.

Non-Local Density Functional Theory with Density-Dependent Weights

N2 - Modified Density Functional

Geometry: Free surface
Substrate: Surface energy
Method: Nitrogen at 77K
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Using the modified Tarazona prescription described by Olivier (see DFT Model References on
page B - 16 [items 3 and 4]), model isotherms were calculated for a wide range of adsorptive
energies to a relative pressure of 0.6. The model makes no provision for pore filling in the
micropore region. If the sample solid contains small mesopores, the isotherm data should be
truncated (using the Select Data Points window) to a suitably low relative pressure to avoid trying
to fit this region; mesopore filling reports as a large area of low energy in the calculated distribution
of adsorptive potential.

The surface energy is reported in terms of the effective Lennard-Jones interaction parameter, i.e.,
for the adsorptive / adsorbent pair divided by Boltzmann constant. The units are therefore Kelvin.

N2 - Cylindrical Pores - Oxide Surface
AR - Cylindrical Pores - Oxide Surface

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using a combination of statistical mechanical calculations and
experimental observations for macroporous silicas and MCM-41 mesoporous silicas as well as
zeolites. The pore-filling pressures were determined as a function of the pore size from adsorption
isotherms on MCM-41 materials characterized by X-ray and other techniques. The variation of the
pore fluid density with pressure and pore size has been accounted for by density functional theory
calculations. The N2 model reports pore sizes ranging from 3.8 to 387 Å and the ARmodel from
3.8 to over 500 angstroms.

References: M. Jaroniec, M. Kruk, J.P. Olivier, and S. Koch, “A NewMethod for the
Accurate Pore Size Analysis of MCM-41 and Other Silica-Based Meso-
porous Materials,” Proceedings of COPS-V, Heidelberg, Germany (1999).

N2 – Cylindrical Pores – Pillared Clay Surface (Montmorillionite)

Geometry: Cylinder
Substrate: Crystalline Silicate
Category: Porosity
Method: Nitrogen at 77K

Model isotherms were calculated using a combination of statistical thermodynamic Non-Local
Density Functional Theory (NLDFT) calculations and experimental isotherms for reference
samples of montmorillionite. The construction method for the hybrid models was analogous to that
described in the first reference below (Jaroniec et al,1999). The additional references add
additional theoretical details as well as examples of the application of the model to pillared clay
catalysts. This model reports pore widths from 3.8 to 387 angstroms.
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References: Mietec Jaroniec, Michal Kruk, James P. Olivier and Stefan Koch, “A New
Method for the Characterization of Mesoporous Silicas,” Proceedings of
COPS-V, 1999, Studies in Surface Science, Vol 128, Characterization of
porous Solids V , Unger, et al, Eds, Elsevier, Amsterdam, 2000.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
a Pillared Interlayered Clay (PILC) from a Hybrid Density Functional
Theory (DFT) Method,” The Journal of Physical Chemistry B; 2001, 105
(3), 623-629.

M. L. Occelli, J. P. Olivier, J. A. Perdigon-Melon, and A. Auroux, “Surface
Area, Pore Volume Distribution, and Acidity in Mesoporous Expanded
Clay Catalysts from Hybrid Density Functional Theory (DFT) and
Adsorption Microcalorimetry Methods,” Langmuir 2002, 18, 9816-
9823.9b.

James P. Olivier, “The Importance of Surface Heterogeneity in
Developing Characterization Methods.” 6th International Symposium on
the Characterization of Porous Solids, Studies in Surface Science and
Catalysis 144, Elsevier, 2002.

James P. Olivier and Mario L. Occelli, “Surface Area and Microporosity of
Pillared Rectorite Catalysts from a Hybrid Density Functional Theory
Method,”Microporous and Mesoporous Materials 2003, 57, 291-296.

C02 - DFT Model

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Carbon dioxide at 273 K

Model isotherms were calculated using the non-local prescription of Tarazona, employing
molecular parameters derived from the known bulk properties of carbon dioxide.

AR - Modified Density Functional Model

Geometry: Free surface
Substrate: Any
Category: Surface energy
Method: Argon at 87K

This model was produced in the same manner as the N2 Modified Density Functional model listed
earlier, except applicable to argon adsorbed at 87.3 K.
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N2 - Tarazona NLDFT, Esf = 30.0K

Geometry: Cylinder
Substrate: Oxide
Category: Porosity
Method: Nitrogen at 77K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a cylindrical pore geometry. The wall potential used is k = 30 K, typical for
a silica or alumina surface.

This model file is particularly useful for sizing zeolites or zeolite containing materials that have
substantial micropore volume. The reported pore size range is 3.8 to 387 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Slit Pores by NLDFT
Ar - Carbon Slit Pores by NLDFT

Geometry: Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and a slit-like pore geometry. These models are slightly different from N2-DFT
and Ar-DFT models that were calculated using NLDFT with density independent weighting
functions.

The reported pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Finite Pores, As=6, 2D-NLDFT
Ar - Carbon Finite Pores, As=6, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions assuming 2D model of finite slit pores having a diameter-to-width aspect ratio
of 6.

This model is particularly useful for microporous carbon materials. The reported pore size range is
from 3.5 to 250 angstroms.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore
structure analysis.,” The Journal of Physical Chemistry C, 113(45):19382-
19385, 2009.

N2 - Carbon Finite Pores, As=12, 2D-NLDFT
Ar - Carbon Finite Pores, As=12, 2D-NLDFT

Geometry: Finite Slit
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77K; Argon at 87K

Model isotherms were calculated using the same methods and assumptions that were used in the
model above except in this model, the aspect ratio is equal to 12.

These two finite pore models may be used as a research tool in conjunction with independent
analytical techniques such as high-resolution transmission electron microscopy (HRTEM) and/or
X-ray diffraction (XRD) to obtain comprehensive information about the structure of studied carbon
material.

References: Jacek Jagiello and James P. Olivier. “A simple two-dimensional NLDFT
model of gas adsorption in finite carbon pores. Application to pore
structure analysis.,” The Journal of Physical Chemistry C, 113(45):19382-
19385, 2009.

N2 - Carbon Cylinder, single-wall nanotube by NLDFT
Ar - Argon Cylinder, single-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Models Based on Statistical Thermodynamics
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Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the graphitic surface of an
infinitely long cylinder.

This model is particularly useful for characterizing carbon single-wall nanotubes. The reported
pore size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987).

N2 - Carbon Cylinder, multi-wall nanotube by NLDFT
Ar - Argon Cylinder, multi-wall nanotube by NLDFT

Geometry: Cylinder
Substrate: Carbon
Category: Porosity
Method: Nitrogen at 77 K; Argon at 87 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and multiple concentric graphitic
surfaces of infinitely long cylinders.

This model is particularly useful for characterizing carbon multi-wall nanotubes. The reported pore
size range is from 3.5 to 1000 angstroms.

References: P. Tarazona, Phys. Rev. A 31: 2672 (1985).
Idem, Phys. Rev. A 32: 3148 (1985).
P. Tarazona, U. M. B. Marconi, and R. Evans, Mol. Phys. 60: 573 (1987)

Ar - Zeolites H-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an
infinitely long cylinder.
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This model is particularly useful for characterizing oxides and H+ and (NH4)+ exchanged zeolites.
The reported pore size range is from 3.5 to 300 angstroms.

Ar - Zeolites Me-Form by NLDFT

Geometry: Cylinder
Substrate: Zeolite
Category: Porosity
Method: Argon at 77 K

Model isotherms were calculated using the prescriptions of Tarazona for density dependent
weighting functions and cylindrical pore geometry. The pore wall potential is described by the
Lennard-Jones potential of interaction between a gas molecule and the oxide surface of an
infinitely long cylinder.

This model is similar to the model above, but it more appropriate is for characterizing alkali metal
exchanged zeolites. The reported pore size range is from 3.5 to 300 angstroms.

MODELS BASED ON CLASSICAL THEORIES
Both surface energy distribution and pore size distribution may be evaluated using classical
approaches to model kernel functions for use with equation (1) of the DFT Theory. The
Calculations document can be found on the Micromeritics web page (www.micromeritics.com). Be
aware that the deconvolution method only provides a fitting mechanism; it does not overcome any
inherent shortcomings in the underlying theory.

SURFACE ENERGY
The use of classical theories to extract adsorptive potential distribution is mostly of historical
interest. At a minimum, the equation must contain a parameter dependent on adsorption energy
and another dependent on monolayer capacity or surface area. This is sufficient to permit the
calculation of the set of model isotherms that is used to create a library model. The Langmuir
equation has been used in the past, as have the Hill-de Boer equation and the Fowler-
Guggenheim equation. All of these suffer from the fact that they only describe monolayer
adsorption, whereas the data may include contributions frommultilayer formation.

Models Based on Classical Theories
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B DFT Models

PORE SIZE
It is well established that the pore space of a mesoporous solid fills with condensed adsorbate at
pressures somewhat below the prevailing saturated vapor pressure of the adsorptive. When
combined with a correlating function that relates pore size with a critical condensation pressure,
this knowledge can be used to characterize the mesopore size distribution of the adsorbent. The
correlating function most commonly used is the Kelvin equation. Refinements make allowance for
the reduction of the physical pore size by the thickness of the adsorbed film existing at the critical
condensation pressure. Still further refinements adjust the film thickness for the curvature of the
pore wall.

The commonly used practical methods of extracting mesopore distribution from isotherm data
using Kelvin-based theories, such as the BJH method, were for the most part developed decades
ago and were designed for hand computation using relatively few experimental points. In general,
these methods visualize the incremental decomposition of an experimental isotherm, starting at
the highest relative pressure or pore size. At each step, the quantity of adsorptive involved is
divided between pore emptying and film thinning processes and exactly is accounted for. This
computational algorithm frequently leads to inconsistencies when carried to small mesopore
sizes. If the thickness curve used is too steep, it finally will predict a larger increment of adsorptive
for a given pressure increment than is actually observed; since a negative pore volume is non-
physical, the algorithm must stop. Conversely, if the thickness curve used underestimates film
thinning, accumulated error results in the calculation of an overly large volume of (possibly
nonexistent) small pores.

The use of equation (1) represents an improvement over the traditional algorithm. Kernel
functions corresponding to various classical Kelvin-based methods have been calculated for
differing geometries and included in the list of models.

MODELS INCLUDED

Kelvin Equation with Halsey Thickness Curve

N2 - Halsey Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Halsey equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:
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Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

N2 - Halsey Thickness Curve

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

Reference: G. Halsey, J. Chem. Phys 16, 931 (1948).

Kelvin Equation with Harkins and Jura Thickness Curve

N2 - Harkins and Jura Thickness Curve

Geometry: Slit
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Harkins and Jura equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887 g cm-3

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is the same as above except that cylindrical geometry is assumed.

References: W. D. Harkins and G. Jura, J.A.C.S. 66, 1366 (1944).
J. H. DeBoer et al., J. Colloid and Interface Sci. 21, 405 (1966).

Models Based on Classical Theories
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B DFT Models

Kelvin Equation with Broekhoff-de Boer Thickness Curve

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The kernel function is calculated using the Broekhoff-de Boer equation with standard parameters:

The nitrogen properties used in the Kelvin equation are:

Surface tension = 8.88 dynes cm-1

Molar density = 0.02887g cm-3

N2 - Broekhoff-de Boer Model

Geometry: Cylinder
Substrate: Average
Category: Porosity
Method: Nitrogen 77 K

The calculation is similar to the above except that cylindrical geometry is assumed, and the film
thickness depends on pore size (see reference).

References: Specifically, equations 20 and 21 in: J.C.P. Broekhoff and J.H. de Boer,
“The Surface Area in Intermediate Pores,” Proceedings of the Inter-
national Symposium on Surface Area Determination, D.H. Everett, R.H.
Ottwill, eds., U.K. (1969).

DFT MODEL REFERENCES
The papers listed below provide additional information on DFT models:

1. “Determination of Pore Size Distribution from Density Functional Theoretic Models of
Adsorption and Condensation within Porous Solids,” J.P. Olivier and W.B. Conklin, Micro-
meritics Instrument Corp; presented at the International Symposium on the Effects of Sur-
face Heterogeneity in Adsorption and Catalysts on Solids, Kazimierz Dolny, Poland (July
1992).
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2. “Classification of Adsorption Behavior: Simple Fluids in Pores of Slit-shaped Geometry,”
Perla B. Balbuena and Keith E. Gubbins, Fluid Phase Equilibria, 76, 21-35, Elsevier
Science Publishers, B.V., Amsterdam (1992).

3. “Modeling Physical Adsorption on Porous and Nonporous solids Using Density Functional
Theory,” J.P. Olivier, Journal of Porous Materials, 3, 9-17 (1995).

4. “The Determination of Surface Energetic Heterogeneity Using Model Isotherms Calculated
by Density Functional Theory,” J.P. Olivier; presented at the Fifth International Conference
on the Fundamentals of Adsorption, Pacific Grove, CA (1995).

DFT Model References
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C FREE-SPACE CORRECTION
Free space is that volume of the sample tube which is unoccupied by the sample. The quantity of
gas dosed into the sample tube is calculated from the difference in pressures in the manifold
before and after the dose is delivered. The quantity of gas adsorbed by the sample is calculated
by subtracting the quantity of gas remaining in the free space of the sample tube after equilibrium
is established from the quantity of gas originally dosed into the sample tube. Free space must be
determined accurately to obtain a precise value for quantity adsorbed.

Static-volumetric systems consist basically of a gas manifold joined to a sample tube by an
isolation valve. The manifold section has connections for an absolute pressure transducer, a
temperature gauge, and a vacuum system. It also has inlets for the adsorptive gas and helium. A
Dewar flask containing a cryogenic liquid (usually LN2 at approximately 77 K) is situated so that it
can be raised to immerse most of the sample tube. Two temperature zones exist within the
sample tube when immersed in the cryogenic bath: a warm zone (the volume above the liquid
level and near ambient temperature) and a cold zone (the volume below the liquid level at
cryogenic temperature). Not only must the total free space volume be determined, but it also is
necessary to determine the quantity of gas residing within the “cold” zone since a nonideality
correction must be applied to only that quantity of gas.

The total quantity of gas in the partly immersed sample holder cannot simply be determined using
n = PV/RT because temperature is not constant over the total volume, but instead is distributed as
two temperature zones with a steep temperature gradient between them. A convenient method for
resolving this problem is to derive two factors which, for the existing temperature profile, can be
multiplied by the prevailing pressure to reveal the molar volume of gas contained in the cold zone
and the total quantity residing in the free volume of the immersed sample holder (the analysis free
space).

The analyzer provides the following methods for free space determination:

n Measure
n Calculate
n Enter

MEASURE

Generally, this method, although requiring a little more time (approximately 10 minutes), is the
most preferred one for determining free space. It is simple, automatic, requires very little
information, and essentially is error-proof. With this method, the instrument first evacuates the
manifold and sample tube (containing sample), then isolates the sample tube by closing the valve.
Then the manifold is charged with helium, the pressure measured, and the valve opened allowing
the helium to expand into the sample tube at ambient temperature. Again the pressure is
measured.

C Free-Space Correction

TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023 C - 1



C Free-Space Correction

The Dewar is raised and the sample tube is cooled to cryogenic temperature. Again pressure
drops; when pressure has equilibrated, the value is recorded. Ambient and analysis free spaces
are calculated from (1) system volume, (2) system, ambient, and bath temperatures, and (3)
measured pressures. From these, the value of the portion of analysis free space at cryogenic
temperature which requires correction for nonideality can be determined.

This method may be undesirable if:

n Helium is unavailable. Free space determination by the analyzer requires the use of helium.
n Analysis speed is a major factor. A helium free space measurement of 10 to 15 minutes is

required.
n The sample tends to absorb and retain helium for a prolonged period of time or if it adsorbs

helium.

CALCULATE
This method is the most rapid and efficient way of compensating for free space. Ensure the
following is accomplished:

n Perform a blank analysis on the sample tube.
n Load the blank analysis file data into the sample tube file.
n Enter the analysis bath temperature (found on the p° and Temperature window).
n Enter the sample mass and density (found on the Sample Description tab).

ENTER
This method allows for entering predetermined values for the ambient and analysis free spaces.
The values to enter may be obtained in one of two ways:

n A pre-analysis free space calibration of the sample tube containing sample.
n The total free space of an empty sample tube is measured and the displacement of the sample

calculated from its mass and density and subtracted from the total free space.

In either procedure, ensure that the level (or, in cases where the Isothermal Jacket is used, the
effective level) of the cryogen bath on the sample tube is the same when the analysis is performed
as it was when gathering data for free space calculations.
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D MAINTAIN HIGH-PURITY GASES

The analysis system was designed to accurately measure the surface area of all types of
materials. It is important that the gases (especially krypton) used for these measurements be of
highest purity, especially when analyzing low surface area samples. Three ways to ensure high-
purity gases are to always maintain:

n Thoroughly purged gas pressure regulators.
n Non-permeable gas lines.
n Leak-free connections.

Impure gas is strongly indicated, for example, if a series of measurements on a low surface area
material yields decreasing specific surface areas with decreasing quantities of sample. The
analyzer uses very small amounts of helium; therefore any residual air in the regulator can distort
results of subsequent analyses for quite some time.

Micromeritics offers the following suggestions to assist in maintaining high-purity gases
(particularly helium):

n Use metal gas lines only.
n Remove trapped air from the regulator and gas lines.

USE METAL GAS LINES
Always use metal gas lines which have been carefully cleaned of any oils and greases used in the
manufacturing process. Do not use plastic or rubber gas lines. When these types of permeable,
nonmetallic gas lines are used with helium, contaminants accumulate at a much faster rate. This
causes errors in analysis results and can also contaminate a clean sample.

REMOVE TRAPPED AIR
When connecting the regulator to the gas cylinder, air is unavoidably trapped on the high and low
pressure sides of the regulator, as well as in the gas lines. Remove as much of this air as is
possible before opening the gas cylinder valve. If this air is allowed to remain in the regulator, it
will mix with the helium and cause inaccurate results in subsequent analyses. Or if the valve is
open for any length of time, the air trapped on the high pressure side may diffuse back into the gas
cylinder and contaminate its entire contents.

There are two methods for removing trapped air from the regulator lines: the Purge Method and
the Evacuation Method.

D Maintain High-Purity Gases
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DMaintain High-Purity Gases

PURGE METHOD

This is the preferred method for removing trapped air.

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

If multiple instruments are installed, choose the correct Unitmenu.

2. Close all valves by right-clicking each valve, then click Close.

3. Open the regulator shut-off valve.
4. Open the gas cylinder valve briefly and allow the regulator to be charged with gas until the

high pressure gauge reads just over half the tank pressure, then quickly close the valve.

A. Gas tubing to instrument
B. Gas regulator shut-off valve
C. Low pressure gauge
D. High pressure gauge
E. Gas cylinder shut-off valve
F. Regulator connecter nut
G. Regulator control knob
H. Brass reducer fitting

5. Use the Pressure Control knob to set the output pressure (gas cylinder pressure gauge) to
15 psig.

6. Loosen the fitting at the instrument helium inlet until the low pressure side drops to approx-
imately 3 psig (0.02 MPa), then tighten the fitting.
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7. Repeat steps 4, 5, and 6 three times.
8. Briefly open the gas cylinder valve, then use the Pressure Control knob to reset the reg-

ulator output pressure to 15 psig.
9. After the pressure has stabilized (indicating there are no leaks), open the gas cylinder valve.

D Maintain High-Purity Gases
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DMaintain High-Purity Gases

EVACUATION METHOD

To use this method, the gas tank must be within 10 feet of the instrument.

1. Do one of the following:

If... Then...
The regulator has not
been filled with gas and
the gas line is attached
to the instrument:

Close the gas cylinder valve.

Open the regulator shut-off
valve.

The regulator is filled
with gas:

Close the gas cylinder valve.
Open the regulator shut-off
valve.
Loosen the helium inlet fitting
(or nut) on the instrument.
Allow all of the gas in the reg-
ulator to expel from the line
(pressure reading will be zero).
Retighten the helium inlet fitting
(or nut).

2. Go to Unit > Enable manual control (if the instrument schematic is not displayed, go to
Unit > Show instrument schematic).

If multiple instruments are installed, ensure the correct Unitmenu is selected.

3. Close all valves, then open valves 6, 7, and 10.
4. Allow evacuation to continue for 20 minutes. This pulls a vacuum on the helium line to the

gas cylinder. The manifold pressure transducer should fall close to zero.

Allow evacuation for a full 20 minutes. If evacuation time is too short, trapped air may
remain in the lines.

5. Close valves 6, 7, and 10.

D - 4 TriStar II Plus Operator Manual
303-42800-01 (Rev M )— Sep 2023



SAMPLE DATA WORKSHEET FOR GAS ADSORPTION
Sample tube identification:

Sample Mass (g)
Before Degas After Degas After Analysis

1. Mass of empty sample tube set g

2. Mass of sample tube set plus sample g g g

3. Mass of sample (step 2 minus step 1) g g g

Degas Information
Degas apparatus
Temperature (°C)
Time (hours)
Actual time started
Actual time finished

Degas Notes:

Sample Data Worksheet for Gas Adsorption
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F EXPORTED DATA EXAMPLE
This exported data has been truncated for this manual.

Sample Information

                    Method:    Default                                              
                    Sample:    Alumina Reference Material Lot 152624-13, 0.26 m2/g  
                  Operator:    JCH                                                  
                 Submitter:    Micromeritics                                        
                  Bar Code:                                                         
                 Mass type:    Entered                                              
               Sample mass:    2.1465 g                                             
                   Density:    1.000 g/cm³                                          
              Type of data:    Automatically collected                              
           Instrument type:    3030                                                 
  Original instrument type:    3030                                                 
                  Comments:                                                         

Sample Tube

            Sample tube:    Sample Tube  
     Ambient free space:    1.0000 cm³   
    Analysis free space:    1.0000 cm³   

F Exported Data Example
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    Non-ideality factor:    0.0000620    
  Use isothermal jacket:    No           
         Use filler rod:    No           
       Vacuum seal type:    None         

Degas Conditions

  Degas conditions:    Degas Conditions  

            Smart VacPrep evacuation

     Backfill sample tube:    Automatic         
          Evacuation rate:    0.67 kPa/s        
  Unrest. evacuation from:    0.67 kPa          
             Vacuum level:    1.333224e-03 kPa  
          Evacuation time:    10 min            
    Temperature ramp rate:    10.0 °C/min       
       Target temperature:    30 °C             
            Hold pressure:    13.3 kPa          

                Heating Phase

  Sample                     Ramp             

F Exported Data Example
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  prep:     Temperature      Rate      Time   
  Stage   (°C)  (°C/min)    (min)  
----
       1            400          10       60  

Analysis Conditions

  Analysis conditions:    Run Conditions   
  Isotherm collection:    Target Pressure  

               Pressure Table

   Starting       Pressure        Ending     
   Pressure       Increment      Pressure    

(p/p°)         (p/p°)         (p/p°)     
---
  0.000000000                   0.060000000  
  0.060000000    0.020000000    0.200000000  

           Preparation

  Fast evacuation:    No          
  Evacuation rate:    1.33 kPa/s  

F Exported Data Example
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  Evacuation time:    0.10 h      

           Leak test:    Yes    
  Leak test duration:    120 s  
        Use TranSeal:    No     

                Free Space

     Measured before analysis             
  Lower Dewar for evacuation:    Yes      
             Evacuation time:    0.10 h   
                 Outgas test:    Yes      
        Outgas test duration:      180 s  

                     p° and Temperature

           p° type:    Calculated from analysis temperature  
  Temperature type:    Entered                               
       Temperature:    77.300 K                              

                         Dosing

  Use first pressure fixed dose:    No                  

F Exported Data Example
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   Use maximum volume increment:    No                  
               Target tolerance:    0.5% or 0.0667 kPa  

            Equilibration

        Relative                     
        Pressure      Equilibration  

(p/p°)       Interval (s)   
 --
  1    1.000000000               10  

  Minimum equilibration delay at p/p° >= 0.995:    1 s  

             Sample Backfill

  Backfill at start of analysis:    Yes  
    Backfill at end of analysis:    Yes  
                   Backfill gas:    N2   

Adsorptive Properties

                         Adsorptive:    krypton @ 77.35 K (Kr)  
          Non-condensing adsorptive:    No                      

F Exported Data Example
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          Maximum manifold pressure:    0.213 kPa               
  Therm. tran. hard-sphere diameter:    3.8100 Å                
     Molecular cross-sectional area:    0.210 nm²               
         Adsorbate molecular weight:    83.80                   
               Thermal conductivity:    1.00                    
                Non-ideality factor:    0.0000300               
          Density conversion factor:    0.0012743               
                      Dosing method:    From Psat tube          

    Psat vs. Temperature Table

        Saturation                 
         Pressure     Temperature  

(kPa)     (K)
---
   1        0.2104          75.40  
   2        0.2341          75.85  
   3        0.2632          76.35  
   4        0.2988          76.90  
   5        0.3162          77.15  
   6        0.3309          77.35  
   7        0.3461          77.55  
   8        0.3701          77.85  

F Exported Data Example
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   9        0.4133          78.35  
  10        0.4609          78.85  

Report Options

                          Report options:    Alumina Reference Material Lot 152624-13  
                       Show report title:    Yes                                       
                            Report title:    Alumina Reference Material                
                            Show graphic:    Yes                                       
                            Graphic file:    miclogo.emf                               
                          Graphic height:    0.250 in                                  
                           Graphic width:    2.000 in                                  
  Apply thermal transpiration correction:    No                                        

        Summary: Yes

            Surface Area

           Single-point BET:    Yes  
            Multi-point BET:    Yes  
                   Langmuir:    No   
           t-Plot Micropore:    No   
            t-Plot External:    No   

F Exported Data Example
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  BJH Cumulative Adsorption:    No   
  BJH Cumulative Desorption:    No   
        D-H Cum. Adsorption:    No   
        D-H Cum. Desorption:    No   

         Pore Volume

     Adsorption Total:    No  
     Desorption Total:    No  
     t-Plot Micropore:    No  
  BJH Cum. Adsorption:    No  
  BJH Cum. Desorption:    No  
  D-H Cum. Adsorption:    No  
  D-H Cum. Desorption:    No  

           Pore Size

  Average pore diameter:    No  
    BJH adsorption avg.:    No  
    BJH desorption avg.:    No  
    D-H adsorption avg.:    No  
    D-H desorption avg.:    No  

F Exported Data Example
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            Other

          Freundlich:    No  
              Temkin:    No  
      Alpha-S method:    No  
       DFT Pore Size:    No  
  DFT Surface Energy:    No  
   Nanoparticle Size:    No  

       Horvath-Kawazoe

  Maximum pore volume:    No  
    Median pore width:    No  

      Dubinin-Radushkevich

  Micropore surface area:    No  
      Monolayer capacity:    No  

          Dubinin-Astakhov

     Micropore surface area:    No  
  Limiting micropore volume:    No  

F Exported Data Example
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               MP-Method

        Cumulative surface area:    No  
         Cumulative pore volume:    No  
  Average pore hydraulic radius:    No  

                                Pass/Fail

         Pass/Fail 1:    S A:Single-point BET:                           
    High Range Value:    0.2600 m²/g                                     
  High Range Message:    Alumina 004/16816/00 Lot 152624-13 Upper Limit  
     Low Range Value:    0.1800 m²/g                                     
   Low Range Message:    Alumina 004/16816/00 Lot 152624-13 Lower Limit  
         Pass/Fail 2:    S A:Multi-point BET:                            
    High Range Value:    0.3000 m²/g                                     
  High Range Message:    Alumina 004/16816/00 Lot 152624-13 Upper Limit  
     Low Range Value:    0.2200 m²/g                                     
   Low Range Message:    Alumina 004/16816/00 Lot 152624-13 Lower Limit  
         Pass/Fail 3:    No                                              
         Pass/Fail 4:    No                                              

F Exported Data Example
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